
 

  

  

Instructor Help 
RT30_Q4 2009 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 



 

2 

Contents 
Welcome to Your Course! ................................................................................7 

Navigate Your Online Course............................................................................7 

User Profile ...................................................................................................9 

About Locale and Time Zone .........................................................................9 

Using Help ....................................................................................................9 

Security Timeout..........................................................................................10 

Set Course Preferences (Course Admin)........................................................11 

General Information and Settings ...................................................................11 

Style Manager .............................................................................................12 

Enable or Disable Tools .................................................................................13 

Threaded Discussion Preferences (Course Admin) .............................................13 

Schedule Course Content and Build Paths ........................................................14 

Schedule Course Content............................................................................14 

Path Builder..............................................................................................17 

Course Enrollment........................................................................................21 

Group Management ......................................................................................22 

User Profile .................................................................................................23 

About Locale and Time Zone .......................................................................23 

Course Home.................................................................................................25 

Announcements ...........................................................................................25 

Add Announcements ..................................................................................26 

View Announcements .................................................................................26 

To view course announcements: ...............................................................26 

Schedule Course Content and Build Paths .....................................................27 

Course Checklist ..........................................................................................27 

Syllabus......................................................................................................27 

Create a Syllabus ......................................................................................28 

Delete Syllabus Items ................................................................................29 

Reorder Syllabus Items ..............................................................................30 

What's New .................................................................................................30 



 

3 

Content Items ...............................................................................................32 

Types of Content Items.................................................................................32 

Exams and Quizzes....................................................................................33 

Text/Multimedia ........................................................................................33 

Threaded Discussion ..................................................................................35 

Hide or Show Content Items ..........................................................................36 

To hide or show content item:........................................................................37 

Reorder or Move Content Items......................................................................37 

Schedule Course Content ..............................................................................37 

Toolbox ......................................................................................................40 

Manage Files and Folders ..............................................................................46 

Add/Delete Folders .......................................................................................47 

Delete Files .................................................................................................47 

Upload/Download Files ..................................................................................48 

Upload Streaming Media Files ........................................................................49 

Formatting Content (Visual Editor) ...............................................................52 

Design & HTML View .....................................................................................54 

Plain Text Editor...........................................................................................56 

Design Tips: MS Office Documents...........................................................58 

Design Tips: Visual Editor .......................................................................59 

Math Equation Editor ....................................................................................60 

Course Tools .................................................................................................63 

Set Course Preferences (Course Admin)...........................................................63 

Gradebook ..................................................................................................64 

Email..........................................................................................................65 

Live............................................................................................................65 

Chat ........................................................................................................66 

Add, Edit, and Delete Chatrooms...............................................................66 

Chat Logs ..............................................................................................67 

Participate in Chat ..................................................................................67 

ClassLive..................................................................................................68 



 

4 

Audio and Messaging...............................................................................70 

ClassLive FAQs .......................................................................................70 

Participate .............................................................................................72 

Plan and Publish Sessions ........................................................................73 

Session Archives.....................................................................................74 

Whiteboard ............................................................................................75 

Doc Sharing ................................................................................................76 

Delete Shared Files ....................................................................................76 

Download Shared Files ...............................................................................77 

Edit Shared Files .......................................................................................77 

Categories for Shared Files .........................................................................78 

Mark Files as Shared or Private....................................................................79 

Upload Files to Share .................................................................................79 

View Download History...............................................................................81 

Dropbox......................................................................................................81 

Create Baskets..........................................................................................82 

Edit or Delete Baskets and Items .................................................................84 

Grade Dropbox Items.................................................................................84 

Move Items to Another Basket.....................................................................87 

View Dropbox Items...................................................................................87 

Journal .......................................................................................................89 

Webliography ..............................................................................................91 

Add Categories..........................................................................................91 

Add Entries...............................................................................................92 

Delete Entries ...........................................................................................93 

Edit Entries...............................................................................................93 

Search Entries...........................................................................................94 

Threaded Discussion .....................................................................................95 

Delete Threads ............................................................................................96 

Grade Threads .............................................................................................96 

Manage Thread Topics ..................................................................................97 

Print Threads...............................................................................................98 



 

5 

Respond to Threads......................................................................................99 

Threaded Discussion Preferences (Course Admin) ........................................... 100 

View Threads............................................................................................. 100 

Exams and Quizzes......................................................................................103 

How to Create an Exam............................................................................... 103 

Add Exams................................................................................................ 104 

Add Questions ........................................................................................... 105 

Delete Exams ............................................................................................ 106 

Design Tips: Gradebook and Exams ....................................................... 107 

Edit Exams................................................................................................ 109 

ExamGuard ............................................................................................... 109 

Toolbox .................................................................................................... 111 

Exam Statistics .......................................................................................... 116 

Preview Exams .......................................................................................... 118 

Question Pools ........................................................................................... 118 

Reset or Grant Additional Time..................................................................... 120 

Test Banks ................................................................................................ 121 

Gradebook...................................................................................................123 

How to Set Up Gradebook ........................................................................... 124 

Add Items to Gradebook ............................................................................. 124 

Assign and Change Grades .......................................................................... 125 

Assign Extra Credit ..................................................................................... 126 

Assign Points and Weights ........................................................................... 126 

Design Tips: Gradebook and Exams ....................................................... 127 

Exclude Grades .......................................................................................... 129 

Export Grades............................................................................................ 130 

Preview Gradebook Settings ........................................................................ 131 

Quick Grade View....................................................................................... 131 

Reset or Grant Additional Time..................................................................... 132 

Select Gradable Items................................................................................. 133 

Set Gradebook Preferences.......................................................................... 134 



 

6 

Share Grades with Student .......................................................................... 134 

View Grades .............................................................................................. 135 

View User Activity ...................................................................................... 137 

Learning Outcomes .....................................................................................139 

How it works: ............................................................................................ 139 

Add Learning Statements to Course .............................................................. 139 

Link Learning Statements to Content Items.................................................... 141 

View Learning Outcomes ............................................................................. 143 

Details by student ................................................................................... 143 

Details by Outcome.................................................................................. 144 

Edit Learning Statements ............................................................................ 145 

Remove Learning Statements ...................................................................... 147 

Export Assessment Summary....................................................................... 147 

Resources ...................................................................................................148 

Online Education FAQs ................................................................................ 148 

HTML Quick Reference ................................................................................ 150 

Section 508............................................................................................... 152 

Educator's Voice......................................................................................... 153 

 



 

7 

Welcome to Your Course! 
Using the tools and features available in this software, we’ll help you create a unique 
online course that reflects your needs and those of your students. Here’s how it 
works…  

 Take the IDT Instructional Design Tutorial. Found on the page from which you access 
your course, the Instructional Design tutorial walks you through a quick overview of the 
course creation process. 
 

 Know your online classroom. See Navigate Your Online Course to orient yourself with the 
tools and features you will use to add and deliver course content. 
 

 Course Home page. The first page to display when you log in to your course is the Course 
Homepage. This is the central location or starting point for your course. Course Home 
displays course announcements, new posts and course activity since your last login, course 
navigation buttons, and course tools you can use to communicate with your students.  
 

 Set your course preferences. See1 Set Course Preferencesto set course-wide preferences 
and select a design and style for your course. 

 
 
See also: 

• Navigate Your Online Course 

• User Profile 

• Using Help 

• Security Timeout 

Navigate Your Online Course 

Before you begin building your course, take the IDT Instructional Design Tutorial 
to orient yourself to working in an online learning environment. Click on the following 
links to learn more about the major interface components to your course desktop 
including how to navigate your course and locate course tools and features.  

Tools menu 

At the top of your course is the Tools menu. Use the Tools menu to locate and open 
the tools you want to use to build and maintain your course. The course tools help 
you communicate and interact with your students. They include things like email, 
announcements, and chatrooms. Your students can use these same tools to 
communicate with you and with other students. In the image below, click on each of 
the tool buttons to learn more about that tool. 
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Navigation tree 

Located in the left-side pane of your course, the navigation tree functions 
according to the selected working mode: Course or Author. When you start to 
create your course, you will add Units and Content Items. In the image below (which 
shows the navigation tree in Author mode), click on the course Units and content 
items to learn more. 

 

Navigation tree buttons 

Located at the bottom of the navigation tree, you will find four buttons. In the image 
below, click on each of the buttons to learn more.  

 

Course mode vs. Author mode 

As an instructor, you can view your course in two different modes:  

 Course mode - Shows your course just as students see it. In Course mode, you can 
navigate the course like a student. 

 Author mode - Displays tools and options to help you build your course. In Author mode, 
you can design your Course Home page, add announcements, create your syllabus, and 
more. 

For example, if you're working in Course mode and click Syllabus from the Course 
Home page, you see your Syllabus just as students see it. If you click the Author tab, 
however, you see tools that allow you to add new syllabus items or edit existing 
items. 

In the image below, click on the Course and Author tabs for an example of what you 
will see when you switch between Course and Author mode. Students do not have 
the Author tab or Course Admin tool as these are instructor features only.  
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User Profile 

The User Profile page is where you can specify locales and time zones for your 
course.   

About Locale and Time Zone  

User profile settings determine the specific locale (language and country) and time 
zone for your current login session. Select a locale for your session from the User 
Profile page by clicking  in the navigation tree.  

When you specify a locale from the User Profile page, only you will view the course in 
the selected locale and time zone. However, when you specify a course locale from 
the General Information and Preferences page, all students will be required to use 
that locale. This is because the settings you set from the General Information and 
Preferences page are applied globally throughout the course and override any locale 
a student sets in his/her user profile settings. 

If your institution sets the locale for the course at the administrative level, the locale 
settings listed on the General Information and Preferences page display as read-only.  

Set user profile settings 

1. In the course navigation tree, click . 

2. On the Settings tab in the fields provided, enter the following: 

 Language (Country) - Select your language preference for the course. 

 Time Zone - Select your time zone preference for the course. 

3. Click Save Changes. 

Set course locale and time zone 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin.  

3. Click General Information and Settings. 

4. In the Course Locale drop-down list, select a locale. The selected locale is enforced to all 
students in the course meaning, your students will not have the ability to change the locale 
in their User Profile settings as this page will display as read-only. 

Remember, if your institution sets the locale for the course at the administrative 
level, the locale settings listed on the General Information and Preferences page 
display as read-only. 

Using Help 

The Help system is accessible from anywhere within your course. On the Tools menu, 
click Help for assistance with using the features and tools within Teaching Solutions.  
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Use the Design Tips to learn best practices and answers to frequently asked 
questions about creating or designing an online course. 

For your convenience, you can print out help pages to read for future reference. To 

print any help page in the Online Help system, click  in the Online Help toolbar.  

If you open the Help system and don't see the Help topic you're looking for, click  
in the Online Help toolbar to look up other Help pages. If at any time you need 
further assistance, contact the Help Desk. A client services representative is available 
to assist you.   

  

Security Timeout 

When you access your online course, you are asked to provide your user name and 
password so the eCollege system can acknowledge you as a legitimate user. As long 
as you are actively working in your course, your course remains open and available 
to you.  

If, however, there is no activity in your course for 90 minutes (for example, you 
leave for lunch without logging out of your course), the eCollege system 
automatically logs you out. This security feature ensures that the only person 
working in your course using your login name and password is you.  

If the system logs you out of your course, re-enter your login name and password in 
the page that displays.  

Because the system logs out after 90 minutes of inactivity, save your work often. 
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Set Course Preferences (Course Admin) 
The Course Admin page is where the initial administrative setup takes place for your 
online course. Use the Course Admin tool to set global, course-wide preferences. Just 
like a traditional course, your online course requires administrative setup. Set your 
course preferences to access or determine general course information, course 
enrollment, and group management. Instructors can specify titles for course sections 
(Units, Modules, Chapters, Weeks, etc.) to set a tone for the class. 

To open the Course Admin page: 

1. On the Tools menu, click Course Admin. 

2. The main Course Admin page contains three tabs:  

 General Information and Preferences - Click to set course options and settings for 
General Information and Preferences, Style Manager, Enable/Disable tools, Threaded 
Discussion, Course Scheduler and Path Builder, and Survey Report Wizard. 

Style Manager and ClassLive can be disabled at the administrative level. If your 
institution has chosen to disable these features, you will not see them listed. 

 Course Enrollment - Click to view a list of students currently enrolled in the course. 

 Group Management - Click to organize students into groups or teams for the course.  

Whichever tab in the Course Admin tool you are working in, the course preference 
settings you select apply course-wide. You can change course preference settings at 
any time. 

 
See also: 

• General Information and Settings 

• Style Manager 

• Enable or Disable Tools 

• Threaded Discussion Preferences 

• Schedule Course Content and Build Paths 

• Course Enrollment 

• Group Management 

• Locale/Language 

General Information and Settings 

Information about your course is set at the administrative level and can include the 
title of the course, the instructor, teaching assistant, etc. Course default settings you 
might change include customizing the course navigation tree to allow long content 
item names in your course, wrapping long content items names onto multiple lines, 
truncating long names to 13 characters, etc. You can also change the default course 
settings to not display a link to the course syllabus under the Course Home button in 
the navigation tree. 

Describe the General Information and Settings options 
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Remember to click Save Changes after setting your preferences. 

Field Description 

Course Title (Required) Displays the title assigned to the course. 

Instructor 
Title 

(Required) Displays the title of the instructor to the course. 
Instructors Titles include Professor, Doctor, Teacher, etc.  

TA Title Displays the title of the teaching assistant (TA) to the course. 

Unit Heading (Required) Displays the heading to sections of a course. For 
example, if your course is structured into weeks, you might 
change the default setting from Unit to Week. Other headings 
some instructors use include Module, Section, Chapter, etc. 

Navigation Sets whether or not to wrap text for Unit Headings and 
Content Item names in the navigation tree. Select the check 
boxes to display long Unit titles or Content Item names on 
multiple lines in the navigation tree; otherwise, leave the 
check boxes clear. 

Course Locale Sets the locale for the course. The locale you specify here will 
override any locale a student sets in his/her User Profile 
Settings. Basically, when you specify a course locale, all 
students will be required to use that locale. In the drop-down 
list provided, select a specific course locale.  

If your institution sets Course Locale settings at the 
administrative level, the Course Locale drop-down list 
displays as read-only. This means you can view, but cannot 
change, the locale or time zone to your course.  

Course 
Description 

 In the Visual Editor, type a description of the course. This is 
the description used in the course catalogue. 

Required Text In the Visual Editor, list the textbook(s) required for the course. This 
is the list used in the course catalogue. 

Style Manager  

Use the Style Manager to customize the look and feel of your course. You can 
personalize colors, design themes, and fonts. Every online course is unique. If your 
institution prefers that all its online courses maintain a similar look and feel, the 
Style Manager might not be available in your course. 

Open Style Manager 

1. In the navigation tree, click the Author tab.  

2. On the Tools menu, click Course Admin. 
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3. Click Style Manager.  

Apply the course default style 

1. Open  Style Manager.  

2. Select Use the default course style.  

3. On the Fonts tab, follow the instructions on the page to customize your font preferences 
and the alignment of the logo accordingly. 

4. Click Save Changes. 

Apply a custom course style 

1. Open Style Manager.  

2. Select Use a custom course style based on the selections below.  

3. Either specify a Color Theme or select a Design Theme. 

4. Do one of the following for the selected theme: 

 Color Themes - Select any of the available color options and its respective background 
design. 

 Design Themes - Choose a look that suits your course. Like a template, the 
design theme includes color, background, and menu and button styles. 

5. On the Fonts tab, follow the instructions on the page to customize your font preferences 
and the alignment of the logo accordingly. 

6. Click Save Changes. 

Click Use the default course style at any time to return to the default eCollege 
course style. Any changes you have made in the Style Manager will be lost. 

Enable or Disable Tools 

As the instructor, you can select which course tools and features to use or not use in 
the course. Remember, tools can be disabled (turned off) at the administrative level. 
If your institution disabled tools at the administrative level, those tools will not be 
available to enable (turn on) or disable (turn off). 

To enable or disable tools: 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin. 

3. Click Enable/Disable tools. 

4. Select the tools you want to either enable or disable for the course. The tools you disable 
are also disabled for the students. 

5. Click Save Changes. 

Threaded Discussion Preferences (Course Admin) 

You can set course-level Threaded Discussion preferences from the Course Admin 
page, but you can also override these options at the individual content item level 
from the Toolbox page. The Toolbox page lists specific Threaded Discussion 
preferences, such as moving Threads, deleting Threads, assigning Threads to a 
group, etc. 
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Set course-level Threaded Discussion preferences 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin. 

3. Click Threaded Discussion Preferences. 

4. Select the check box for any of the following: 

 Set topics to "read only" after the scheduled end dates for all Threaded 
Discussions in this course - Locks all Thread postings once the content item's End Date is 
passed. Students can view the Thread, but they will not see Respond or Edit buttons. 

 Allow students to edit their posted responses for all Threaded Discussions in this 
course - Allows students to edit their own Thread responses after they've posted them to a 
Threaded Discussion. If a Thread response is edited, a Last Modified date displays under the 
response, as well as the original post date. 

5. Click Save Changes 

Open Toolbox for Threaded Discussion 

See Toolbox. 

Schedule Course Content and Build Paths 

The Course Scheduler and Path Builder tool work in conjunction of each other in 
establishing time-based and performance-based conditions set by you. As a stand 
alone tool, Course Scheduler enables you to set start dates, end dates, and due 
dates for all the Units and content items in your course from a single location. If you 
assign a due date, the date displays on your students' Course Checklist. You can also 
use the Course Scheduler to restrict access to individual Units and content items and 
to determine the dates on which students can access exams in the Gradebook.  

If Path Builder is enabled for your course, you can set performance-based conditions 
for content items within a Unit or the Unit itself. Once the condition is met, students 
can move on to the next learning item for the class. Time conditions set from the 
Course Scheduler are reflected in the Path Builder page and vice versa. Together, 
Course Scheduler and Path Builder make it easy for you to establish time and 
condition-based parameters around learning objectives for the course.  

See also: 

• Course Scheduler 

• Path Builder 

Schedule Course Content  

Use the Course Scheduler feature to set start dates, end dates, and due dates for 
all the Units and content items in your course from a single location. If you assign a 
due date, the date displays on your students' Course Checklist. You can also use the 
Course Scheduler to restrict access to individual Units and content items and to 
determine the dates on which students can access exams in the Gradebook. 

Additionally, you can schedule individual content items or Units using the Edit 
Schedule feature located in the Toolbox for the individual content item. 
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If you schedule Start and End Dates for a Unit or a content item using the Course 
Scheduler, the same Start and End Dates display if you open the Event Scheduler for 
the individual Unit or content item (and vice versa). 

Schedule all content items and Units 

1. In the navigation tree, click the Author tab. 

2. In the Tools menu, click Course Admin. 

3. Click Course Scheduler. Depending on the amount of content in your course, the Course 
Scheduler can take up to a minute to open. 
 
The first time you open Course Scheduler, all Unit and content item dates are set to the 
same date (i.e., your course dates). This means all Unit start and end dates default to the 
start and end dates of your course, and all content item dates default to the Unit's date. 
 

4.  Set start and end date access times for your Unit and content items accordingly.  
 

Explain the columns in Course Scheduler  

 
In this 
column 

Do this 

Content Locate the Unit or content item for which you want to schedule a 
start/end date access time. 

Date 
Assignment 

Select either Use course start/end to allow student access using the 
default dates or Assign specific start/end to use your own start/end 
date values and not use the course default. 

Start Date Click  to open a calendar and select a start date for the Unit or 
content item. Use the arrow buttons in the calendar to move 
from month to month. Remember, the date you select must fall 
within the course's Start and End dates. If you don't want 
students to access the Unit or content item before the Start 
Date, select the Restrict access before check box.  

You can also enter a Start Date directly into the text field. Make 
sure you enter the date in one of the following formats: 
(mm/dd/yy); (mm.dd.yy); (mm-dd-yy); (mm,dd,yy). 

End Date Select an End Date for the Unit or content item (the same way 
you selected a Start date). If you don't want students to access 
the Unit or content item after the End Date, select the Restrict 
access after check box. 

Due Date 
(optional) 

Select a Due Date for the content item (the same way you 
selected a Start date). Assigning a Due Date is optional; 
however, if you choose to assign a Due Date the date will appear 
on the students' Course Checklist. 

Calendar 
Display 

Select one of the following: 
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 Do not display, to not display the start/end dates for the Unit or 
content item. 

 Start & end only, to display the start/end dates for the Unit or 
content item. 

 Duration of item, to display the Unit or content item within the 
specified start/end date range. 

 

5. Click Save Changes. 

Schedule a single content item 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the content item for which you want to schedule and assign 
dates or deadlines. 

3. Click Toolbox. 

4. Click Edit Schedule.  

5. Assign dates and preferences accordingly. 
 

Explain the fields in the Edit Schedule window 

 
In this field Do this 

Start and End 
dates 

Select: 

 Use Unit start and end dates, to display the default start/end 
dates for the Unit or content item. 

 Use the following dates, to set a specific date range for which the 
start/end dates for the Unit or content item display. Use the drop-
down lists to select dates or click . 

 Restrict access before, if you don't want students to access the 
Unit or content item before the Start Date.  

 Restrict access after, if you don't want students to access the Unit 
or content item after the End Date. 

Due Date 
(optional) 

Select a Due Date for the content item (the same way you 
selected a Start Date). Assigned due dates display in the 
students' Course Checklist. 

 

6. Click Save Changes.  



 

17 

Schedule a Unit 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Unit for which you want to schedule and assign dates or 
deadlines. 

3. Click Toolbox. 

4. Click Edit Schedule. 

5. Assign dates and preferences accordingly. 
 

Explain the fields in the Edit Schedule window 

 
In this field Do this 

Start and End 
dates 

Select: 

 Use course start and end dates, to display the default start/end 
dates for the Unit or content item. 

 Use the following dates, to set a specific date range for which the 
start/end dates for the Unit or content item display. Use the drop-
down lists to select dates or click . 

 Restrict access before, if you don't want students to access the 
Unit or content item before the Start Date.  

 Restrict access after, if you don't want students to access the Unit 
or content item after the End Date. 

Due Date 
(optional) 

Select a Due Date for the content item (the same way you selected a 
Start Date). Assigned due dates display in the students' Course 
Checklist. 

 

6. Click Save Changes. 

Path Builder 

Use the Path Builder to automate and control the pace at which students can move 
on to the next Content Item or Unit for the course. By enabling condition-based 
parameters, you determine what criteria must be met for an assignment or exam 
before students can continue.Path Builder is a powerful means in managing student 
progression throughout each lesson and Unit. As an instructor, you can set student 
performance conditions on content and in turn control student access to new content 
by time constraints and individual performance. 

Checklist for using Path Builder 

Path Builder is dependent on the setup and structure of Course Admin settings, 
course content items, and Gradebook. If would like to use Path Builder and it is 
enabled for your course, we recommend you first do the following: 

 Complete the steps on How to Create a Course. 

 Set up Gradebook, including marking content items as gradable or non-gradable 
and assigning points. 
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 Set time and date conditions in Course Scheduler. 

Terms to know 

The basics of Path Builder are simple: Create a learning path for students by 
managing when students can move on to the next lesson or Unit in the course based 
on performance (i.e. earned points) or an action (i.e. read syllabus, submit report). 
To move on to the next lesson or Unit, a student must meet the conditions you 
define for the trigger. Terms like "trigger," "target," and "condition" are used 
frequently in Path Builder. Following is a definition of these terms for your reference 
to help you get started. 

• Target - Course destination point. For example, to move on to Unit 2 (the destination), you 
must complete the Unit 1 exam. Another example: To move on to Lesson 2, you must meet 
the learning criteria and conditions for Lesson 1. 

• Condition - Performance criteria. Basically, by setting conditions you are telling the system 
when to trigger (allow) access to the next course item based on whether conditions were 
met for performance or for an action. 

• Trigger - Condition requirement. For example, students must earn a minimum of 70 out of 
100 points for the Unit 5 assignment before the system allows (triggers) student access to 
the Unit 5 exam.   

Design Tips: 

 As a best practice, always schedule dates for Unit and Content Items from Course 
Scheduler. Time conditions entered from Course Scheduler are reflected on the Path Builder 
page.  

 As a best practice, always ensure your Gradebook settings are final before using the Path 
Builder. Grade point values in Path Builder are dependent on Gradebook. This means, points 
entered for content items in Gradebook are reflected on the Path Builder page.  

 Path Builder reflects any changes made to the Course Navigation Tree. This means, if you 
add, remove, or rename Content Items in the Course Navigation Tree, the Path Builder 
page reflects these changes and reorders content items accordingly.  

Open Path Builder 

1. In Author mode, click the Course Admin tab. 

2. Click Course Scheduler & Path Builder. 

3. Click Path Builder. When you open the Path page for the first time, you will notice Unit 
and Content Items display in the same order as you have set them up for the course. In 
the Target column, you can expand and collapse Units to view the condition triggers for 
Content Items. The default, "No Trigger," displays for Content Items without trigger 
conditions. 

Set up triggers and conditions 

Before setting up triggers and conditions for your course content, review the 
"Checklist for Path Builder" section on this page.  

Setting up condition triggers for course content is like creating a learning path. 
Basically, you are telling the system what conditions must be met for specific 
Content Items before a student can proceed to the next lesson in the Unit, or the 
next Unit.   

1. Open Path Builder. 
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2. In the Target column, locate the Unit for which you want to set up condition triggers, and 
click  to expand and view the content items listed for the selected Unit. 

3. At this point, you can select a trigger from the Condition drop-down menu. Once a trigger 
is selected, another drop-down menu displays with grading conditions.  

4. Select Number Grade. Once a grade condition is selected, a new drop-down menu 
displays with value conditions.  
 

Explain the trigger condition drop-down menus in Path Builder 

 
For Do this 

Condition In the Condition drop-down menu, select trigger to specify course 
content a student must complete before moving on to the next 
lesson or Unit. 

Grade Grade condition options are tied to the points entered in Gradebook. 
Select Number Grade to measure performance by points or 
percentage.  

Value Value conditions serve as a metric to individual student 
performance. If a student does not meet the point range specified in 
Path Builder, the system is not triggered to allow for student access 
to the next lesson or Unit. 

Select:   

 Greater Than if points earned must be greater than the total points 
possible. 

 Less Than if the points earned must be less than a specific number. 

 Greater Than or Equal To if the points earned must be greater than or 
equal to the total points possible. 

 Less Than or Equal To if the points earned must be Less Than or Equal 
to a specific number. 

Remember, Path Builder displays points possible as you assign them 
in Gradebook. This is important to remember for when you make 
edits or changes in Gradebook. For example, let's say Assignment 1 
is worth 10 points and the condition trigger in Path Builder is set to 
Greater Than or Equal To 7/10 points. If the total points possible for 
Assignment 1 in Gradebook is changed to 100 points, the system 
refreshes Path Builder to display the Assignment 1 condition trigger 
as Greater Than or Equal To 7/100 points! 

 

5. Click Save Changes.  
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Add triggers and targets 

Before you add triggers and targets, be sure to read the "Before you Begin" section 
on this page.  

Because Path Builder is dependent on the setup and structure of your course, 
changes to the Course Navigation Tree, Gradebook, and Course Scheduler all directly 
impact condition triggers tied to course content. When new content items are added 
to Course, the system automatically updates Path Builder to reflect course 
modifications made before and during a course session. As a best practice, ensure 
your Course Navigation Tree, Gradebook settings, and time conditions in Course 
Scheduler are exactly how you want them for the course before adding triggers and 
targets.  

1. Open Path Builder. 

2. In the Target column, locate the new Unit or Content Item added to the course. 

3. Click  to expand and view the content items listed for the selected Unit. 

4. At this point, select a trigger and additional conditions as necessary.  
 

Explain the trigger condition drop-down menus in Path Builder 

 
For Do this 

Condition In the Condition drop-down menu, select trigger to specify course 
content a student must complete before moving on to the next lesson 
or Unit. 

Grade Grade condition options are tied to the points entered in Gradebook. 
Select Number Grade to measure performance by points or 
percentage.  

Value Value conditions serve as a metric to individual student performance. 
If a student does not meet the point range specified in Path Builder, 
the system is not triggered to allow for the student to move on to the 
next lesson or Unit. 

Select:   

 Greater Than if points earned must be greater than the total points 
possible. 

 Less Than if the points earned must be less than a specific number. 

 Greater Than or Equal To if the points earned must be greater than or 
equal to the total points possible. 

 Less Than or Equal To if the points earned must be Less Than or Equal 
to a specific number. 

Remember, Path Builder displays points possible as you assign them 
in Gradebook. This is important to remember for when you make 
edits or changes in Gradebook. For example, let's say Assignment 1 
is worth 10 points and the condition trigger in Path Builder is set to 
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Greater Than or Equal 7/10 points. If the total points possible in 
Gradebook is changed to 100 points, the system refreshes Path 
Builder to read the new Gradeook setting and displays the 
Assignment 1 condition trigger as Greater Than or Equal To 7/100 
points! 

  

 

5. Click Save Changes.  

Remove triggers and targets 

As mentioned before, Path Builder is dependent on the setup and structure of your 
course. After the initial setup of Path Builder, any content items or units removed 
from the course are also removed from Path Builder. For example, let's say Week 1 
contains five assignments, and Assignment #2 is removed from the course. By 
default, the system removes Assignment #2 from the Path Builder page and 
refreshes the page to display four assignments for Week 1.  

Because Path Builder is dependent on the setup and structure of your course, deleted 
Content Items, changes to Gradebook settings, and changes to Course Scheduler all 
directly impact condition triggers tied to course content. For this reason, the Path 
Builder page does not include a delete button as the system automatically updates 
Path Builder to reflect course modifications made before and during a course session.  

Move content items tied to Path Builder 

As a best practice, we do not advise moving course content after the initial setup of 
Path Builder. If you should have to move a content item tied to Path Builder, the 
moved content item inherits the condition triggers of the new location. For example, 
if Assignment 1 of Unit 1 is moved to Unit 2, then Assignment 1 inherits the 
condition triggers defined for Unit 2.  

Course Enrollment 

From the Course Enrollment page, you can view the current enrollment information 
for your course. This includes the number of students enrolled in the course, student 
enrollment status: pending, waitlisted, or dropped; the email address of enrolled 
students, the date on which a student enrolled, and the time zone and language 
setting for each student.  

View class roster 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin. 

3. Click Course Enrollment. Locate the Class Roster section to view the current course 
enrollment. 

4. Do any of the following: 

 Click on the column titles to sort column titles by Name, Email Address, Status, 
Enrollment Date, Time Zone, or Language. 
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 Click on a student name to view the profile for that student. Student profiles can include 
the student's first and last name, contact information, time zone, and school in which the 
student is currently enrolled. 

View dropped course members 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin. 

3. Click Course Enrollment. Locate the Dropped Class Members section to view a list of who 
has dropped the course. 

4. Do any of the following: 

 Click on the column titles to sort column titles by Name, Email Address, Status, Drop 
Date, Time Zone, or Language. 

 Click on a student name to view the profile for that student. Student profiles can include 
the student's first and last name, contact information, time zone, and school in which the 
student is currently enrolled. 

Group Management 

Many instructors see instructional value in creating groups or teams within their 
courses. Just like in a physical classroom, online groups can be useful for holding 
private team discussions, having specialized readings, assignments, and group 
emails, and using other tools to complete final team projects or papers. 

If you choose to create course groups, the Group feature is pervasive within many 
course tools, including Email, Document Sharing, individual content items, and the 
Gradebook. For example, you, or group members, can email the entire group 
through the Email feature; students can upload papers or presentations to their 
individual group through Document Sharing; you can assign individual content items 
(i.e., Threads, Readings, Assignments, Activities) to each group; and you can review 
and assess group content items through the Gradebook. Additionally, you can create 
and delete private chatrooms for each group you set up. Group members can see 
content items specific to their group.  

As the course instructor, you can create groups and then select members of each 
group. You will have access to every group; students can only access groups in 
which you enroll them.  

Create groups 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin.  

3. Click Group Management. The Groups page opens and displays a list of any groups 
you've already created. 

4. Click Add Group. To plan ahead, you can create groups without adding group members. 
This is helpful when you know you want to divide the class into working groups but have 
not determined which students will work together. 

5. In the Group Name field, type a name for the group (i.e. Group A, Group B, etc.). 

6. In the Select Group Members list, select the members to include in the group by clicking 

on their names and using the  button. The members you select appear in the Group 
Members list. 
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7. Remove a member from a group by clicking the name in the Group Members list and 

using the  button.  

8. Click Add Group. Once a new group is added, the system assigns the group a Group ID. 
To add another group, click Save & Add Another Group. 

Assign a content item to groups 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the content item you'd like to assign to a group.  

3. Click Toolbox. 

4. In the Assigned To drop-down list, select the group to which you want to assign the 
content item.  
 
The Assigned To drop-down list only appears if you've already created groups in your 
course. 
 

5. Click Save Changes. 

Edit groups 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin. 

3. Click Group Management. The Groups page opens and displays a list of any groups 
you've already created. 

4. Locate the group you want to edit and click Edit.  

5. Select group members and use the  and  buttons accordingly to make changes. 

6. Click Save Changes. 

Delete groups 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin. 

3. Click Group Management. The Groups page opens and displays a list of any groups 
you've already created. 

4. Locate the group you want to delete and click Delete. A confirmation displays. 

5. Select the check box to accept the confirmation message, and then click Delete Group & 
Group Content. 

User Profile 

The User Profile page is where you can specify locales and time zones for your 
course.   

About Locale and Time Zone  

User profile settings determine the specific locale (language and country) and time 
zone for your current login session. Select a locale for your session from the User 
Profile page by clicking  in the navigation tree.  

When you specify a locale from the User Profile page, only you will view the course in 
the selected locale and time zone. However, when you specify a course locale from 
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the General Information and Preferences page, all students will be required to use 
that locale. This is because the settings you set from the General Information and 
Preferences page are applied globally throughout the course and override any locale 
a student sets in his/her user profile settings. 

If your institution sets the locale for the course at the administrative level, the locale 
settings listed on the General Information and Preferences page display as read-only.  

Set user profile settings 

1. In the course navigation tree, click . 

2. On the Settings tab in the fields provided, enter the following: 

 Language (Country) - Select your language preference for the course. 

 Time Zone - Select your time zone preference for the course. 

3. Click Save Changes. 

Set course locale and time zone 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin.  

3. Click General Information and Settings. 

4. In the Course Locale drop-down list, select a locale. The selected locale is enforced to all 
students in the course meaning, your students will not have the ability to change the locale 
in their User Profile settings as this page will display as read-only. 

Remember, if your institution sets the locale for the course at the administrative 
level, the locale settings listed on the General Information and Preferences page 
display as read-only. 



 

25 

Course Home  
Your Course Home page is the first thing you and your students see when you log 
in to your course. Course Home is the starting point for your course that displays 
Course Announcements, an Introduction to the course, a list of coursework currently 
assigned to students, and a list of new postings or student activity since your last 
login. Much of your course set up takes place on the Course Home page. All course 
announcements, as well as your introduction to the course, are added in the Author 
view of the Course Home page.    

Additionally, in the navigation tree is the Course Home button. When you enter 
your course, the Course Home button is expanded by default and under it is a link to 
the course syllabus. You can disable default course features in your course 
preferences. 

See also:   

• Announcements 

• Course Checklist 

• Course Introduction 

• Syllabus 

• What's New 

Announcements 

You can post announcements for your course on your Course Home page. Students 
can see all announcements or messages posted by you the next time they log in. Use 
announcements to welcome students to the course, give specific instructions about a 
course or Unit change, inform students about changes in office hours, or explain 
other urgent situations that might otherwise get lost in email. 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor.  

Design Tips: 

 You can use Course Scheduler to set Display Dates for your course announcements 
and determine exactly when to display and when to withdraw each announcement. 
As a result, you can create multiple announcements at one time and then control 
when each announcement displays, or does not display, over the duration of the 
course. 

 Posting announcements reduces the time spent responding to similar email messages from 
many students. Use Announcements to post information you might write on the board at 
the beginning of a class on campus. Tell students about schedule events and changes, 
remind them about course work, or give short assignments. You could also use this tool to 
track down a student you haven't seen or heard from in a while. 

 Only instructors can post and delete announcements. A permanent record of all course 
announcements is stored within the course. 

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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See also: 

• Add Announcements  

• Edit or Delete Announcements  

• View Announcements 

• Schedule Announcements 

Add Announcements 

As an instructor, you can post, edit, or delete course announcements on the Course 
Home page. Your students can only view announcements. 

To add an announcement: 

1. In the navigation tree, click the Author tab, and then click Course Home. 

2. Click Add Announcement. 

3. In the Subject field, type a short subject for your announcement. This is the text students 
click on to read the announcement. 

4. In the Visual Editor, type and format your announcement. If you'd like your announcement 

to link to a file, click  in the Visual Editor toolbar.  

5. Select Display Dates for your announcement. Enter a date directly into the text box 
(mm/dd/yyyy). 
 
The Display Dates default to the course start and end dates, so if you don't enter Display 
Dates, your announcement remains on the Course Home page throughout the entire course 
unless you delete it or change its Display Date. 
 

6. Click Add Announcement. 

View Announcements 

The most recent announcements you post to the course display at the top of the 
Announcement list. New or unread announcements are marked by a closed envelope 

, and read announcements are marked by an opened envelope . Remember, if 
you set specific Display Dates for a particular announcement, that announcement 
only displays during the date range specified. This means announcements do not 
display on the Course Home page if the current date is before the announcement's 
Display Start Date or after the Display End Date. To display an announcement, you 
can always modify the Display Dates.  

To view course announcements: 

1. In the navigation tree, click the Author tab, and then click Course Home.  

2. In the Announcement section, click the announcement you want to view. You can open or 
expand all course announcements by clicking Expand All. 

3. Click the announcement again, or click , to close individual announcements. 
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Schedule Course Content and Build Paths 

The Course Scheduler and Path Builder tool work in conjunction of each other in 
establishing time-based and performance-based conditions set by you. As a stand 
alone tool, Course Scheduler enables you to set start dates, end dates, and due 
dates for all the Units and content items in your course from a single location. If you 
assign a due date, the date displays on your students' Course Checklist. You can also 
use the Course Scheduler to restrict access to individual Units and content items and 
to determine the dates on which students can access exams in the Gradebook.  

If Path Builder is enabled for your course, you can set performance-based conditions 
for content items within a Unit or the Unit itself. Once the condition is met, students 
can move on to the next learning item for the class. Time conditions set from the 
Course Scheduler are reflected in the Path Builder page and vice versa. Together, 
Course Scheduler and Path Builder make it easy for you to establish time and 
condition-based parameters around learning objectives for the course.  

See also: 

• Course Scheduler 

• Path Builder 

Course Checklist 

The Course Checklist feature on the _Ref1336833856Course Home page is a 
great resource for students. From the student view, the Course Checklist displays a 
list of all course assignments and their associated due dates, as well as a check box 
for each item so that students can monitor their progress in regard to assigned 
coursework. Ideally, the course checklist helps students to be aware of assignment 
due dates and prompt them to complete assignments on time. Additionally, from the 
course checklist you can click the Go links to open the pages to the individual 
content items listed.  

Design Tips: 

 You can assign Due Dates to course checklist items using Course Scheduler or Toolbox for 
the individual content item.  

 The Due date feature does not restrict student access to content items. Restricting access to 
content items is controlled through the Restrict access before/after this date check boxes in 
the Course Scheduler or Edit Schedule window for each content item. 

  If a due date is not assigned to a content item, the content item still displays for the 
student so that they can check it as completed; however, a due date is not listed. Students 
can sort their Course Checklist by Unit or by Due Date.  

  Except for exams, students can manually check off the items in their Course Checklist; the 
checklist is not integrated with the actual content items. As a result, students can check off 
items not necessarily complete. 

Syllabus 

Your online syllabus can include the same information as a traditional syllabus, such 
as a Course Description, Course Objectives, General Course Policies and Procedures, 
Grading Policies, Course Textbooks, and anything else you want to include. 
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In Author mode, you can add these and other items to your online syllabus, or you 
can upload an existing offline Microsoft Word document into your course syllabus. 
When you upload an existing document, a link to your Word document displays in 
the Syllabus section of your course. Students can click the link to open the Word 
document and view the Syllabus. If you choose to create a custom online Syllabus in 
Author mode, your Syllabus information displays directly in the Syllabus area of your 
course.  

A link to the course Syllabus displays under the Course Home button in the 
navigation tree by default. If you like, you can opt to turn off the course syllabus 
feature in your course preferences.  

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Design Tips: 

 The syllabus is a perfect place to set the tone for your online course. Make the syllabus 
personable and include your photo with a few paragraphs about your background and 
teaching style.  

 Do you want to keep students on track throughout the semester? Create a detailed schedule 
outlining due dates for projects, assignments and exams.  

 Do you want to ensure students log on frequently and participate? Reward quality 
participation in weekly discussions with extra credit.  

See also: 

• Create a Syllabus 

• Delete Syllabus Items 

• Reorder Syllabus Items 

Create a Syllabus 

When you are ready to create a syllabus for your course, the Syllabus tool enables 
you to either upload a syllabus that you have previously created in an MS Word 
document or to add your own syllabus items using the Visual Editor, but not both. 
This means, if you choose to upload an MS Word document, and then later decided 
to add your own syllabus text items, the system will delete your word document. 
Similarly, if you have previously added items to your syllabus and then choose to 
upload an MS Word document to the syllabus, the system will delete all existing 
syllabus text items. 

By default, the Instructor Information text item is available for you to use if you are 
adding items to your syllabus using the Visual Editor. Some instructors like to include 
Instructor Information as a way to introduce themselves to the class and provide 
contact information, office hours, etc. 

Create a new syllabus 

1. In the navigation tree, click the Author tab. 

2.  Click Syllabus under the Course Home button.  

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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3. Choose either: 

 Compose Text Item (Visual Editor), to compose and add your own text items using 
Visual Editor. 

 Upload Microsoft Word Syllabus (.doc), to upload an existing syllabus (MS word 
document). 

4. Click Add. 

Add syllabus items 

1. In the navigation tree, click the Author tab. 

2. Click Syllabus under the Course Home button. 

3. Select Compose Text Item (Visual Editor), and click Add. 

4. In the Title field, type a title for your syllabus item and compose your text in the Visual 
Editor. 

5. Click Add Item.  

6. Click the Course tab to switch to Course view and preview your work as students will see 
it.  

Add instructor information 

In addition to your contact information, you can also include in the Instructor 
Information section a brief greeting to your students to welcome them to the course. 
Some instructors share information about themselves and include a picture to appear 
more personable online. 

1. In the navigation tree, click the Author tab. 

2. Click Syllabus under the Course Home button. 

3. Select Compose Text Item (Visual Editor). 

4. Click Instructor Information.  

5. In the drop-down list provided, select an instructor or teaching assistant, and click Go. 

6. In the remaining fields provided, enter your contact information accordingly.  

7. Click Save Changes. 

Upload an existing syllabus (MS Word document) 

1. In the navigation tree, click the Author tab 

2.  Click Syllabus under the Course Home button 

3. Select Upload Microsoft Word Syllabus (.doc), and click Add. 

4. Click Browse to navigate to the custom document you want to upload to your course. 

5. Once the syllabus is uploaded, click Upload & Convert File. A link to your Word document 
displays under Syllabus Items. Students can click the link to open the Word document 
and view the Syllabus.  

Delete Syllabus Items 

As the instructor, you can delete the items you've added to your Syllabus at any 
time.  
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To delete syllabus items: 

1. In the the navigation tree, click the Author tab. 

2. Click Syllabus under the Course Home button.  

3. In the Delete  column, click  beside the items you want to delete.  

4. Click Delete. 

 
 

  

Reorder Syllabus Items 

You can arrange or reorder how items display in your syllabus. For example, if you 
prefer to have the course grading policy follow the course description or vice-versa, 
you can switch the syllabus items to display accordingly. 

To reorder syllabus items: 

1. In the navigation tree, click the Author tab. 

2. Click Syllabus under the Course Home button.  

3. Locate the syllabus Item(s) you want to reorder. 

4. In the Order column, type a new number in the text box beside the syllabus item you want 
to reorder. 

5. Click Save. 

What's New 

Use the What's New feature on the Course Home page to monitor student activity 
in your course. From What's New, you can see since your last login when individual 
students contributed to a select area of the course, such as Dropbox. This is helpful 
because it saves you time from searching through every Unit or content item to see 
which students have contributed to various course areas.  

For example, if you wanted to see if there were any new postings to the Unit 1 
Threaded Discussion, you could sort your What's New list by content item and see 
that the Threaded Discussion for Unit 1 had 5 new responses and 3 new postings. 
Similarly, if you wanted to see how student Michelle Petersen was participating in the 
course, you could sort by student and see that Michelle Petersen had posted 2 
responses in the Threaded Discussion and had posted a Website to the 
Webliography. 

For students, the What's New list looks similar, although they do not have access to 
the Sort by Item/Student option. Switch from Author mode to Course mode to see 
how What's New looks from the student view. 

Set date restrictions on your What's New list 

1. In the navigation tree, click the Author tab, then click Course Home. 

2. On the Course Home page, locate the What's New section. 

3. Select a range from the See What's New Since Last drop-down list. A list displays of all 
course activity that occurred within the selected range. For example, if you select Three 
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Weeks Ago from the drop-down list, your What's New feature displays a list of all course 
activity that's taken place in the last three weeks. You can change the range at any time. 
 
If there is a new post to any area in the course, such as Threaded Discussion, DocSharing, 

Dropbox, etc., click the Go link to open that page in the course to view the latest 
submission. 

Sort What's New activity 

1. In the navigation tree, click the Author tab, then click Course Home. 

2. On the Course Home page, locate the What's New section.  

3. In the Sort by: field, click either 
 

 Item, to sort your list by course item; 

 Student, to sort your list by student name. 
 

You can click a specific content item to go directly to that item within your course. If 
there is a new post to any area in the course, such as Threaded Discussion, 
DocSharing, Dropbox, etc., click the Go link to open that page in the course to 
view the latest submission. 

View What's New activity 

1. In the navigation tree, click the Author tab, then click Course Home. 

2. On the Course Home page, locate the What's New section. 

3. Click Expand All to see a complete view of all course activity. Click Collapse All to 
compress your list.  

4. Click on the link to the most recent post. New posts are bolded.  
 
If there is a new post to any area in the course, such as Threaded Discussion, DocSharing, 

Dropbox, etc., click the Go link to open that page in the course to view the latest 
submission. 
 
 You can view what students have contributed since 1 day ago, 1 week ago, 1 month ago, 
etc. by selecting a range from the See What's New Since drop-down menu. 
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Content Items 
Once you have added Units  to your course, you are ready to add content items. A 
content item itself is a sub-section within a Unit that does not contain actual content. 
After a content item is added to a Unit, you must go back into the content item and 
insert the actual content.  

Think of content items as the teaching tools you use to deliver course content. You 
can add as many content items as you'd like to any Unit, or add several items of the 
same type to the same Unit. You can also rename or delete a content item. Some 
instructors like to customize content items to reflect their individual course. You 
don't need to have every content item in every Unit; you can pick which content 
items are appropriate for each Unit and for your course. 

Some courses might use Sharable Content Objects (SCO's). These content items 
must be added to the course at the Admin level and, once added to a course, can be 
used throughout the course much like a Text/Multimedia content item. However, 
because SCO content items are shared content, you cannot edit the content. You can 
use all of the Toolbox functions for SCO objects (Hide, Schedule, etc.). 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor.  

See also: 

• Types of Content Items 

• Add Content Items 

• Hide or Show Content Items 

• Rename or Delete Content Items 

• Reorder or Move Content Items 

• Schedule Content Items 

• Toolbox 

  

Types of Content Items 

There are several types of content items that you can add to your course. Once you 
add a content item, you can delete or make changes to it at any time using the 
Toolbox feature.  

Click on any of the following types of content items to learn about that type: 

• Text/Multimedia 

• Web Content Upload 

• MS Office Document 

• Exam 

• Threaded Discussion 

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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Exams and Quizzes 

Use the Exam content item to evaluate student performance. When you create an 
exam item, you can add pages, add and edit questions and pools of questions, use 
existing exam test banks, and add and edit exam and quiz information. To add an 
exam to your course, you must first add the exam content item to a Unit, and then 
insert content into the exam. You can also set exam preference settings like 
passwords, extending test time, access dates and times, grading options, etc. 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

See also: 

• How to Create an Exam 

• Add Exams 

• Add Questions  

• Delete Exams 

• Design Tips: Gradebook and Exams 

• Edit Exams 

• ExamGuard 

• Exam Preferences (Toolbox) 

• Exam Statistics 

• Preview Exams 

• Question Pools 

• Reset or Grant Additional Time 

• Test Banks 

Text/Multimedia  

Text content items are essentially empty fields in which you can add text, images, 
and links to Websites. You can also assign content to groups or make content 
viewable to a group of users you specify. 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Design Tips: 

 You can use text and multimedia content items to deliver course content in the 
form of:   

o Readings, assignments, text lectures, study tips, a glossary, handouts, or other 
text-based information 

o Audio or video segments, images, computer simulations, or slide show 
presentations 

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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 Name each text or multimedia content item whatever you like. For example, you might 
name text items Readings, Assignments, or Stuff You Need.  

 Text and multimedia content items are formatted using the Visual Editor.  

Add a text or multimedia content item 

Text and multimedia items are two ways to deliver course content. These items are 
added the same way to your course. 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Unit to which you want to add a text or multimedia content 
item. 

3. Click Unit Content Items, and click Add Items. 
 

4. Click Add Items.  

5. In the fields provided, enter information accordingly. 
 

Explain the fields 

 

In this field Do this 

Name Either: 

 Type a name for the new content item. When you enter a new item 
name, it displays in the Select existing item name drop-down list. 

 Select an existing content item name from the Select existing item 
name drop-down list. This list displays names to previously created 
content items. 

Item type Select Text/Multimedia. 

Add to: Select either Course Home or the Unit to which you want to add 
the content item. 

Assign to: Select the audience for the content item. 

Hide item 
from 
students 

Select this check box if you do not want the content item to 
show in course view to students. 

Create 
dropbox 
basket 

Select this check box to create a Dropbox basket for the content 
item. When you create a Dropbox basket for a content item, 
students can submit assignments related to the content item 
directly to the Dropbox basket for the item.  
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6.  
Click Add Items. To add more items, click Save & Add More Items. 

7. Insert content into the text or multimedia content item by editing it. 

Edit (insert content) a text or multimedia content item 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the text or multimedia content item you want to edit. 

3. Do one of the following: 

 To edit a text item, make your changes in the Visual Editor, and click Save Changes. 

 To edit a multimedia item, click Browse to upload the new or modified file, and click 
Upload & Convert file.  
 
When a Microsoft document is uploaded into the eCollege system, it is automatically 
converted to a Web document for display on the internet. However, not all Microsoft Office 
features are supported on the Web. See Design Tips: MS Office Documents for more 
information about formatting your documents for uploading.  
 

4. Click Save Changes. It might take several minutes for your file to be converted to 
HTML format, so please be patient. To see your changes, click the Course tab in the 
navigation tree. 

Delete a text or multimedia content item 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click  the text or multimedia content item you want to delete. 

3. Click Toolbox. 

4. Click Delete [name of content item]. A confirmation message displays. 

5. Click Delete. The item from the current Unit is deleted. If you've used the content item 
elsewhere in the course, those instances will not be deleted.  

Threaded Discussion 

The Threaded Discussion content item simulates traditional classroom discussions. A 
Threaded Discussion, or Thread, allows students to post comments to a discussion 
topic, react to other students' comments, and respond to ideas shared by you or by 
others in the course.  

Discussions take place asynchronously, which means you can respond to a Thread 
discussion at any time; other students do not have to be logged into the course in 
order for you to respond and participate. Threaded Discussions begin with a topic 
you identify. Students log into the course when they can and then post to the 
Threaded Discussion at their convenience. Responses to each topic display below the 
topic. 

Students enjoy using Threaded Discussions because they can compose their 
thoughts before they post a comment, respond more thoughtfully to discussion 
topics, and engage in lively debates that are less threatening than in a live classroom 
environment. You might want to post one or several questions for discussion each 
week. Students might have a set amount of time to respond or might be graded on 
the quality of their comments.  
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The  icon displays next to Threaded Discussions set as gradable items. Click  to 
open the Threaded Discussion Gradebook Details window and see the number of 
posts made per a student to a Threaded topic. 

While you can delete a Threaded Discussion content item containing topics, do so 
with caution. You can also delete a Thread topic without having to delete individual 
responses within the topic.  

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Design Tips: 

 One way to assure balanced student involvement and manage discussion in the Threaded 
Discussions is to divide your online class into discussion groups. From there, you can 
require each student to be a facilitator: post a message and respond to each of the group 
members. 

Open a Threaded Discussion 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, locate the Unit with the Threaded Discussion you want open. 

3. Click the Threaded Discussion content item to open it. 

  

See also: 

• Add Threads 

• Delete Threads 

• Grade Threads 

• Manage Thread Topics 

• Print Threads 

• Respond to Threads 

• Set Thread Preferences (Toolbox) 

• View Threads 

Hide or Show Content Items 

As an instructor, you can hide or show a content item from the students' view. This 
option is useful, for example, if you want to use pop quizzes in your course, or if you 
want to incorporate an entire publisher test bank (hidden from students) that can be 
referenced in quizzes and tests throughout the course. You can hide or unhide 
content items at any time.  

When you hide a content item, the item does not display in the student view of the 
course navigation, the student view of the Gradebook, or in the Coursework area. 
Hidden content items display with an asterisk * in the Author view of the navigation 
tree.  

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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To hide or show content item: 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the content item.  

3. Click Toolbox. 

4. Select the Hide item from students check box. If this box is already selected (i.e., the 
content item is already hidden), de-select the check box to show the item. 

5. Click Save Changes. 

  

Reorder or Move Content Items 

Once you've added content items to your course, you might decide that you want 
them in a different order or that you want to move them to another Unit. You can 
reorder content items within a Unit or between Units.  

Reorder content items within a Unit 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Unit in which you want to rearrange the content items. 

3. Click Toolbox. 

4. Click Change Item Order. 

5. Change the numbers in the Order column to reflect the new content order.  

6. Click Save Changes. 

Move content items to another Unit 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Unit that contains the content item you'd like to move.  

3. Click the individual content item you want to move. 

4. Click Toolbox. 

5. Click Move [content item name].  

6. In the Move to drop-down list, select the Unit to which you want to move the content 
item. 

7. Click Save Changes. 

Schedule Course Content  

Use the Course Scheduler feature to set start dates, end dates, and due dates for 
all the Units and content items in your course from a single location. If you assign a 
due date, the date displays on your students' Course Checklist. You can also use the 
Course Scheduler to restrict access to individual Units and content items and to 
determine the dates on which students can access exams in the Gradebook. 

Additionally, you can schedule individual content items or Units using the Edit 
Schedule feature located in the Toolbox for the individual content item. 
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If you schedule Start and End Dates for a Unit or a content item using the Course 
Scheduler, the same Start and End Dates display if you open the Event Scheduler for 
the individual Unit or content item (and vice versa). 

Schedule all content items and Units 

1. In the navigation tree, click the Author tab. 

2. In the Tools menu, click Course Admin. 

3. Click Course Scheduler. Depending on the amount of content in your course, the Course 
Scheduler can take up to a minute to open. 
 
The first time you open Course Scheduler, all Unit and content item dates are set to the 
same date (i.e., your course dates). This means all Unit start and end dates default to the 
start and end dates of your course, and all content item dates default to the Unit's date. 
 

4.  Set start and end date access times for your Unit and content items accordingly.  
 

Explain the columns in Course Scheduler  

 
In this 
column 

Do this 

Content Locate the Unit or content item for which you want to schedule a 
start/end date access time. 

Date 
Assignment 

Select either Use course start/end to allow student access using the 
default dates or Assign specific start/end to use your own start/end 
date values and not use the course default. 

Start Date Click  to open a calendar and select a start date for the Unit or 
content item. Use the arrow buttons in the calendar to move 
from month to month. Remember, the date you select must fall 
within the course's Start and End dates. If you don't want 
students to access the Unit or content item before the Start 
Date, select the Restrict access before check box.  

You can also enter a Start Date directly into the text field. Make 
sure you enter the date in one of the following formats: 
(mm/dd/yy); (mm.dd.yy); (mm-dd-yy); (mm,dd,yy). 

End Date Select an End Date for the Unit or content item (the same way 
you selected a Start date). If you don't want students to access 
the Unit or content item after the End Date, select the Restrict 
access after check box. 

Due Date 
(optional) 

Select a Due Date for the content item (the same way you 
selected a Start date). Assigning a Due Date is optional; 
however, if you choose to assign a Due Date the date will appear 
on the students' Course Checklist. 

Calendar 
Display 

Select one of the following: 
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 Do not display, to not display the start/end dates for the Unit or 
content item. 

 Start & end only, to display the start/end dates for the Unit or 
content item. 

 Duration of item, to display the Unit or content item within the 
specified start/end date range. 

 

5. Click Save Changes. 

Schedule a single content item 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the content item for which you want to schedule and assign 
dates or deadlines. 

3. Click Toolbox. 

4. Click Edit Schedule.  

5. Assign dates and preferences accordingly. 
 

Explain the fields in the Edit Schedule window 

 
In this field Do this 

Start and End 
dates 

Select: 

 Use Unit start and end dates, to display the default start/end 
dates for the Unit or content item. 

 Use the following dates, to set a specific date range for which the 
start/end dates for the Unit or content item display. Use the drop-
down lists to select dates or click . 

 Restrict access before, if you don't want students to access the 
Unit or content item before the Start Date.  

 Restrict access after, if you don't want students to access the Unit 
or content item after the End Date. 

Due Date 
(optional) 

Select a Due Date for the content item (the same way you 
selected a Start Date). Assigned due dates display in the 
students' Course Checklist. 

 

6. Click Save Changes.  
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Schedule a Unit 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Unit for which you want to schedule and assign dates or 
deadlines. 

3. Click Toolbox. 

4. Click Edit Schedule. 

5. Assign dates and preferences accordingly. 
 

Explain the fields in the Edit Schedule window 

 
In this field Do this 

Start and End 
dates 

Select: 

 Use course start and end dates, to display the default start/end 
dates for the Unit or content item. 

 Use the following dates, to set a specific date range for which the 
start/end dates for the Unit or content item display. Use the drop-
down lists to select dates or click . 

 Restrict access before, if you don't want students to access the 
Unit or content item before the Start Date.  

 Restrict access after, if you don't want students to access the Unit 
or content item after the End Date. 

Due Date 
(optional) 

Select a Due Date for the content item (the same way you selected a 
Start Date). Assigned due dates display in the students' Course 
Checklist. 

 

6. Click Save Changes. 

Toolbox 

Each content item you add to your course has a Toolbox associated with it. The 
Toolbox is where you can set preferences and properties for the current content 
item. Although most options in the Toolbox are common to all content items, there 
are several options that are unique to a particular content item. For example, 
Toolbox options for Exams are specific to Exams only, and Toolbox options for 
Threaded Discussion are specific to Threaded Discussion, etc.  

If your course uses Sharable Content Objects (SCOs), you can access the Toolbox 
associated with the SCO, but you will be unable to edit or otherwise modify the 
shared content object. As a result, in Author mode for a SCO content object, only the 
Toolbox button is available. 

Open Toolbox 

1. In the navigation tree, click the Author tab.  

2. In the navigation tree, click on the Unit or content item. 
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3. Click Toolbox.  
 
The toolbox properties change accordingly for the selected content item. The Assign To 
Groups option in Toolbox only shows if you've created groups in your course. Similarly, 
the Create a Dropbox Basket option is not available in the Toolbox for Exams or for 
Threaded Discussions. 

Toolbox for Units 

For this 
option 

Do this 

 Edit 
Schedule 

See Edit Schedule._Ref-907952437 

Edit a 
Unit title 

1. Open Toolbox. 

2. Click Edit Unit Title. 

3. Type a new title. The Unit title displays in the course when the 
student clicks that particular Unit and also in the Coursework section 
of the Course Home page. 
 
To display the title in the navigation tree, select the Use title in 
navigation menu check box; otherwise, the navigation tree displays 
according to the default General Course Info settings in your 
Course Preferences.  
 

4. Click Save Changes. 

 Change 
Item Order 

Once you've added content items within a Unit, you might decide 
that you want them in a different order. You can rearrange 
content items within a Unit at any time. 

1. Open Toolbox. 

2. Click Reorder Items. 

3. Change the numbers in the Order column to reflect the new order. 

4. Click Save Changes. 

Change 
Unit Order 

Once you've added Units to your course, you might decide that 
you want them in a different order. You can rearrange Units 
within a course at any time. 

1. Open Toolbox. 

2. Click Reorder Units. 

3. Change the numbers in the Order column to reflect the new order. 

4. Click Save Changes. 

Delete 
Unit 

When you delete a Unit, you also delete all content items within 
that Unit. 

1. Open Toolbox. 
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2. Click Delete Unit. 

Toolbox for content items (in general) 

For this 
option 

Do this 

 Edit 
Schedule 

See Edit Schedule. 

Create 
Dropbox 
Basket 

1. Open Toolbox. 

2. Click Create Dropbox Basket.  
 
Text to Delete Dropbox Basket and Go to Dropbox Basket 
displays. Once you create a dropbox basket from within the Toolbox, 
you can return to the Toolbox to delete it. 
 

3. Click Save Changes. 

 Move  Once you've added content items, you might decide that you 
want them in a different order, or you might want to move an 
item to another Unit. You can rearrange the order of content 
items within a Unit or move them to another Unit at any time. 

1. Open Toolbox. 

2. Click Move. 

3. At this point, you can: 

 In the Move drop-down list, select the Unit to which you want to 
move the content item. 

 Change the numbers in the Order column to reflect the new order. 

4. Click Save Changes. 

 Delete 1. Open Toolbox. 

2. Click Delete. A confirmation message displays. 

3. Click OK. 

The content item and the content it contains is deleted from your 
course.  

Assign to Select an audience for the item. This might be the entire class, 
groups, etc. 

Hide from 
students 

Hide the content item from course view so that students cannot see it. 
When you set up your course structure, you can hide and show content 
items as the course progresses. 

Toolbox for Exams 

For this 
option 

Do this 

 Edit See Edit Schedule._Ref-907952437 
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Schedule 

Move Once you've added content items, you might decide that you want 
them in a different order, or you might want to move an item to 
another Unit. You can rearrange the order of content items within 
a Unit or move them to another Unit at any time. 

1. Open Toolbox. 

2. Click Move. 

3. At this point, you can: 

 In the Move drop-down list, select the Unit to which you want to move 
the content item. 

 Change the numbers in the Order column to reflect the new order. 

4. Click Save Changes. 

 Delete 
1. Open Toolbox. 

2. Click Delete. A confirmation message displays. 

3. Click OK. 

The content item and the content it contains is deleted from your 
course. 

Assign to Select an audience for the item. You might assign the exam to a 
specific group of students, or to all students. This option is 
available only if you have created groups in your course.   

Hide Hide the exam from course view so that students cannot see it. 
When you set up your course structure, you can hide and show 
content items as the course progresses. 

Exam type Select either: 

 Students may only take the exam once, to restrict students from 
accessing the exam more than once. 

 Students may re-take the exam, to allow students to access the 
exam multiple times. This option is useful for practice quizzes.  

Time 
allowed 

Set a time limit for the Exam. Time limits determine how long 
students have to complete the exam. To exit students from the 
exam after the time limit expires, select the Kick students out of 
exam when time expires check box. If this check box is not 
selected, the set time limit is not in effect and the student will not 
be kicked out of the exam. 

The time limit option only applies if you selected Students may 
only take the exam once.  

Grading 
options 

Click Use Auto-Grading to score questions if you want the 
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system to automatically grade all objective questions in the exam. 
If you select this option, you can also choose to automatically 
display the auto-graded score to students in the Gradebook, or to 
display an auto-graded summary to students at the time they 
submit their exam. This summary immediately tells students how 
many questions they got right (by question type). 

Select how the results of the graded exam display to students in 
the Gradebook.  

Security 
password 

Set a password for the exam. Students cannot access the exam without 
the correct password. You are responsible for notifying students of the 
password. 

Toolbox for Threaded Discussion 

For this option Do this 

 Edit Schedule  See Edit Schedule._Ref-907952437 

Move Move the Threaded Discussion to another section or Unit in 
the course. You can also select this option to reorder the 
Thread within the Unit. 

1. Open Toolbox. 

2. Click Move. 

3. Type a new title. The Unit title displays in the course when the 
student clicks that particular Unit and also in the Coursework 
section of the Course Home page. 
 
To display the title in the navigation tree, select the Use title 
in navigation menu check box; otherwise, the navigation 
tree displays according to the default General Course Info 
settings in your Course Preferences.  
 

4. Click Save Changes. 

 Delete Delete the Threaded Discussion content item and all topics 
or Threads within it. 

1. Open Toolbox. 

2. Click  Delete. A confirmation message displays. 

3. Select the check box to accept the confirmation message, and 
then click Delete Content & Responses. 

Assign to Assign a target audience for the Threaded Discussion. This 
might be the entire class, groups, etc. 

Set all topics to 
"read only" after 
the scheduled end 
date 

Select this option to lock all Thread postings once the 
content item's End Date is passed. Students can view the 
Thread, but they will not see Respond or Edit buttons.  
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Allow students to 
edit their 
responses after 
posting 

 Select this option to allow students to edit their own 
Thread responses after they've posted them to a Threaded 
Discussion. If a Thread response is edited, a Last Modified 
date displays under the response, as well as the original 
post date. 

Hide item from 
students 

Hide the Threaded Discussion from course view so that students 
cannot see it. When you set up your course structure, you can 
hide and show content items as the course progresses. 

Toolbox for Learning Outcomes Manager  

Learning Outcomes Manager (LOM) is enabled from the Administrative pages. If LOM 
is not available to turn on or off from Enable/Disable tools, the LOM feature is not 
activated for your course.  

For this option Do this 

 Edit Title Change or rename the Learning Outcomes Manager content item 
title to how you want it to display under Course Home. For 
example, you might rename the title to "Performance 
Indicators," "Course Competencies," "Learning Objectives, " etc.  

Do not display 
Learning Outcomes to 
students in the 
Course View  

Either: 

 Select the check box to not show (default) Learning Outcomes 
Manager to students in Course view. 

 De-select the check box to display Learning Outcomes 
Manager to students in Course view as Read-only. The 
LOM page shows students their performance against set 
outcomes for the course. 
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Manage Files and Folders 
Your online course might include numerous files: document files, audio files, video 
files, images, etc. You can use the File Manger, also referred to as Course Folder, to 
help you organize and keep track of course files.  

File Manager enables you to upload files into your course rather than uploading files 
directly into content items. Additionally, you can create new folders within File 
Manager and organize them to follow the same structure as your course. For 
example, if your course is organized by Week 1, Week 2, etc., you can organize your 
folders in File Manager as Week 1, Week 2, etc. 

As you build your course, avoid using special characters (like "*," "-," "%," etc.) in 
the folder and file names you create or upload. Folders and files names with special 
characters are inaccessible from within Visual Editor when you add links to files and 
images in other areas of your course.  

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Design Tips: 

 Avoid using special characters (like "*," "-," "%," etc.) in the folder and file names you 
create or upload.  

 As a best practice, upload files no larger than 10 MB. The system will timeout from 
uploading files after 90 minutes.  

 For optimum performance, review the recommended guidelines for uploading and 
downloading files.  

To open File Manager: 

1. In the navigation tree, click the Author tab, and click Course Home. 

2. Click File Manager. By default, the main course folder and Streaming Media folder display. 
 
Use the Streaming Media folder to store any media files you might upload for the course. 
As you build your course, avoid using special characters (like "*," "-," "%," etc.) in the 
folder and file names you create or upload. Folders and files names with special characters 
are inaccessible from within Visual Editor when you add links to files and images in other 
areas of your course. 
 

Examples of file naming conventions to avoid 

 

Avoid Use 

Syllabus_Fall#1.doc Syllabus.doc 

Jo-Jo Smith.doc JoJo_Smith.doc 

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm


 

47 

Bob Smith Project 1 for ENG101.rtf bobsmithproj1.doc 

 

See also: 

• Add/Delete Folders 

• Delete Files 

• Upload/Download Files 

• Upload Streaming Media Files 

Add/Delete Folders 

You can add and delete folders from File Manager at any time to create and maintain 
the folder structure you want. When a new folder is added to the File Manager folder 
structure, it is created as a sub-folder within the selected folder. 

Add folders 

1. In the navigation tree, click the Author tab, and click Course Home. 

2. On the Course Home page, click File Manager.  

3. Click Add Folder. 

4. In the Folder Name field, type a name for the new folder. 

5. Click Add Folder. If you have another folder to add, click Save & Add Another Folder. 

Delete folders 

1. In the navigation tree, click the Author tab, and click Course Home. 

2. On the Course Home page, click File Manager. 

3. Select the check box to the folders you want to delete. For sub-folders, click on the root 
folder to expand it, and then select your folders. When you delete a folder, all files in that 
folder are deleted as well. You cannot delete the main course folder or the Streaming Media 
main folder. 

4. Click Delete. A confirmation message displays. 

5. Click Delete. 

  

Delete Files 

You can delete the files uploaded to File Manager at any time. When you delete 
folders created by you, the contents within the folder are also deleted.  

To delete files: 

1. In the navigation tree, click the Author tab, and click Course Home. 

2. On the Course Home page, click File Manager.  

3. Select the check box to the files you want to delete. For files contained within a folder, click 
on the folder to expand it, and then select your files. 

4. Click Delete. A confirmation message displays. 
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5. Click Delete. 

  

Upload/Download Files 

 You can use File Manager to upload course files rather than linking course files 
directly to content items. When you upload course files to File Manager, you can also 
download them at any time. Consider File Manager as your storage place for all of 
your uploaded course files. To make changes to an uploaded file, download the file, 
make your changes, and then re-upload the file. 

Design Tips: 

 Avoid using special characters (like "*," "-," "%," etc.) in the folder and file names you 
create or upload. 

 As a best practice, upload files no larger than 10 MB. The system will timeout from 
uploading files after 90 minutes.  

 For optimum performance, review the recommended guidelines for uploading and 
downloading files.  

Upload files 

1. In the navigation tree, click the Author tab, and click Course Home. 

2. On the Course Home page, click File Manager. 

3. Click on the folder to which you want to upload your files. 

4. Click Upload Files. 

5. Click Browse to locate and select the file you want to upload. If you upload a file with a 
different extension than what is supported by the system, zip the file(s) and then attach 
the .zip file. Remember, avoid special characters in folder and file naming conventions. 
 

Examples of file naming conventions to avoid 

 

Avoid Use 

Syllabus_Fall#1.doc Syllabus.doc 

Jo-Jo Smith.doc JoJo_Smith.doc 

Bob Smith Project 1 for ENG101.rtf bobsmithproj1.doc 

 

6. Click Upload File to upload the file to the selected course folder 
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Upload zipped or compressed files 

 If students are downloading large files or multiple files from your course, upload a 
zip file to decrease the download time for students. Remember, avoid special 
characters (like "*," "-," "%," etc.) in folder and file naming conventions. 

1. In the navigation tree, click the Author tab, and click Course Home. 

2. On the Course Home page, click File Manager. 

3. Click on the folder to which you want to upload your zipped file.  

4. Click Upload Files.  

5. Select the Unzip .ZIP file check box to unzip the file upon upload. Do not select this check 
this box if you want the zipped file visible in the folder tree. 

6. Click Upload Files to upload the file to the selected course folder. 

Download files 

1. In the navigation tree, click the Author tab, and click Course Home. 

2. On the Course Home page, click File Manager.  

3. Select the check box to the files you want to download. For files contained within a folder, 
click on the folder to expand it, then select your files. 

4. Click Download Files. Remember, if you are downloading a file to make changes to it, 
you must re-upload the changed file to use it in your course. 

  

Upload Streaming Media Files 

You can upload streaming media files to your course from within File Manager and 
Visual Editor. In File Manager, store any media files you might upload for the course 
in the Streaming Media folder. Students can access the streamed media as soon as 
you upload the files and provide the appropriate link. 

Design Tips: 

 Avoid using special characters (like "*," "-," "%," etc.) in the folder and file names you 
create or upload. 

 As a best practice, upload files no larger than 10 MB. The system will timeout from 
uploading files after 90 minutes.  

 For optimum performance, review the recommended guidelines for uploading and 
downloading files.  

Upload media files with File Manager 

1. In the navigation tree, click the Author tab, and click Course Home. 

2. On the Course Home page, click File Manager.  

3. Click Streaming Media. 

4. Click Upload Files. 

5. Click Browse to select the file you want to upload. Remember, the file must have an .ra, 
.rm, or .rpm file extension. 
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Examples of file naming conventions to avoid 

 

Avoid Use 

Syllabus_Fall#1.doc Syllabus.doc 

Jo-Jo Smith.doc JoJo_Smith.doc 

Bob Smith Project 1 for ENG101.rtf bobsmithproj1.doc 

 

6. (Optional) Select the Unizip .ZIP file check box if you are uploading a .zip file and want 
the system to unzip the content upon upload. Do not select this check this box if you want 
the zipped file visible in the folder tree. 

7. Click Upload File. 

Upload files with Visual Editor 

1. On the Visual Editor toolbar, click .  

2. Select a file type to upload.  
 

Examples of file naming conventions to avoid 

 

Avoid Use 

Syllabus_Fall#1.doc Syllabus.doc 

Jo-Jo Smith.doc JoJo_Smith.doc 

Bob Smith Project 1 for ENG101.rtf bobsmithproj1.doc 

 

3. Click Continue. The window changes according to your selection.  
 
If you selected either Link to Content or File or Insert an Image, make sure you are 
working from the appropriate tab: 

 Upload Content/Image - Click this tab to upload files to File Manager. 

 Select Content/Image from Course Folder - Click this tab to link to files stored in File 
Manager. 
 

4. Enter information accordingly. Some of the following fields display according to the type of 
file you are uploading. 
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 Text to display - Type the hyperlink text. This is the text students click on to open the 
file. 

 Descriptive text - Type text about the image. This is the text that displays when the 
cursor hovers over the hyperlink.   

 File to upload - Click Browse  to select the file you want to upload. 

 Folder for content - Select  Streaming Media. 

 Image to insert - Select the folder containing the image file you want to insert. 

5. Click Add Link. 
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Formatting Content (Visual Editor) 
 Don't know HTML? Not a problem! Use Visual Editor to create, modify, and format 
course content whether you're familiar with HTML or not. The Visual Editor makes 
formatting your course content as easy as editing with a word-processing document. 
Although HTML experience is not necessary to create your course, some general 
HTML background is helpful. We've included an HTML Quick Reference to help you 
with basic HTML code. 

The Visual Editor also includes a Plain Text Editor tool for advanced HTML authors. 
For example, use Plain Text Editor to copy and paste HTML content authored from 
authoring tools like Dreamweaver, or embed code from popular video media posted 
on YouTube. As an advanced HTML author, the Plain Text Editor is your solution to a 
more sophisticated authoring environment you can use without having the 

unexpected behaviors known to occur in Visual Editor's  HTML Code view. 

  For best results, click  to copy and paste text from MS Word documents to 

Visual Editor. By clicking , copied and pasted text from MS Word documents 
renders seamlessly. If you are proficient in HTML and consider yourself an advanced 
HTML author, you might consider switching to Plain Text Editor tool to write and 
format content for your course. 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Show the Visual Editor toolbar 

 

Explain the buttons on the Visual Editor toolbar 

Because the Visual Editor mirrors many familiar word-processing toolbar buttons, it 
is easy to use. Built into the course authoring mode, you'll see the Visual Editor 
throughout your course as you author.  

Some of the buttons on the Visual Editor toolbar are not available for instructors or 
students for the following Course Tools: Journal, Threaded Discussion, and Dropbox. 
Additionally, the student version of Visual Editor does not include Math Equation 
Editor, HTML View, Plain Text Editor, or the ability to add links, images, and files. 
These are instructor features only. 

Please note, Plain Text Editor and Math Equation Editor are configured by your 
System Administrator. This means, Plaint Text Editor and Math Equation Editor are 
available only if your System Administrator has turned them on for your course.  

Button Description 

 
Print the content currently displaying in the editor as it will appear to 
students. 

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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Search and Replace; search for and replace text based on parameters 
you specify.  

 
Cut the selected text.  

 
Copy the selected text. 

 
Paste the selected text into the editor. 

 
Paste the content of the clipboard into the editor without any 
formatting/display properties. Content is pasted as plain text.  

 Paste the content of the clipboard into the editor as HTML or Web 
code, allowing you to retain and see HTML code within the Design 
View. 

 
Paste the content from an MS Word document into the edit, allowing 
you to retain and see HTML code within the Design View 

 
Undo the previous X actions. 

 
Redo; perform the previous X actions. 

 
Create a link to a file or a Website (URL). The file you link to may be 
located on a hard drive or network drive. 

 
Create a link to an image. The image you link to may be located on a 
hard drive or a network drive.  

 Access the Math Equation Editor. This feature allows you to build and 
edit complex mathematical equations within your course.  

 
Run the current content through a spell check. 

 
Insert a special character or symbol. 

 
Insert the current date. 

 
Insert the current time. 

 
Create a table. Clicking this button opens a "table wizard" which will 
help you create a table with the parameters you specify. 

 
Change or set the color of the font. 

 Change or set the background or "highlight" color. Highlight the text, 
then click the Background button.  

 
Change or set the font for the text.  

 
Change or set the size of the font.  

 Bold the selected text.  

 Italicize the selected text.  

 
Underline the selected text.  

 Align the selected (and subsequent) text on the left.  

 
Center the selected (and subsequent) text.  
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Align the selected (and subsequent) text on the right.  

 
Force justify the selected (and subsequent) text right and left.  

 
Decrease the indent of the selected text (i.e., move the text left).  

 
Indent the selected text (right). 

 
Create a numbered list.  

 
Create a bulleted list.  

 
Insert a horizontal line at the current cursor position.  

 
Strike through or "cross out" the selected text.  

 
Edit content in the Design View. This option includes a full-screen edit 
mode, as well as a "zoom" option.  

 
Edit content using HTML code. Click the Indent HTML check box to 
indent your HTML code for easier viewing. Notice, too, that the 
toolbars disappear in this view. 

  

 See also: 

• Design & HTML view 

• Design Tips: MS Office Documents 

• Design Tips: Visual Editor 

• Link to Images, Files, and Websites 

• Math Equation Editor  

• Plain Text Editor 

Design & HTML View 

When you work in the Visual Editor, you can view your content in two formats: 
Design View and HTML View. 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor.  

Switch between Design View and HTML View 

Click  to work in Design mode and click  to work in HTML mode. 

 

View content in Design View 

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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Design View is the default view for the Visual Editor and is the view that allows you 
to use the toolbar for non-HTML course creation and revision. In this view you can 
create and format your content just as you would using a word-processing 
application.  

 
 PC Users: Work in "Full Screen" view by clicking the F11 key. To return to the 
original screen view, click the F11 key again.  

 

The Visual Editor can only accurately represent the five fonts listed in the drop-down 
list in the Design View. If you paste or write HTML code using a different font in the 
HTML View, the font will display in the Design View in Arial, although it will display 
correctly in your course. 

If you enter a hard return (i.e., press the Enter key on your keyboard) in the Visual 
Editor, the space between text lines will display as double spacing. To create single-
line spaced text, press Shift + Enter instead of just Enter. Note also that if you are 
pasting text into the Visual Editor that contains hard returns, the space between 
these lines will appear to be double spaced as well. You can remove the double 
spacing by changing the hard returns to soft (Shift+Enter) returns. 

View content as HTML 

HTML View shows you the HTML source code you created in the Design View. You 
can tweak the HTML code or add functionality that is not supported within the Visual 
Editor toolbar from the HTML View. The HTML View is an advanced option and should 
only be used if you are comfortable writing HTML or JavaScript. If you add JavaScript 
or other objects, such as Flash movies, applets, Active X controls, etc. to your course 
from the HTML View, these objects will not display in the Design View but will 
function correctly from your course. 
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Plain Text Editor 

Advanced in HTML and not a fan of Visual Editor? We have your solution! Plain Text 
Editor is the tool to use if you develop content in third party HTML editors for your 
course. Unlike the HTML Code view in Visual Editor, the Plain Text Editor is more 
sophisticated in rendering code and is designed to handle embedded code from 
popular media sources like YouTube. 

Like Visual Editor, the Plain Text Editor includes the same functionality and features 

to Add a Link, Insert an Image, and insert math equations using Math 
Editor. 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Design Tips: 

• Always save content authored in Visual Editor before switching to Plain Text Editor as the 
system will lose you work. 

• For best results, author in either the Plain Text Editor or the Visual Editor. It is not 
recommended that you author in both. Basically, once you begin authoring content for the 
course from Plain Text Editor, continue to use the Plain Text Editor for the lifetime of the 
course. The system remembers which editor was used. 

• Avoid toggling from the Plain Text Editor to Visual Editor (even after you click Save) as the 
system will not maintain the integrity of your code or content.  

Show the Plain Text Editor 

Switch from Visual Editor to the Plain Text Editor tool by clicking the Plain Text Editor 
link. To prevent losing existing content authored from the Visual Editor page, always 

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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click Save. As a best practice, author course content from one editor tool only. 
Toggling between Visual Editor and Plain Text Editor is not recommended as content 
is likely to be lost and embedded code is not rendered the same between the editors.  

  

Explain the buttons on the Plain Text Editor 

Because the Plain Text Editor mirrors the tools found in Visual Editor, the workflow to 
Add a Link, Insert an Image, and insert math equations using Math Editor are the 
same!  

The student version of Visual Editor does not include Math Equation Editor, 
HTML View, Plain Text Editor, or the ability to add links, images, and files. These are 
instructor features only. 

Button Description 

Add a 
Link 

Create a link to a file or a Website (URL). The file you link to may be 
located on a hard drive or network drive. 

Insert an 
Image 

Create a link to an image. The image you link to may be located on a hard 
drive or a network drive.  

Math 
Editor 

Access the Math Equation Editor. This feature allows you to build and edit 
complex mathematical equations within your course.  
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Design Tips: MS Office Documents  

When a Microsoft document is uploaded into the eCollege system, it is automatically 
converted to a Web document. Web documents aren't always identical to their 
Microsoft counterparts, however; not all Microsoft Office features are supported on 
the Web.  

Files can corrupt for a variety of reasons. Following is a list of questions of what to 
look for if you get an error uploading your file. If you're still having trouble after 
reviewing the questions, contact the Help desk for assistance. 

Is your file larger than 10MB? 

We recommend uploading files less than 2MB, but users with higher connection 
speeds might be able to upload larger files. For optimum performance, avoid 
uploading flies greater than 10MB. For optimum performance, review the 
recommended guidelines for uploading and downloading files. 

Does your file contain special characters? 

Avoid using any type of special characters in the file name, and keep the file name 
under 10 characters. The following table provides examples of file naming 
conventions to use and avoid.  

Avoid Use 

Syllabus_Fall#1.doc Syllabus.doc 

Jo-Jo Smith.doc JoJo_Smith.doc 

Bob Smith Project 1 for ENG101.rtf bobsmithproj1.doc 

Does your PowerPoint (.ppt) file contain Window Metafiles (.wmf)? 

Publisher PowerPoints containing .wmf (Windows Metafiles) images increase the file 
size by a considerable amount. To avoid this, save your images as .jpg and reinsert 
them into the PowerPoint (.ppt) to reduce the file size. 

Is your document set to Read Only? 

 If so, the file cannot be saved as a Web page. 

Is Spell Check turned on? 

If so, turn Spell Check off and re-save your document. To turn off Spell Check in 
Word, go to the Tools menu and click Options. On the Spelling and Grammar tab, 
clear the Check spelling as you type check box. Make sure you re-save your file. 

Does your file contain macros? 

 For security reasons, files containing macros cannot be uploaded to the eCollege 
system. To see if your document contains any Macros, go to the Tools menu and 
click Macro. Remove any Macros in your file or presentation.  
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Can you save your document as a Web page on your computer? 

Try saving the document as a Web page on your computer; then open up the file. If 
you get an error message, it is possible that your file will not convert to a Web page 
in the eCollege upload tool.  

Design Tips: Visual Editor 

The Visual Editor is built into the course authoring mode and allows you to format 
text for display on the Web without any HTML knowledge. Microsoft Office 
applications (Word, Excel, PowerPoint, and Access) use a format for saving pages in 
HTML that the Visual Editor may render differently than was originally designed.  

Following are some tips on how to avoid or solve these formatting inconsistencies. 
After saving your pages, be sure to check the formatting to ensure that it displays 
the way you intended. 

Formatting 
Control 

Issue Solution 

Using the 
Headings 
style to format 
text 

If you use a Heading tag 
(i.e., Heading 1) to format 
text, and then manually 
change the text to be a 
different font type or size, 
when you copy and paste 
the text into the Visual 
Editor, the Heading tag is 
recognized, but any manual 
changes are not. 

Make any manual style changes 
to content from within the Visual 
Editor.  

Pasting text 
styled as 
"Normal" into 
the Visual 
Editor  

When you paste text into 
the Visual Editor that is 
styled as "Normal" in your 
Word document, the Visual 
Editor displays the text in 
ITS default or "Normal" font 
(Verdana).  

Before you paste your text into 
the Visual Editor, highlight all 
the text and manually set the 
correct font and font size. That 
is, apply a specific font and size 
rather than using the "Normal" 
tag.  

Pasting 
modified 
custom 
paragraph 
styles into the 
Visual Editor 

If you modify a custom 
paragraph style such as 
"Body Text" in your Word 
document, any changes you 
make will not display in the 
Visual Editor. 

Before you paste your text into 
the Visual Editor, highlight all 
the text and manually set the 
correct font and font size. 

Pasting 
bulleted / 
numbered lists 
into the Editor 

If you do not copy and 
paste the entire list, from 
top to bottom, the list 
formatting may not come 
over correctly. This issue is 

Make sure you copy the entire 
list, from the top to the bottom, 
into the Visual Editor.  You may 
also want to consider pasting 
your list into the HTML View and 
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most common if you copy 
content from the middle of 
a list. 

then formatting your content in 
the Design view. 

Adjusting line 
spacing 

If you enter a "hard return" 
(i.e., hit the ENTER key) in 
the Visual Editor, the space 
between text lines will 
display as double spacing. 
Similarly, if you are pasting 
text into the Visual Editor 
that contains hard returns, 
the space between these 
lines will appear to be 
double spaced as well. 

To create single-line spaced 
text, press SHIFT+ENTER 
instead of just ENTER if you're 
entering text directly into the 
Visual Editor. You can remove 
double spacing of text you 
copied and pasted into the 
Visual Editor by changing the 
hard returns to "soft" 
(SHIFT+ENTER) returns with the 
Editor. 

Viewing fonts 
in the Design 
View 

In the Design View, the 
Visual Editor can only 
accurately represent the 
five fonts listed in its drop-
down list. If you have 
assigned a font other than 
those appearing in the 
drop-down list to your text, 
the text will not display in 
the correct font. 

If you paste or write HTML code 
in the HTML View that uses a 
font other than those listed in 
the Design View, the font will 
display in Arial in the Design 
View but it will display correctly 
in your course or campus. 

Waiting for 
content to 
"paste" into 
the Visual 
Editor 

Copying and pasting from 
Word into the Visual Editor 
may take a moment.  For 
instance, if you are copying 
a large table from Word to 
the Visual Editor, you may 
experience up to a minute 
delay while the tool parses 
the correct HTML from the 
Word document into the 
Visual Editor. 

Be patient. 

Math Equation Editor 

The Math Equation Builder (Equation Editor) helps you create complex 
mathematical equations and formulas to share with your students. Accessed from 
the Visual Editor, the Equation Editor is available in Journal and Gradebook, and 
anywhere in your course where the Visual Editor displays. The Equation Editor 
includes a comprehensive set of mathematical symbols and templates that are easy 
to access from pull-down palettes. You can use the tool to build, demonstrate, and 
apply mathematic notations, formulas, and sample equations throughout your 
course. 
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Any time you create a new equation, it is saved in a list of equations for that course. 
As a result, you can create equations and insert them into your course content at the 
time they are created, or you can create and store equations in a list to use later. 
Once an equation is created and stored, you can insert it into your course as many 
times as you like. You can also edit an equation from the Equation List and update 
the equation in all instances of the course. 

Please note, Math Equation Editor is available only if your System Administrator has 
turned it on for your course. If the Math Equation Editor tool does not show in Visual 
Editor, it means Math Equation Editor is not turned on for your course. 

Design Tips:  

 When you insert an equation into the Visual Editor, you need to make sure you click Save 
Changes. If you forget to save changes to the Visual Editor, the equation is still saved in 
your Equation List, but the equation does not display in the Visual Editor and you'll need to 
re-insert it. 

  If you have a software application with which you currently generate MathML code, you can 
copy and paste existing MathML code into the Equation Editor. 

Add a new equation 

1. Within Visual Editor, position your cursor in the exact place where you want to insert or add 
an equation.  

2. On the Visual Editor toolbar, click . The Equation Editor window opens. Any equations 
you've already created in the course are listed alphabetically by equation title. 

3. Click Create New Equation. 

4. Type a unique title for the new equation. For example, a title you might use is: Quadratic 
Formula, Unit 4 Equation, or Section 3 Quiz Question #9. Equations are listed 
alphabetically by title in the Equation List. 

5.  Create your equation using the toolbar buttons and pull-down options. 
 
To create your equation, single click on a button to display a pull-down palette of additional 
functions. From the palette, select the operation or symbol you want to add. The symbol or 
function displays in the Equation Editor. If you're creating an equation, use the Tab key or 
the arrow keys to move from one part of the equation to the next. When you've finished 
creating the equation, press Enter to set the equation. 
 

6. When you're finished creating your equation, click one of the following: 

 Save & Insert, to insert or append the equation into the current text area and save the 
equation to the Equation List. 

 Save, to save the equation to the Equation List without inserting it in the current text 
area. 

 Cancel, to return to the Equation List without saving any of your work. 
 
If you have a software application with which you currently generate MathML code, you 
can copy and paste existing MathML code into the Equation Editor (saving you from 
having to re-create equations you've already built.) 
 
To paste existing MathML equations into the Equation Editor, click the Show MathML link 
at the bottom of the Equation Editor window. Paste your existing MathML code into the 
editing field that displays. You can modify the code you pasted in with this editor or 
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modify equations that are currently displaying in the Equation Editor window, whether 
you pasted them in or not. When you're finished, click Done to save your changes. 

Edit an existing equation 

1. Within Visual Editor, click . The Equation Editor window opens. 

2. In the Equation List, click the + plus sign next to the title of the equation you want to edit. 
This expands the equation. 

3. Click Edit. The equation displays in the Equation Editor editing area. 

4. Make your changes to the equation as needed. 

5. When you're finished editing the equation, click one of the following: 

 Replace & Insert, to save the edited equation to the Equation List and to overwrite the 
equation everywhere it's been used or inserted in the course. 

 Replace, to save the edited equation to the Equation List without inserting it into the 
current text area. This option also replaces the edited equation everywhere it displays in 
the course; that is, the Replace option overwrites all instances of this equation. 

 Save as New, to save the edited equation to the Equation List as a new equation with a 
new title (you must rename the equation). If you select Save as new, you need to 
return to the Equation List and insert the equation into the Visual/Text editor. 

 Cancel, to return to the Equation List without saving your changes. 

Insert an existing equation 

1. Within Visual Editor, position your cursor in the exact place where you want to insert or add 
the equation.  

2. On the Visual Editor toolbar, click . The Equation Editor window opens. 

3. In the Equation List, click the + sign next to the title of the equation you want to insert. 
This expands the equation. 

4. Click Insert. The equation is inserted at the current cursor position. 

Delete an existing equation 

1. Within Visual Editor, position your cursor in the exact place where you want to delete the 
equation.  

2. Select the equation in the Visual Editor, or the equation's <img> tag in the Text Editor, 
with your cursor, and then press Delete on your keyboard. The current instance of the 
equation is deleted. 
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Course Tools 
The course tools help you communicate and interact with your students. Your 
students can use course tools to communicate with you and with other students. You 
can enable and disable specific course tools and features from the Course Admin 
page.  

See also: 

• Course Admin 

• Gradebook 

• Email 

• Live 

• Doc Sharing 

• Dropbox 

• Journal 

• Webliography 

Set Course Preferences (Course Admin) 

The Course Admin page is where the initial administrative setup takes place for your 
online course. Use the Course Admin tool to set global, course-wide preferences. Just 
like a traditional course, your online course requires administrative setup. Set your 
course preferences to access or determine general course information, course 
enrollment, and group management. Instructors can specify titles for course sections 
(Units, Modules, Chapters, Weeks, etc.) to set a tone for the class. 

To open the Course Admin page: 

1. On the Tools menu, click Course Admin. 

2. The main Course Admin page contains three tabs:  

 General Information and Preferences - Click to set course options and settings for 
General Information and Preferences, Style Manager, Enable/Disable tools, Threaded 
Discussion, Course Scheduler and Path Builder, and Survey Report Wizard. 

Style Manager and ClassLive can be disabled at the administrative level. If your 
institution has chosen to disable these features, you will not see them listed. 

 Course Enrollment - Click to view a list of students currently enrolled in the course. 

 Group Management - Click to organize students into groups or teams for the course.  

Whichever tab in the Course Admin tool you are working in, the course preference 
settings you select apply course-wide. You can change course preference settings at 
any time. 

See also: 

• General Information and Settings 

• Style Manager 

• Enable or Disable Tools 
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• Threaded Discussion Preferences 

• Schedule Course Content and Build Paths 

• Course Enrollment 

• Group Management 

• Locale/Language 

Gradebook 

You and your students have access to a shared online Gradebook. Use the 
Gradebook to determine which aspects of your course should be graded and add 
these items to your online Gradebook as gradable items. Next, assign a "total points 
possible" value to each gradable item. As students complete assignments, you can 
evaluate their work and then enter their grades into the Gradebook. If you entered a 
total point value for each gradable item when you set up your Gradebook, the 
Gradebook can use the students' actual points and the total points possible to 
calculate current student grades at the content item, Unit, and course 
level. Students' names display in Gradebook after they have enrolled in your course.  

Additionally, you can use Gradebook to post comments for each grade, grant 
students additional test time, create links to course content for review, and view 
students' activity in the course. You can also create custom gradable items as they 
relate to the course, such as participation, group projects, extra credit, assignments, 
etc.  

See also: 

• How to Set Up Gradebook  

• Add Items to Gradebook 

• Assign and Change Grades 

• Assign Extra Credit 

• Assign Points and Weights 

• Design Tips: Gradebook and Exams 

• Exclude Grades 

• Export Grades 

• Preview Gradebook Settings 

• Quick Grade View 

• Reset or Grant Additional Time 

• Select Gradable Items 

• Set Gradebook Preferences 

• Share Grades with Student 

• View Grades 

• View User Activity 
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Email 

Use email to address student questions, concerns, and issues individually or send 
messages and files to groups of students. When a user is enrolled in an eCollege 
course, his/her email address is uploaded into that course.  

Students can use email to send private messages to instructors regarding course or 
assignment questions or other personal concerns, or to communicate with other 
group members on collaborative projects. The carbon copy (Cc) option is not 
available to students. 

Design Tips: 

 Instead of answering every Thread in a Threaded Discussion, use Email after the discussion 
is over to highlight specific student responses or critique issues that came up. 

To send an email: 

1. On the Tools menu, click Email. 

2. Select the name of the email recipient in the Select Recipients box. 
 
You can send email to All Class Members, groups of students that you have set up within 
the course, a single class member, or multiple class members. When you add a Group 
name to the Recipients list, the individual group members' names display in the list rather 
than the name of the group. 
 

3. Click  and  to add or remove recipients to and from the Recipients box. 

4. Select the Do not disclose recipients (bcc) check box if you do not want the email 
recipients on the list to see the other recipients of the email. For example, if you send an 
email to a group of students who did poorly on a quiz, you don't want these students to see 
the other students who also did poorly. 

5.  In the Cc field, type the email address of those you would like copied on the message. 
Only instructors have this option. 

6. In the Subject field, type a subject for your message and the message in the Visual Editor. 

7. (Optional) Click Add/Remove  to attach a file to your message. Select the file in the 
window that opens and click Open. You can attach more than one document to an email. 

8. Click Send Message. The system distributes the email and sends a copy of your message 
to your personal email account. 

Live 

Use the Live (synchronous) tools, Chat and ClassLive, to incorporate the same 
interaction from a traditional classroom setting into your online course. Chat and 
ClassLive enable you to communicate and interact with your students through the 
use of features like chatrooms, shared desktops, presentations, virtual tours, 
interactive quizzes, and more.  

See also: 

 Chat 

 ClassLive 
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Chat 

The Chat tool enables you and the students in your course to communicate with each 
other in real time.  

See also: 

 Add, Edit, and Delete Chatrooms 

 Chat Logs 

 Participate in Chat 

Add, Edit, and Delete Chatrooms 

There is a main chatroom for every course. You can create different chatrooms for 
different purposes or groups. You can also rename, edit, or delete an existing 
chatroom.  

Add chatrooms 

1. On the Tools menu, click Live. By default, the main Chat page displays. 

2. Click Add Chatroom. 

3. In the Name field, type a name for the room. 

4. In the Description field, type a short description of what kind of discussion should take 
place in that room. 

5. (Optional) Select the Private room check box if you don't want a chat log created for the 
new chatroom. By default, a chat log is created for every room. 

6. In the Assign Room To drop-down list, select who can access the new chatroom. You can 
make the chatroom available to all class members or to specific groups you've defined 
within the course. 

7. Click Add Room. If you have more rooms to create, click Save & Add Another Room. 

Edit or rename chatrooms 

1. On the Tools menu, click Live. By default, the main Chat page displays. 

2. In the Edit column, click   for the chat you want to rename or edit. 

3. Make your changes accordingly, and click Save Changes. 

Delete chatrooms 

Remember, when you delete a chatroom, the logs for that room are no longer 
available. 

1. On the Tools menu, click Live. By default, the main Chat page displays. 

2. In the Delete column, click  for the chat you want to delete. A confirmation message 
displays. 

3. Click Delete Room & Chat Logs. 
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Chat Logs 

Chat sessions are automatically saved in chat logs, which you and your students can 
view, save, and print.  

View chat logs 

1. On the Tools menu, click Live. By default, the main Chat page displays. 

2. In the Chat Logs column, click  beside the chatroom for which you'd like to view a chat 
log. 

3. Click a specific archive date to open the archive and see the chat log for that date.   

Print chat logs 

1. On the Tools menu, click Live. By default, the main Chat page displays. 

2. Open the Chat you want to print. Make sure the text information you want to print is visible 
on your page. 

3. Click the Print button in your browser to print the page.  

Save chat logs 

You can share interesting chat logs with students by copying the logs into a MS Word 
document and attaching that document to an email message, or by posting it in the 
course. 

1. On the Tools menu, click Live. By default, the main Chat page displays. 

2. Open the Chat log. 

3. Highlight the text you want to save. 

4. Click Ctrl + C to copy the text to the clipboard. 

5. Open a new document (a MS Word document, for example) and click Ctrl + V to paste the 
contents of the clipboard into your new document.   

6. Save the document. 

Delete chat logs 

1. On the Tools menu, click Live. By default, the main Chat page displays. 

2. In the Chat Logs column, click  to view the chat logs. 

3. In the Delete column, click  beside the log you want to delete. A confirmation message 
displays. 

4. Click Delete. 

Participate in Chat 

Chatrooms enable you to communicate with your students in real time meaning, you 
can communicate with other students because you are logged into the course and 
using Chat at the same time. 

Open a chatroom 

1. On the Tools menu, click Live. By default, the main Chat page displays. 
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2. Click the chatroom you'd like to participate in. A confirmation window opens. 

3. Click  to open the chatroom.  
 

 

 
You can also use your keyboard to open a chatroom by pressing Alt + Enter. Once 
you've selected the chatroom you'd like to participate in, click  Alt + Enter on your 
keyboard and the chatroom opens.  
 

 

4. Type your message in the text field at the bottom of the chatroom and press the Enter key. 
Your text appears in the chatroom. 

Send a private chat message 

1. Open a chatroom. 

2. From within the chatroom, double-click the name of the person you want to send a private 
message to. A small window opens. 

3. In the window, type the private message text.  

4. Press the Enter key. Your message is seen only by the recipient to whom you sent the 
message. 

Add a link to a Website in the chatroom 

1. Open a chatroom. 

2. Before you add a link, ensure that:  
 

 Web Touring under the Options menu in the chatroom is on.  

 Turning on Web Touring ensures that the Web page to the URL link you are 
sending opens for the recipient in a separate window. Pop-up Blocker under the Tools 
menu in your Web browser is turned off. Turning off Pop-up Blocker ensures that the Web page 
to a URL link you send or receive opens. 

3. Type the full URL address in the field at the bottom of the chatroom and press the Enter 
key. Your URL displays in the chatroom. The URL address must include http://www. for the 
recipient of the link to view the Web page.  

ClassLive 

ClassLive is an interactive graphical chat tool that allows you to communicate with 
your students in real time. For example, you can place or draw objects on the 
whiteboard, you can share a software application from your computer, you can send 
and receive graphed or plotted equations, you can participate in synchronous chat 
sessions with your students, you can broadcast live audio, and you can work through 
complex mathematical, accounting, and chemistry problems one step at a time. Use 
ClassLive with a group of students, or use the tool for one-on-one help. 

 
As a stand-alone tool, ClassLive includes a training page with video tutorials and 
additional documentation provided by Elluminate, Inc.  

Before you begin... 

http://www.elluminate.com/support/training
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 Ensure your computer meets the specific technical requirements to use ClassLive.  

 The ClassLive tool is enabled by default. Instructors can turn ClassLive on or off 
from the Course Preferences page. If you don't see a link to ClassLive on the Live 
tab of your course, the tool is turned off. Remember, you can always use the 
regular Chat feature of your course to conduct simple synchronous discussions. 

 Join ClassLive 5 – 10 minutes prior to the start of your session and set your 
Connection Speed to the Internet. 

 Close all applications running on your computer that you don't intend to use with 
your ClassLive session. Running other applications slows down your connection to 
ClassLive. 

Ways to use ClassLive 

 Following are some ideas to get you thinking about how you can use ClassLive in 
your course. Some features are only available to ClassLive Pro users. Ask your 
administrator which ClassLive version you are running.  

 Meet with students one-on-one to help them individually with course work. ClassLive is 
especially useful for helping students with mathematics, accounting, and chemistry 
equations. 

 Present a PowerPoint slideshow or display other uploaded images. Use the toolbar to add 
notes to slides and to point out important sections of the slide or image. 

 Use the Application Sharing feature to teach students how to use applications like Excel, 
PowerPoint, or any other application on your computer. Students can watch as you walk 
them through menu options, toolbars, and other features of the application. 

 Share a Website with your students with the WebTour feature and have your students 
follow you through the site. 

 Incorporate the Broadcast Audio feature into your session to walk students through a 
presentation, emphasize specific sections of the whiteboard, notify students that you're 
switching boards, or to add a personal touch to your online course. 

 Upload course notes and highlight areas of importance.  

 Use the Graphing Calculator feature to create visual representations of equations. Have 
students make modifications to the equation, re-create the graph, and send the new graph 
back to you.  
Use the Polling feature to ask your students if they're ready to move to the next slide. You'll 
know almost immediately whether they're ready to go on.  

 Turn the ClassLive session into a live forum in which groups can present their projects to 
the rest of the class. 

 Use Quiz Manager to conduct live quizzes and review the results with students as a class 
or privately.  

  
Open a Breakout Room to personally help students who might be falling behind the rest of 
the class and tutor them individually or in small groups.  

See also: 

• Audio and Messaging 

• FAQs 

• Participate 

• Plan and Publish Sessions 
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• Session Archives 

• Whiteboard 

  

Audio and Messaging 

You can use any of ClassLive's audio and messaging tools to speak to all students or 
individually in a private session on the side. The messaging area is where you can 
send text messages to everyone, selected students or to one student in the session. 
Students can always send a text message to you, even when they do not have 
messaging privileges. Students' messages will display as a private message to you 
and other instructors in the session. Depending on your session configuration, you 
can monitor all messages that are sent, including private messages. Direct messages 
are color-coded for your benefit: Black text means the message was sent to 
everyone in the session, Blue text means that you sent or received a message, and 
Red text means that a student has sent a private message to another class member.  

 As a stand-alone tool, ClassLive includes a 3training page with video tutorials and 
additional documentation provided by Elluminate, Inc. 

ClassLive FAQs 

Since the ClassLive feature might be new to you, we've compiled a list of frequently 
asked questions. Check the list below to see if your questions have already been 
asked and answered. 

 As a stand-alone tool, ClassLive includes a training page with video tutorials and 
additional documentation provided by Elluminate, Inc. On the support page you will 
find a link to Technical Support which includes additional FAQs.  

What happens if I select Follow Moderator? 

The Follow Moderator button, when selected, forces students to see only the changes 
you make to the Whiteboard. This feature is useful when you want to prevent 
students from having the ability to access other ClassLive tools within a session while 
you are demonstrating a problem or leading a Web tour. 

How do I draw a circle or square? 

Use the drawing tools on the Whiteboard toolbar to create objects. To draw a circle, 
click the Draw an Ellipse on the page button. To draw a rectangle, click the Draw 
a Rectangle on the page button. We have created a table to help you understand 
how to use the Whiteboard drawing tools. Click here to open this table in a separate 
window. 

I made a mistake on the board? How can I remove or fix it? 

To correct a mistake on the Whiteboard, select the object, right-click, and then select 
Delete Object(s) to remove the object. 

How can I print or save the text message portion of the ClassLive discussion? 

http://www.elluminate.com/support/training
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To print a text message log, you must first save the text message as a text file. 
From the File menu, select Save, and then select Chat Conversation. In the Save 
Chat Conversation window, select a file name and the folder to which you want to 
save the file, and then click Save. The suffix .txt is added to the file name. You can 
use Notepad, WordPad or any word processing application to open the text file and 
print it. 

How can I save a Whiteboard page in the ClassLive discussion? 

From the File menu, select Save, and then select Whiteboard. The Save File 
window opens. Navigate to and open the file folder to which you want to save the 
Whiteboard. Type a file name in the File Name text box and scroll through the Files 
of Type drop-down menu to select a file format. Click Save to close the Save File 
window. The Select Screens window opens. Select whether you want to save all the 
pages in the Current Screen Group, only the Current Screen, or the Selected 
Screens. If you select Selected Screens, an explorer window opens showing all 
available pages. Select the pages you want to save from the explorer window. Use 
the Shift or Ctrl (Command) key to select multiple pages, and then click OK. 

Do I have to minimize my shared application if I want to return to the ClassLive 
application? 

No, ClassLive's Application Sharing feature allows you to open applications within the 
main area of the Whiteboard. When you first login as the instructor, you 
automatically have the permission to begin sharing your desktop. To start 
Application Sharing, on the Tools menu select Application Sharing, and then select 
Host Applications. Host Application Sharing is only available to ClassLive Pro users. 

Are my ClassLive session archived? How can I view an old session? 

All ClassLive sessions are archived and can be viewed by both instructors and 
students. On the Live tab, you can access an archived session from the ClassLive link 
in your course. Locate the Session Archives section to see a list of all archived 
ClassLive sessions in the current course. ClassLive sessions are archived by date and 
time if no name was given to the session at the time it was closed out. 

How do I broadcast live audio? 

Before you can broadcast video, you must enable video support. To enable video 
support, On the Tools menu, select Video, and then select Enable Video Camera 
Support. A check mark indicates video is not enabled. Broadcast Live Video is only 
available to ClassLive Pro users. 

Can I save my ClassLive sessions? 

Yes, you can save the Whiteboard pages from every session. If you have content you 
would like to save from a breakout room, you must copy the content into the main 
Whiteboard page to capture the information in a saved session. 

How do I exit the ClassLive session? 

To exit the ClassLive session, click Exit from the File menu. 

Can I save the quiz created in Quiz Manager? 

Yes! You can save quizzes created in Quiz Manager; however, quizzes created within 
a ClassLive session are saved in XML format and are not connected to the course 
Gradebook. If you want your students' quiz results stored in the course Gradebook, 
you must create the quiz within the main course (outside of ClassLive). 
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How can I enlarge the view of the text messaging area? 

The Chat window in ClassLive is resizable. To enlarge the window, on the View menu 
clear the Layout Locked setting (selected by default). You can resize the window 
diagonally, by clicking on the corner of the Chat window and dragging your mouse. 
You can also resize the window vertically and horizontally. 

How can I see the entire Whiteboard area? 

There are two ways you can maximize the Whiteboard viewing area. First, click the 
"maximize" button in the top-right corner of your session window. This maximizes 
the entire ClassLive session window so that the session fills your entire page. 
Second, from the View menu, clear the Layout Locked setting (selected by default), 
and then double-click on the title bar of the Whiteboard. This also expands the 
Whiteboard area to fill the entire page. Double-click again in the title bar of the 
Whiteboard to return to the original view. 

How do I delete an object from the Whiteboard? 

Select the object you would like to delete and right-click, and then select Delete 
Object(s). The selected objects clear from the Whiteboard. To delete all objects on 
the Whiteboard, click the Eraser button on the Whiteboard toolbar. A confirmation 
message opens. Select All Objects to delete all content on the Whiteboard. 

How can I change the color of my drawing tool? 

Each time you select a drawing tool on the Whiteboard toolbar, editing attributes 
display in the Quick Editor located at the bottom of the Whiteboard page area. The 
editing attributes change according to the selected drawing tool. Editing attribute 
options can include color palette, font, size, and style. To change the color of your 
drawing tool, click on a color in the Quick Editor color palette and begin to draw in 
the main area of your Whiteboard page. Your drawing displays in the selected color. 

How do I move, copy, or delete an object?  

Select the object you want to Move, Copy, or Delete. With the object selected, right-
click and select Move, Copy, or Delete Object(s). 

What objects can I edit on the Whiteboard? 

You can edit all objects on the Whiteboard. 

Participate 

Participating in ClassLive is easy! Use the Participants window to view the current 
students in your session and control their privileges to speak, send messages, use 
the whiteboard, use the graphing calculator, host application sharing, respond to poll 
questions, and more. Upon entering a session, your name displays in blue text in the 
Participants window. During a session, the Participants window uses activity lights to 
indicate to you when a student experiences delays in receiving content or steps away 
from a session.  

 As a stand-alone tool, ClassLive includes a training page with video tutorials and 
additional documentation provided by Elluminate, Inc.  

To open ClassLive: 

1. On the Tools menu, click Live. 

http://www.elluminate.com/support/training
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2. Click ClassLive.  

3. Click either Lead Session to lead a live session or Join Session to join a session as a 
participant. Only one instructor can lead a ClassLive session. 

Plan and Publish Sessions 

Don't have time to login to course? No problem! More convenient than ever, 
ClassLive provides Plan! and Publish!, a plug-in feature enabling you to create 
ClassLive sessions outside of course and publish sessions for viewing outside of the 
your virtual classroom. This means, you can work outside of ClassLive and work in 
advance to plan and develop a ClassLive session. Once a session is archived, use the 
Publish feature to have access to the recorded session outside of the course. 
Accessible at any time, you and your students can review archived sessions without 
logging into the course!  

 
As a stand-alone tool, ClassLive includes a training page with video tutorials and 
additional documentation provided by Elluminate, Inc.  

Before you begin... 

 Ensure you download the license key to ClassLive's additional tools, Plan! and 
Publish!, and save the key to your desktop or to any location you will remember. 

 The ClassLive tool is enabled by default. Instructors can turn ClassLive on or off 
from the Course Preferences page. If you don't see a link to ClassLive on the Live 
tab of your course, the tool is turned off. Remember, you can always use the 
regular Chat feature of your course to conduct simple synchronous discussions. 

 Join ClassLive 5 – 10 minutes prior to the start of your session and set your 
Connection Speed to the Internet. 

 Close all applications running on your computer that you don't intend to use with 
your ClassLive session. Running other applications slows down your connection to 
ClassLive. 

Download Plan! 

For a successful download, ensure you have the license key for Elluminate Plan!. The 
license key is a one-time entry meaning, once you have installed Plan! and entered 
the license key, you won't use the license key again. 

1. Open ClassLive. 

2. Click Download Key. Save the license key file to your Desktop or any location you will 
remember. 

3. Click Download Plan!. The installation dialog window displays. 

4. Click Run. 

5. Follow the instructions of the Elluminate Setup Wizard to complete downloading Plan!. 

6. Once you click Finish on the last page of the Setup Wizard, Plan opens! 

Download Publish! 

For a successful download, ensure you have the license key for Elluminate Publish!. 
The license key is a one-time entry meaning, once you have installed Publish! and 
entered the license key, you won't use the license key again.  

http://www.elluminate.com/support/training/next/


 

74 

1. Open ClassLive. 

2. Click Download Key. Save the license key file to your Desktop or any location you will 
remember. 

3. Click Download Publish!. A confirmation message displays.  

4. Click OK. The installation dialog window displays. 

5. Click Run.  

6. Follow the instructions of the Elluminate Setup Wizard to complete downloading Publish!. 

7. Once you click Finish on the last page of the Setup Wizard, Publish! opens! 

Plan a ClassLive session 

Once Plan! is installed on your computer, you can access ClassLive without logging 
into your course and work ahead in planning and developing a ClassLive session! As 
a stand-alone tool, ClassLive Plan! includes a training page with video tutorials and 
additional documentation provided by Elluminate, Inc. 

Publish a ClassLive session 

 Once Publish! is installed on your computer, you can access and view archived 
ClassLive sessions without logging into your course! As a stand-alone tool, ClassLive 
Plan! includes a training page with video tutorials and additional documentation 
provided by Elluminate, Inc. 

  

  

Session Archives 

Archived Class Live sessions are useful for recording sessions for future course use 
and for providing a way for students to review course material- especially for 
instances when a student is absent from a course session. If you like, you can also 
create tutorial sessions and archive them for students to access and view as needed.  

 
As a stand-alone tool, ClassLive includes a training page with video tutorials and 
additional documentation provided by Elluminate, Inc.  

View archived sessions 

1. Open ClassLive. 

2. From the Session Archives section of the page, locate the Session Date column. 

3. Click to select the date of the ClassLive session you want to view. The recorded session 
opens.  

Rename Archived Sessions 

For a successful download, ensure you have the license key for Elluminate Plan! The 
license key is a one-time entry meaning, once you have installed Plan! and entered 
the license key, you won't use the license key again. 

1. Open ClassLive. 

2. From the session Archives section of the page, locate the Title column. 

http://www.elluminate.com/support/training/next/
http://www.elluminate.com/support/training/next/
http://www.elluminate.com/support/training/next/
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3. Click  for the Title you want to rename or edit. 

Download Archived Sessions 

For a successful download, ensure you have the license key for Elluminate Publish!. 
The license key is a one-time entry meaning, once you have installed Publish! and 
entered the license key, you won't use the license key again.  

1. Open ClassLive. 

2. From the session Archives section of the page, locate the Download column.  

3. Click  for the session you want to download and publish for viewing outside of the 
course. Remember, you must download ClassLive Publish! before you can download 
archived sessions to view offline (outside of course). 

Delete Archived Sessions 

Deleting an archived ClassLive session does not permanently delete the session from 
the system. If you need to retrieve a deleted session or have deleted an archived 
session by accident, please contact your Client Services consultant. 

1. Open ClassLive. 

2. From the Session Archive section of the page, locate the Delete column. 

3. Click  for the session you want to delete. A confirmation messages displays. 

4. Click OK. 

  

  

Whiteboard 

The Whiteboard is the main presentation window. Use the Whiteboard to present 
slides or as a work area where you and your students can write, draw, or type. As 
the instructor, you must manage all the pages in the Whiteboard, the page content, 
and the student permissions to view and work on the Whiteboard pages.  

As a stand-alone tool, ClassLive includes a training page with video tutorials and 
additional documentation provided by Elluminate, Inc.  

To use Whiteboard tools: 

1. Open ClassLive. 

2. Click any one of the tools, located on the left side of the Whiteboard, to select it. Editing 
attributes for the selected tool display at the bottom of the Whiteboard in the Quick Editor.  
We have created a table to help you understand how to use the Whiteboard drawing tools. 
Click here to open this table in a separate window. 

3. Position your cursor on the Whiteboard, and then click and drag the mouse to begin 
drawing. 

4. Release the mouse button to complete the action. 

http://www.elluminate.com/support/training
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Doc Sharing 

Use Doc Sharing to share documents with your students for the course. You and your 
students can upload and download documents, images, spreadsheets, .zip files, and 
HTML pages. Students can download documents you share or download documents 
shared by other students. Additionally, students can view, build, revise, or recreate 
the documents they download and then upload their changes for the entire class to 
view. 

Both you and your students can access shared files, but only instructors can delete 
files. Instructors can also create and edit Document Sharing categories.  

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Design Tips: 

 Some instructors use Doc Sharing as a holding place for resources used later in the course. 
You can upload documents for students to access at any time. 

 Have students post assignments in DocSharing. This is especially useful when students are 
expected to review and critique other students' work as part of the learning process. 

 Students can upload assignments or other document files to Doc Sharing that they want to 
submit for general class review and consumption. Students working in groups can share a 
single draft of an assignment, reading, or project and continue to revise, edit, and review 
the single document as they collaborate together on their joint task. Or, each student in the 
group can submit their portion of the project to the document sharing area so that all 
"parts-of-the-whole" can effectively be synthesized from the contributions submitted in this 
area. 

  If you want students to have the ability to view each other's files, encourage students to 
use the same file format. For example, if a student is unable to view MS Word 2000 files, 
encourage the class to post documents in another common format. 

See also: 

• Categories for Shared Files 

• Delete Shared Files 

• Download Shared Files 

• Edit Shared Files 

• Mark Files as Shared or Private 

• Upload Files to Share 

• View Download History 

Delete Shared Files 

Delete uploaded files from Doc Sharing that you no longer want available for use in 
the course.  

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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To delete shared files: 

1. On the Tools menu, click Doc Sharing.  

2. Do one of the following: 

 Locate the document you want to delete, and then click  . A confirmation message 
displays.  

 If you've added a Document Sharing category, click on the category listed in the Document 
Sharing Categories table to view the documents uploaded for that category. Locate the 
document you want to delete, and then click  . 

3. Click Delete to confirm that you want to permanently delete the document from the 
course. 

  

Download Shared Files 

Download files from Doc Sharing to save them to your hard drive for future viewing, 
editing, etc. In the list of files available to download, you can see who the owner of 
the file is, the date the file was uploaded, the file size, whether the file is shared, and 
its download history record. Students can also use Doc Sharing to download files 
from the course.  

Design Tips: 

 You can select and download all of the documents in DocSharing at once. The system zips 
the files upon download.   

 If you are using Internet Explorer as your browser, the file opens in a new browser window. 
If you’d rather save the file directly to your hard drive, right-click on the file in the 
File/Description list and select Save Target As. 

To download a shared file: 

1. On the Tools menu, click Doc Sharing. 

2. Do one of the following: 

  
In the File Name/Description column, select the check box beside the documents you want 
to download. To download all documents, select the check box beside the File 
Name/Description link. 

 If you’ve added a Document Sharing category, click the category listed in the Document 
Sharing Categories table to view the documents uploaded for that category. In the File 
Name/Description column, select the check box beside the documents you want to 
download. 

3. Click Download Documents. 

  

Edit Shared Files 

Some instructors have a master copy of the files they upload to Doc sharing. If you 
have made changes to your master copy and would like to replace what you 
previously posted to Doc Sharing, you can re-upload the document to replace it. If 
you do not have a master copy of a file you posted to Doc Sharing, you can 
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download the current version posted in Doc Sharing, make your changes, and then 
re-upload the document; however, if you do this, you must use the same file name 
in order for the modified file to replace the existing document in Doc Sharing. 

To edit a shared file: 

1. On the Tools menu, click Doc Sharing.  

2. Do one of the following: 

 Locate the file listed on the page, and then click . 

 If you've added a Document Sharing category, click on the category listed in the 
Document Sharing Categories table to view the documents uploaded for that category. 
Locate the file listed on the page, and then click . 

3. Make your changes in the fields provided. 

 Share file with - Select Instructor Only if you only want the document available to 
you and not to students. Select Entire Class if you want the file available to view and 
download by the entire class. 

 Replace file with - Click Browse to upload the modified file to the course again, using 
the same file name. The new, modified file replaces the existing file. 

 Description - Type a description about the file you are posting. For example, if you are 
posting lecture notes for Units 1 and 2, you might type the description "Lecture notes for 
Units 1 and 2." 

 Owner - Type the name you want listed on the main Doc Sharing page as the owner of 
the file. 

4. Click Save Changes. 

  

Categories for Shared Files 

Organize the documents uploaded to Doc Sharing by creating categories to sort and 
view individual entries. For example, you might create subject categories: 
Management, Accounting, Operations; team categories: Group A, Group B; or 
assignment categories: Week One, Week Two, etc. As an instructor, you can add, 
delete, and edit categories in Doc Sharing at any time. 

Add categories 

1. On the Tools menu, click Doc Sharing. 

2. Click Add Category. 

3. Enter information accordingly: 

 Category Title - Type a new category title. 

 (Optional) Assign category to - Assign the category to a group. You can share Doc 
Sharing categories with the entire class or, if you have students working in groups, you can 
assign categories to a specific group. 

4. Click Add Category. To add additional categories, click Save & Add Another Category. 
Once a category is added, it is listed under the Categories column in the main Document 
Sharing page. 
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Delete categories 

When you delete categories, the documents contained within that category are also 
deleted. Only instructors can delete categories and the documents they contain. 

1. On the Tools menu,  click Doc Sharing. 

2. In the Delete column in the Document Sharing Categories table, click  beside the 
category you want to delete. A confirmation message displays.  

3. Select the check box to confirm that you want to delete the category and the documents it 
contains. 

4. Click Delete Category & Documents. 

Edit categories 

1. On the Tools menu, click Doc Sharing. 

2. In the Edit column in the Document Sharing Categories table, click  beside the 
category you want to edit. 

3. Make your changes accordingly: 

 Category Title - Type a new category title. 

 (Optional) Assign category to - Assign the category to a group. You can share Doc 
Sharing categories with the entire class or, if you have students working in groups, you can 
assign categories to a specific group. 

4.  Click Save Changes. 

  

Mark Files as Shared or Private 

As an instructor, you can upload files to Doc Sharing for your own viewing, or you 
can upload files to share with the entire class. Files set to Entire Class are viewable 
by both the instructor and students, whereas, documents set to Instructor Only 
can only be viewed by the instructor. You can mark a file that a student has shared 
as private, although the file will remain visible to the student who shared it because 
they are the owner. 

To mark a file as shared or private: 

1. On the Tools menu, click Doc Sharing.  

2. Locate the file you want to share or not share. 

3. In the Share column, click to toggle the share setting between Entire Class or Instructor 
Only. 

Upload Files to Share 

Use Doc Sharing to upload course files to either share with the class or have 
available for your own viewing. If you add categories to Doc Sharing, you can upload 
and assign files to that specific category.  

 Design Tips: 

 Save the file that you want to upload to Doc Sharing on your desktop or another familiar 
folder so that it is easy to locate when you begin to upload the file to Doc Sharing.  
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 Avoid using special characters (like "*," "-," "%," etc.) in the folder and file names you 
create or upload. 

  If you upload a file with a different extension than what is supported by the system, zip the 
file(s) and then upload the .zip file for your students to download. 

To upload a file for sharing: 

1. On the Tools menu, click Doc Sharing. 

2. Click Upload Document.If you want to upload the document to a specific category, first 
locate and click the category name, and then click Upload Document. Remember, use 
avoid special characters in your folder and file names.  
 

Examples of file naming conventions to avoid 

 

Avoid Use 

Syllabus_Fall#1.doc Syllabus.doc 

Jo-Jo Smith.doc JoJo_Smith.doc 

Bob Smith Project 1 for ENG101.rtf bobsmithproj1.doc 

 

3. In the fields provided, enter information accordingly. 
 

Explain the fields 

 

In this field Do this 

Share file 
with: 

Select either: 

 Instructor Only, to not share the document with students and make 
the file viewable to you only. 

 Entire Class, to allow students to view the uploaded document. 

Find new 
file: 

Click Browse to locate the file you want to upload. 

Unzip 
.ZIP file: 

(Optional) Select the Unzip ZIP File check box if you are 
uploading a zipped file and want the system to unzip the file 
upon upload. 

Owner Verify that the document owner is correct; otherwise, type a new 
name. 
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4. Click Upload Document. 

5. Type a description for the document telling students what to expect when they open the 
document. This description displays in the Doc Sharing list.  

6. Click Add Entry. Your entry displays in the main Doc Sharing page. 

View Download History 

As an instructor, you can view a record of how many times a file has been 
downloaded from Doc Sharing, which students have downloaded a particular file, and 
the date the file was downloaded.  

To view a file's download history: 

1. On the Tools menu, click Doc Sharing. 

2. Locate the document for which you want to view the download history. The Downloads 
column shows the number of times the file has been downloaded. 

3. In the Downloads column, click the number to open the Download History window. The 
download history record displays for the selected file. 

4. Close the window to return to the main Doc Sharing page. 

  

Dropbox 

The Dropbox tool provides a central location where you and your students can 
submit and retrieve assignments and graded activities. Think of the Dropbox as a 
virtual Inbox and Outbox for course assignments where you can:  

 Retrieve submitted assignments from your students in your Inbox 

 Send graded assignments back to your students in your Outbox 

Your Dropbox/Inbox is also linked directly to the Gradebook, which makes it easy to 
open an assignment, grade it, and then record the student's grade directly into the 
Gradebook all from one place. Students can open a graded item from either the 
Dropbox or from the Gradebook and see their grade for that item. You can also 
attach files and documents to assignments when you return them to students. If you 
attach a file with a different extension than what is supported by the system, zip the 
file(s) and then attach the .zip file. 

Design Tips: 

 You can move Dropbox submissions between baskets so long as the student does not have 
a submission in the other basket. 

 You can select students within Dropbox and navigate to the Email tool with the selected 
students automatically inserted as recipients. 

 You can select and download all submissions in Dropbox at once. The system zips the files 
upon download. 

 Click the No Submissions tab to view a list of those students who have not submitted 
documents to Dropbox.  
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 For best results, avoid using special characters (like "*," "-," "%," etc.) in the folder and file 
names you upload to Dropbox. 

 Have students submit assignments to Dropbox. This reduces the amount of email you 
receive, and can substantially reduce clutter and possible confusion for you and for your 
students.  

 Students will appreciate a central location for submitting and retrieving assignments and 
graded activities. Since Dropbox links directly to the Gradebook, you can view and grade 
submitted work from a single location. You can also create links within the course that go 
directly to the Dropbox, so students know exactly how and where to submit assignments. 

See also: 

• Create Baskets 

• Edit or Delete Baskets and Items 

• Grade Dropbox Items 

• Link Content Items to Dropbox  

• Move Items to Another Basket 

• View Dropbox Items 

Create Baskets 

Before students can submit an assignment to the Dropbox, you must first create a 
Dropbox basket for the content item. You can create a Dropbox basket for a content 
item when you first add the content item to the course, or you can add the Dropbox 
basket for the content item later. Only content items for which you have created 
Dropbox baskets display in the Dropbox submission area for students. Students 
select the appropriate Dropbox basket and then submit their assignment to that 
basket. 
 
 

Create a Dropbox basket for a new content item 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, select either Course Home or the Unit to which you're adding the 
new content item. 

3. If you're adding a new content item to 

• Course Home, click Course Items, and then click Add Items. 

• Unit, click Unit Content Items, and then click Add Items. 

4. Select the Create dropbox basket check box. In the other fields provided, enter 
information accordingly. 
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Explain the fields 

 

In this field Do this 

Name: Either: 

 Type a name for the new content item. When you enter a new item 
name, it displays in the Select existing item name drop-down list. 
 
Naming content items lets you customize your course. For example, 
you might create an .xls spreadsheet content item in your course 
and name the content item "Worksheet."  
 

 Select an existing content item from the drop-down list. This list 
displays names to previously created content items. 

Item type: Select a content item type. 

Add to: Select either Course Home or the Unit to which you want to add 
the content item. 

Assign to: Select the audience for the content item. 

Hide item 
from 
students 

Select this check box if you do not want the content item to 
show in course view to students. 

Some instructors like to work ahead and add content items to 
the course, hide them, and then add the content to the content 
items at a later time. 

Create 
dropbox 
basket 

Select this check box to create a Dropbox basket for the content 
item. When you create a Dropbox basket for a content item, 
students can submit assignments related to the content item 
directly to the Dropbox basket for the item.  

 

5. Click Add Items. This adds the new content item to your Course Home page or Unit and 
automatically creates a Dropbox basket for the new content item.  

Create a Dropbox basket for an existing content item 

1. In the navigation tree, click the Author tab. 

2. Click on a content item.  

3. Click Toolbox. 

4. Click Create Dropbox Basket. A Dropbox basket is created for the selected content 
item.  

If a Dropbox basket was previously created for the selected content item, this link 
will read Delete Dropbox Basket instead. 
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5. Click Save Changes. 

Once you create a Dropbox basket for a content item, students can use the Dropbox 
feature to submit assignments to the basket. Dropbox baskets are always named 
after the Unit and the content item name (i.e., Unit 4: Readings). You can, however, 
rename or edit Dropbox baskets._Ref-1323454095 

Edit or Delete Baskets and Items 

By default, all Dropbox baskets are created and named after their Unit and content 
item name. For example, Unit 2: Readings. This helps students when they submit an 
assignment because they can easily associate their assignment with the correct 
Dropbox basket. As an instructor, you can rename and delete Dropbox baskets. 

Edit a Dropbox basket name 

1. On the Tools menu, click Dropbox. 

2. In the Edit column, click . 

3. Make your changes and click Save Changes. Students must submit assignments to the 
new or revised Dropbox basket. 

Delete a Dropbox basket 

1. On the Tools menu, click Dropbox. 

2. In the Delete column, click . A confirmation message displays. If the basket contains 
items, select the check box to accept the confirmation message. 

3. Click Delete Basket. If the basket contains items, click Delete Basket & All Items. 

You can also delete a Dropbox basket and its contents from the Toolbox for a 
particular content item.   

Grade Dropbox Items 

The Dropbox makes it easy to grade assignments and return the graded work to 
students. In fact, you can open and grade assignments from the Dropbox without 
having to go to the Gradebook! 

The submissions you review from students might contain information, comments the 
student entered at the time the assignment was submitted, and any attachments or 
files part of the assignment itself. You can open and view attachments from your 
Inbox. You can also add comments and enter grades from the Quick Grade View 
(Gradebook Details) window. 

Design Tips:  

 You can only enter grades through Dropbox for assignments that you have set up in the 
Gradebook as gradable. 

 Current items not marked as gradable display NA in the Number/Letter Grade columns of 
your Dropbox and do not display Number/Letter Grade fields in the Gradebook Details 
window. 

 Any grades you save through the Dropbox are saved to your Gradebook as well. This means 
you can assign and save a grade from the Dropbox and do not have to transfer the grade to 
the Gradebook. 
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 There are several ways you can return graded assignments to students. You can return 
each individual assignment as you grade it, or you can grade all assignments and then 
return them all at once. 

 When a student submission includes an attachment,  displays next to the assignment 
name in your Inbox. Hold your mouse over  to display the file name of the attachment.  

 To open the Gradebook Details window, click on the student name rather than  (if the 
assignment includes an attachment). If you click , the attached file opens in a separate 
browser window. You can always access the attachment from the Gradebook Details 
window. 

Explain the Quick Grade View (Gradebook Details) window 

Use the Gradebook Details window in Dropbox to add comments, assign grades, and 
return grades to students. The grades you assign are saved to your Gradebook. To 
open the Gradebook Details window, go to your Inbox and click the student's name.  

Field Description 

Numeric Grade Type a numeric grade for the submission. This field only displays if 
you've identified the content item as gradable in your Gradebook. 

Letter Grade Type a letter grade for the submission. This field only displays if you've 
identified the content item as gradable in your Gradebook. 

Weighted 
Average 

Displays the weighted average for the submitted assignment based on 
the values entered in the Gradebook. 

Return to 
student upon 
closing 

(Selected by Default) Saves the grade and returns the assignment to 
the student. In this case, the grade is saved and the assignment is 
returned to the student (i.e., the assignment moves from your Inbox 
to your Outbox and the student is able to see the assignment in 
his/her Inbox.) Leave this check box selected if you want students to 
receive their graded assignment after you close the Gradebook Details 
window; otherwise, clear the check box. 

Visual Editor Type any comments, suggestions, etc. that you might have about the 
student's submission. For example, you might want to include why you 
assigned the grade you did, or you might direct the student to areas 
for additional study. 

Add/Remove Click to attach a file to your review and return it to the student. 

Save 

Save and 
Next 

  

  

  

Save and 
Close 

Cancel 

Saves the grade without returning the assignment to the 
student. 

Saves the grade and opens the next student assignment.  

Please note, the  Save and Next button cycles through Inbox 
items till there are no more items to be graded. Once the last 
item in your Inbox is graded, the Save and Next button is 
disabled. 

  

Saves the grade and closes the Gradebook Details window. 

Closes the Gradebook Details window without saving any of 
your changes. 
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Details Displays the name of the student who submitted the assignment, the 
date and time the assignment was submitted, whether there are 
attachments with the submission, and any comments or notes the 
student might have entered for you. You can view attachments here by 
clicking on the attachment icon. Note that you can only view the file; 
you cannot make changes or comments within the attachment. You 
can, however, attach a file to your response in the Gradebook Details 
window. You can also click  to delete the submission. 

Assign grades 

Current items not marked as gradable display NA in the Number/Letter Grade 
columns of your Dropbox and do not display Number/Letter Grade fields in the 
Gradebook Details window. 

1. On the Tools menu, click Dropbox. 

2. In the Name column, click the basket you want to open.  

3. On the Inbox tab, either: 

 Click the student's name to open the Gradebook Details window and enter 
information accordingly.  

 Type a grade for the assignment in either the Numeric Grade field, Letter 
Grade field, or both. 

4. Click Save Changes. 

  

Assign grades to multiple students 

1. On the Tools menu, click Dropbox. 

2. In the Name column, click the basket you want to open.  

3. On the Inbox tab, click the student's name to open the Gradebook Details window and 
enter information accordingly.  

4. Click Save and Next. The grade is saved in your Gradebook, but the assignment remains 
in your Inbox and is not shared with the student. 

5. Continue to grade additional assignments in the same way, clicking Save and Next. The 
Save and Next button cycles through Inbox items till there are no more items left to 
grade. Once the last item is graded, the Save and Next button is disabled. 

6. When you're ready to return all the assignments to your students, click Save and Close to 
return to your Inbox.  
 

Return graded assignments 

1. On the Tools menu, click Dropbox. 

2. In the Name column, click the basket you want to open. 

3. On the Inbox tab, either: 

 Click the student's name and select the Return to student upon closing check box in 
the Gradebook Details window. Click Save and Close to return to your Inbox and open 
the Gradebook Details window for the next student. 

 In the Return column, select the check box for any student whose assignment you are 
returning. 
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4. Click Save Changes. The assignment is returned to the student's Inbox and moves to your 
Outbox.  

  

Move Items to Another Basket 

Sometimes students might submit an assignment to the wrong basket. If this is the 
case, do not worry! You can move student submissions to other baskets within 
Dropbox at any time; however, you can only move a student submission to a basket 
that does not already contain items from that student.  

To move items to another basket: 

1. In the Tools menu, click Dropbox. 

2. Click on the basket you want to open. 

3. In the Student column, select the check box next to the student whose submission you 
want to move to another basket. 

4. Click Move to Basket. In the drop-down list, select a basket destination for the 
student's submission. 

View Dropbox Items 

The views in Dropbox enable you to see the number of student submissions and 
unread items you have in your Inbox, who you have replied to or distributed grades 
to in your Outbox, and which students have not submitted anything to you yet in the 
No Submissions box. 

Additionally, you can sort how items display in each of the Dropbox views. 
Regardless of the sort option you choose, assignments that students submit for a 
grade always display in your Inbox, and the assignments you grade, review, or 
return always display in your Outbox.  

View Inbox 

Your Inbox lists all submissions from students including comments, notes, and 
attachments. The  icon displays when an attachment is included.  

1. On the Tools menu, click Dropbox. 

2.  In the Inbox Items column, you can see which basket contains unread items. Click on the 
basket for which you want to view the Inbox. 

3. From your Inbox you can:     

 Send Email - Click Send Email to open the Email window.  

 Download Attachments - Click Download Attachments to download the attachments 
from a single student or multiple students.  

 Move items to another basket - Click Move to Basket to move a student's submission to 
a different basket. 

 Grade submissions - Click any name in the Name column to open the Gradebook Details 
window for that student and assign a grade or enter a comment. 

 Mark items as returned - Select the check box in the Return column to track those 
student submission you have returned. 
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View Outbox 

Your Outbox view lists all responses, attachments, and grades you have sent to 
students. If you have set up items as gradable in the Gradebook, the Letter or 
Numeric grade for student submissions displays. 

1. On the Tools menu, click Dropbox. 

2. Click on the basket for which you want to view the Outbox. 

3. Click the Outbox tab.  

4. From your Outbox you can:     

 Send Email - Click Send Email to open the Email window.  

 Download Attachments - Click  to download the attachment from a student. 

View No Submissions box 

Your No Submissions box lists which students have submitted nothing to the 
Dropbox. If you have set up items as gradable in the Gradebook, the Letter or 
Numeric grade for student submissions displays. 

1. On the Tools menu, click Dropbox. 

2. Click on the basket for which you want to view the No Submissions box. 

3. Click the No Submissions tab. 

4. From your No Submissions box you can:     

• Send Email - Click Send Email to open the Email window.  

• Grade submissions - Click any name in the Name column to open the Gradebook Details 
window for that student and assign a grade or enter a comment. 

• Mark items as returned - Select the check box in the Return column to track those 
student submission you have returned. 

Sort items in Inbox, Outbox, and No Submissions box 

Depending on your current Dropbox view (Inbox, Outbox, No Submissions box, 
Students, or Entire Inbox) you can sort items to display by:   

 Student - Sorts all items for one student only. For example, if you select a 
student's name from the list in the Name column, all the assignments submitted 
by the selected student display in your Inbox and Outbox, regardless of the 
Dropbox basket the assignments were originally submitted to. No other 
assignments from other students would display. 

 Date/Time - Sorts all items by the Time/Date of the submission. 

 Items - Sorts all student submissions in Student view by the item. 

 Basket - Sorts student submissions in Entire Inbox view by the basket. 

View submissions from all students 

You can view a complete list of all students in the course showing the number of 
items every student has submitted. If you have set up items as gradable in the 
Gradebook, the Letter or Numeric grade for student submissions displays.  

1. On the Tools menu, click Dropbox. 

2. Click Students. 
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3. From the Students view you can: 

 Send Email - Click Send Email to open the Email window. 

 View Inbox items by student - Click on a student's name to display all Inbox items for 
that student. 

View entire Inbox  

You can view a complete list of all students in the course showing the number of 
items every student has submitted. If you have set up items as gradable in the 
Gradebook, the Letter or Numeric grade for student submissions displays.   

1. On the Tools menu, click Dropbox. 

2. Click Entire Inbox. 

3. From the Entire Inbox view you can: 

 Send Email - Click Send Email to open the Email window. 

 View all Inbox items - Click on the Inbox tab to display all items in your Inbox. 
Unread items are marked with . If you like, select the check box in the Return column 
to track which student submissions you have returned. 

 View all Outbox items - Click on the Outbox tab to display all items in your Outbox. 
The Outbox shows you students for which you have returned assignments.  

 Grade submissions - Click any name in the Name column to open the Gradebook Details 
window for that student and assign a grade or enter a comment.  

 Mark items as returned - Select the check box in the Return column to track those 
student submission you have returned. 

Journal 

The Journal tool is a place where students can write notes and record thoughts. You 
can use the Journal as an assignment area. For example, post articles or questions in 
students' Journals and then require students to respond.  

Students have the option of sharing their Journal entries with you. As an instructor, 
you can read, modify, and comment in the Journal entries that students choose to 
share. 

Design Tips: 

 Think of the Journal as a personal, one-to-one communication tool between you and an 
individual student. Journal entries are only viewable by you and the student submitting the 
entry.  

 The intimacy provided by the Journal allows students to more openly comment and remark 
on issues and concerns about the course. To this end, the Journal provides an avenue for 
students to ask questions and make remarks that they would not normally ask in a more 
open forum. Encourage your students to use the Journal for freely expressing thoughts and 
asking questions.  

 Students can also choose to keep their Journal entries private, allowing them to take notes, 
add personal thoughts, etc., as they choose. 
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Add Journal entries 

Both you and your students can use the Journal tool to make Journal entries. 
Remember, students can designate entries as private, which means they are only 
viewable by the student, or as shared.  

1. On the Tools menu, click Journal. 

2. In the Name column, click the student's name.  

3. Click Add Entry. 

4. Type a title for your entry, and then type your entry in the Visual Editor.  

To view the comments you add to a student's Journal, ensure that Share Entry with 
Instructor is selected; otherwise, select PrivateEntry so that your comments are 
only visible to the student. 

5. Click Add Entry. 

Delete Journal entries 

1. On the Tools menu, click Journal. 

2. In the Name column, click on the student's name. 

3. Click  next to the entry you want to delete. A confirmation message displays. 

4. Click Delete. 

Edit Journal entries 

Instructors can edit student Journal entries marked as shared. Students can make 
additions and corrections to their own Journal entries, although they cannot delete 
them.  

1. On the Tools menu, click Journal. 

2. In the Name column, click on the student's name. 

3. Click  next to the entry you want to edit.  

4. Type your comments or corrections.  
 
To view the comments you add to a student's Journal, ensure that Share Entry with 
Instructor is selected; otherwise, select Private Entry so that your comments are only 
visible to the student. 
 

5. Click Save Changes. 

View Journal entries 

You can view all of a student's Journal entries at once, or you can view one entry at 
a time. Also, you can click the Shared Journal Entries column heading and sort the 
Journal view by the number of entries. 

1. On the Tools menu, click Journal. 

2. In the Name column, click on the student's name. For each Journal entry, the date on 
which the last modifications were made display, in addition to the names of each person 
who has modified the entry. If both you and the student have modified the entry, both 
names display. 

3. Click on the Journal entry to expand and view that entry. You can only view entries that the 
student has marked as shared. 
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4. Click: 

 Expand All, to view all entries at once. 

 Collapse All, to close all entries when they are all expanded. 

Webliography 

Use the Webliography tool to work together with your students in creating an 
annotated bibliography of World Wide Websites relevant to your course. Both you 
and your students can add sites to the Webliography. Students can greatly increase 
the knowledge capital of the course by submitting Websites they have found.  

You can sort Webliography entries by the date they were submitted, by category, or 
by the person who submitted the entry. 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Design Tips: 

 Some instructors create an assignment in the first week of class that asks students to find 
three Websites relevant to a specific topic and then add them to the Webliography. The next 
week, students are asked to evaluate three of the Websites that other students posted. This 
exercise is an effective way to teach students the art of researching on the Web. 

 Set up the Webliography with a few examples of the type of entries students might expect 
to find. Include a spurious entry along with the legitimate ones to use in a discussion on 
analyzing information found on the Web. A humorous Website also makes a nice addition to 
the Webliography, especially if the humor is in some way related to the subject. 

  

See also: 

• Add Categories 

• Add Entries 

• Delete Entries 

• Edit Entries 

• Search Entries 

Add Categories 

A way to manage Webliography entries is to organize your students' entries by 
category. This makes it easy for you and your students to sort and view individual 
entries. For example, you might create subject categories: Management, Accounting, 
Operations; team categories: Group A, Group B; or assignment categories: Week 
One, Week Two, etc. Only instructors can add, edit, and delete Webliography 
categories.  

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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Add categories 

1. On the Tools menu, click Webliography. 

2. Click Add New Category. 

3. In the Category Name field, type a title for the category and click Add Category.  

4. Click Save & Add Another Category to add additional categories. 

Edit categories 

1. On the Tools menu, click Webliography. 

2. Click Edit/Delete Categories. 

3. In the Name column, rename the category. 

4. Click Save Changes. 

Delete categories 

 As an instructor, you can delete entries and categories. When you delete a category, 
the system deletes the category but not the entries it contains. Webliography 
categories and the entries they contain are deleted separately. 

1. On the Tools menu, click Webliography. 

2. Click Edit/Delete Categories. 

3. In the Delete column, click  beside the category you want to delete. A confirmation 
message displays. 

4. Click Delete. 

Add Entries 

Both you and your students can add Website entries to the Webliography. 

To add an entry: 

1. On the Tools menu, click Webliography. 

2. Click Add New Entry.  

3. In the Title field, type a title for your Website and assign it to a category from the 
Category drop-down list. Only categories you've created for your course display in the 
drop-down list. If you haven't created any Webliography categories, the General option is 
the only category option available. 

4. In the Web Address (URL) field, type the URL address to the Website. 

5. In the fields provided, enter information accordingly: 

 Description - Describe what students will find when they go to this site. 

 Site Author - Type the name of the author or creator of the site. 

 Site Last Edited - If available, type the date the site was last modified. 

 Submitter First Name/Last Name - Type your name so the Webliography list shows you 
as the submitter of the site. 

6. Click Add Entry. 
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Delete Entries 

As an instructor, you and can delete entries in the Webliography at any time. If you 
added categories to your Webliography, search the Webliography by category to 
quickly locate the entry you want to delete.  

To delete an entry: 

1.  On the Tools menu, click Webliography. 

2.  In the Delete column, click  beside the entry you want to delete. A confirmation 
message displays. 

3. Click Delete. 

 
 

Edit Entries 

As an instructor, you can edit Website entries in the Webliography at any time. 

To edit an entry: 

1. On the Tools menu, click Webliography. 

2. Do one of the following: 

  Click  beside the entry you want to edit. 

 If the Website entry is assigned to a category, click the category name to display the entries 
for that category, and then click . 

3. In the fields provided, make changes accordingly. 
 

Explain the fields 

 

In this field Do this 

Title: (Required) Type the title of the site.  

Category: Select a category to assign the site to. For example, for a 
Website about the stars, you might select Astronomy. You 
can add categories to organize Webliography entries at any 
time. 

Web Address 
(URL): 

(Required) Type the address of the Website. 

Description: Describe what students will find when they go to this site. 

Site Author: Type information, if available, about the author or 
contributors. 
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Site Last Edited: If available, type the date the site was last modified. 

Submitter 
First/Last Name: 

Type your name so the Webliography list shows you as the 
submitter of the site. 

 

4. Click Save Changes. 

Search Entries 

Use the search feature in Webliography to find Websites that either you or your 
students have added. If you added categories to your Webliography, try searching 
Website entries by category to narrow your search. 

To search entries: 

1. On the Tools menu, click Webliography. 

2. In the Search Webliography field, type a keyword to search.  

3. Click Search. If you are not satisfied with the results from your search, click View All 
Entries to view all Website entries in Webliography for the course. 
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Threaded Discussion 
The Threaded Discussion content item simulates traditional classroom discussions. A 
Threaded Discussion, or Thread, allows students to post comments to a discussion 
topic, react to other students' comments, and respond to ideas shared by you or by 
others in the course.  

Discussions take place asynchronously, which means you can respond to a Thread 
discussion at any time; other students do not have to be logged into the course in 
order for you to respond and participate. Threaded Discussions begin with a topic 
you identify. Students log into the course when they can and then post to the 
Threaded Discussion at their convenience. Responses to each topic display below the 
topic. 

Students enjoy using Threaded Discussions because they can compose their 
thoughts before they post a comment, respond more thoughtfully to discussion 
topics, and engage in lively debates that are less threatening than in a live classroom 
environment. You might want to post one or several questions for discussion each 
week. Students might have a set amount of time to respond or might be graded on 
the quality of their comments.  

The  icon displays next to Threaded Discussions set as gradable items. Click  to 
open the Threaded Discussion Gradebook Details window and see the number of 
posts made per a student to a Threaded topic. 

While you can delete a Threaded Discussion content item containing topics, do so 
with caution. You can also delete a Thread topic without having to delete individual 
responses within the topic.  

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

Design Tips: 

 One way to assure balanced student involvement and manage discussion in the Threaded 
Discussions is to divide your online class into discussion groups. From there, you can 
require each student to be a facilitator: post a message and respond to each of the group 
members. 

Open a Threaded Discussion 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, locate the Unit with the Threaded Discussion you want open. 

3. Click the Threaded Discussion content item to open it. 

  

See also: 

• Add Threads 

• Delete Threads 

• Grade Threads 

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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• Manage Thread Topics 

• Print Threads 

• Respond to Threads 

• Set Thread Preferences (Toolbox) 

• View Threads 

Delete Threads 

While you can delete a Threaded Discussion content item containing topics, do so 
with caution. Sometimes Threaded Discussions can contain attachments or links to 
useful Web sites that you might want for future reference later in the course. You 
can also delete a Thread topic without having to delete individual responses within 
the topic. 

The ability for students to edit Thread responses is enabled in your Threaded 
Discussion preferences.  

To delete Threads: 

1. Open the Threaded Discussion. 

2. Click Toolbox. 

3. Click Delete. A confirmation message displays. 

4. Select the check box to accept the confirmation message, and then click Delete Content 
& Responses. 

Grade Threads 

When Threaded Discussion is set up as a gradable item, you can grade Threads 
directly from within the Threaded Discussion without opening the Gradebook!  

The  icon displays next to Threaded Discussions set as gradable items.  Click  
see the number of posts made per a student to a Threaded topic. Some instructors 
like to use the Threaded Discussion feature as a way to assess class participation. 
Or, you might give extra credit points to students actively participating in Threaded 
Discussion topics to encourage class participation. You can set Threaded Discussion 
as a gradable item in your course from Gradebook Setup. 

To open the Gradebook Details window and assign a grade to Threads: 

1. Open the Threaded Discussion.  

2. In the Author column, click  beside the author or submitter's name. The Gradebook 

Details window opens. Remember, if you don't see  beside the author's name, it means 
the Threaded Discussion is not set up as a gradable item. 

3. In the fields provided, enter grade information accordingly. 

 
 

Explain the Gradebook Details window 

After you review a student's Thread responses, assign a numeric or letter grade. 
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Field Description 

Numeric 
Grade 

Type a numeric grade for the submission. This field only displays 
if you've identified the Content Item as gradable in your 
Gradebook. 

Letter 
Grade 

Type a letter grade for the submission. This field only displays if 
you've identified the Content Item as gradable in your 
Gradebook. 

Share 
grade with 
student 

Select this check box to allow students to see their grades. 
Remember, students cannot see a grade you've assigned them 
unless you select this option. The Share grade with student 
option appears in all Gradebook Details windows and within the 
Dropbox.  

Visual Editor Type any comments, suggestions, etc. that you might have 
about the student's submission. For example, you might explain 
why you assigned the grade you did, or you might direct the 
student to areas for additional study. 

 

4. Click Save and Close. To continue grading, click Save. 

Manage Thread Topics 

After you add a Threaded Discussion content item, you can add topics for discussion 
within that Thread. There is no limit to the number of topics that can exist in each 
Threaded Discussion. Both you and your students can respond to a Threaded 
Discussion, but only you can create Thread topics. 

Some instructors like to add Introductory Text to a new Thread. The Introductory 
Text displays above your Thread and any Thread topics. This text might contain 
general information or instructions to students. For example, "Select one of the 
following topics and respond by Friday." Introductory text is optional; however, if 
you'd like to add this text, click the Edit link beside the Introductory Text section 
on the main Threaded Discussion page. 

Design Tips: 

 Assign Thread topics to specific groups, by clicking Toolbox on the main Thread page. 

 You can add attachments to a discussion topic such as a document, video, or image that 
students can review and comment on in the Threaded Discussion.  

Add a topic 

1. Open the Threaded Discussion. Remember, you must add a Threaded Discussion content 
item to the Unit before you can add Thread topics. 

4. Click Add Topic. 
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5. In the Title field, type a title for your topic. The topic title is what displays under the Topic 
column on the Threaded Discussion page in the course. 

6. In the Visual Editor, type the discussion topic text. This is the actual topic students see and 
respond to. Use the Visual Editor toolbar to format your new discussion topic and 
Add/Remove attachments. 

7. Click Add Topic. 

Delete a topic 

1. Open the Threaded Discussion. 

2. Locate the topic you want to delete. 

3. In the Delete column, click . A confirmation message displays. 

4. Select the check box to accept the confirmation message, and then click DeleteTopic & 
Responses. 

Edit a topic 

1. Open the Threaded Discussion. 

2.  Locate the topic you want to edit. (If you're editing Introductory Text, click the Edit 
link.) 

3. In the Edit column, click  and make your changes in the fields provided. (If you're 
editing Introductory Text, only the Visual Editor field displays.) 

 Title - Type a title for the topic. 

 Visual Editor - Type text to describe the topic, or type questions to help steer student 
discussion in the direction you want. 

 Add/Remove - Click Add/Remove to either include attachments with the topic or 
to remove previously attached files. 

4. Click Save Changes. 

  

Print Threads 

There are two ways to print Threaded Discussions. You can print exactly what 
displays on your page in which you expand select responses (or all responses), or 
you can print the Printer-Friendly version of the Thread. The Printer-Friendly version 
prints the Threaded Discussion without all the links (i.e. Reply, Edit, and Email) 
under each response. The Printer-Friendly option does include the Read/Unread 
status of each Thread so you can quickly identify responses that have not been 
opened.  

Print the Threaded Discussion display 

1. Open the Threaded Discussion. 

2. Locate the Threaded Discussion you want to print. 

3. Click Expand All to open or expand all the Thread responses, or click  next to the 
responses you want to see and therefore print. Only expanded responses print. 

4. Click Print in your browser. Whatever is displayed on your page prints.  

Print a Printer-Friendly version 
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1. Open the Threaded Discussion. 

2. Locate the Threaded Discussion you want to print. 

3. Click Show Options. 

4. From the options that display, click Print View. A Printer-Friendly version of the Thread 
opens in a new browser window. 

5. In the new browser window, right-click and select Print. 

Respond to Threads 

Once you post a topic to a Threaded Discussion, both you and your students can 
respond to the topic and to each other. One line of discussion constitutes a Thread. 
You and your students can also email the author of a Thread. Instructor responses 
display in bold to easily distinguish them from student names and responses. 

Respond to a Thread 

1. Open the Threaded Discussion. 

2. If you have multiple topics in the Threaded Discussion, in the Topics section, click on the 
topic for which you want to view responses. Otherwise, post a response to the current 
topic. 

3. To respond directly to a topic, click Respond below the topic. 

4. To respond to a comment from a student or from someone else, click  beside the 
comment to expand it. Once expanded, click Respond. 

You can view Threaded Discussion responses and sub-Threads one at a time, or you 
can expand them all at once.  

5. Type your response in the Visual Editor. Use the toolbar to check for misspelled words in 
your response. You can also Add/Remove attachments. 

6. Click Preview to preview your response before posting; otherwise, click Post Response.  

Edit a Thread response 

The ability for students to edit Thread responses is enabled in your Threaded 
Discussion preferences.  

1. Open the Threaded Discussion. 

2. If you have multiple topics in the Threaded Discussion, In the Topics section, click on the 
topic for which you want to view responses. Otherwise, edit a response to the current topic. 

3. Locate the response you want to edit, and click  beside the response to expand it. 

4. Once the response is expanded, click Edit. 

5. Make your changes in the Visual Editor. Use the toolbar to check for misspelled words in 
your response. You can also Add/Remove attachments. 

6. Click Preview to preview your changes before posting; otherwise, click Post Response. 

Email the author of a Thread 

1. Open the Threaded Discussion. 

2. In the Author column, click  beside the author or submitter's name. 

3. Type your email message in the Visual Editor. Use the toolbar to check for misspelled 
words in your response. You can also Add/Remove attachments. 
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4. When you're done composing your email, click Send Message. The message is sent only 
to the author of the Thread.  

Threaded Discussion Preferences (Course Admin) 

You can set course-level Threaded Discussion preferences from the Course Admin 
page, but you can also override these options at the individual content item level 
from the Toolbox page. The Toolbox page lists specific Threaded Discussion 
preferences, such as moving Threads, deleting Threads, assigning Threads to a 
group, etc. 

Set course-level Threaded Discussion preferences 

1. In the navigation tree, click the Author tab. 

2. On the Tools menu, click Course Admin. 

3. Click Threaded Discussion Preferences. 

4. Select the check box for any of the following: 

 Set topics to "read only" after the scheduled end dates for all Threaded 
Discussions in this course - Locks all Thread postings once the content item's End Date is 
passed. Students can view the Thread, but they will not see Respond or Edit buttons. 

 Allow students to edit their posted responses for all Threaded Discussions in this 
course - Allows students to edit their own Thread responses after they've posted them to a 
Threaded Discussion. If a Thread response is edited, a Last Modified date displays under the 
response, as well as the original post date. 

5. Click Save Changes 

Open Toolbox for Threaded Discussion 

See Toolbox. 

View Threads 

You can view Threaded Discussion responses and sub-Threads one at a time, or you 
can expand them all at once. If the Threaded Discussion is popular, you might have 
numerous responses to sort through. When viewing responses in a Threaded 
Discussion, you can use the Expand option to view all responses at once, you can 
sort responses by author, date and time, etc. and you can mark responses as read or 
unread to track which responses you have opened and not opened. 

View Threads individually or all at once 

1. Open the Threaded Discussion. 

2. Do any of the following: 

 Expand a single Thread - Click either the title of the response you want to view, or 
click . A response with multiple responses is marked with . If you click , all sub-
Threads and responses expand. 

 Expand all Threads - Click the Expand All link and all responses to the current topic 
expand. After you click Expand All, the link changes to Collapse All. Click Collapse 
All to return to the non-expanded view. 

Sort Threads 
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Once a Threaded Discussion is in progress, you can sort comments by author, date, 
or by response. By default, Threaded Discussions are sorted by response. Instructor 
responses display in bold. 

1. Open the Threaded Discussion. 

2. Click on the following column headings to sort by:  

 Read/Unread - All responses you have either read or not opened. 

 Response - Sorts responses hierarchically, with responses indented beneath the 
topic or response they're responding to. 

 Author - Sorts responses by the authors' last names.  

 Date/Time - Sorts responses by the time and date they were posted. 

Mark Threads as read/unread 

Some topics in a Threaded Discussion have more activity than others. It is easy to 
track which responses you have read or not read by looking at the envelope icon 
beside the response. For responses you have read,  displays, and for unread 
responses,  displays.  

For responses you would like to read again later, mark them as unread to remind 
yourself to read them, or print the Threaded Discussion for future reference. 
Instructor responses display in bold. 

1. Open the Threaded Discussion. 

2. At this point, you can either: 

 Click the envelope icon beside the response you want to mark as either read or unread. 
For responses you have read,  displays, and for unread responses,  displays. 

 Click Show Options and select the check box beside the Threads you want marked as 
either read or unread. In the Mark selected as drop-down list, select either Read or 
Unread. 
 

Explain other drop-down list options 

 
Option Description 

Select: In this drop-down list, select any of the following: 

 All - Selects the check box to all Threads. 

 None - Clears the check box to all Threads (if any check boxes are 
currently selected). 

 Unread - Selects the check box to those Threads that have not 
been read. 

 Read - Selects the check box to those Threads that have been read. 

 Inverse - Changes selected check boxes to the opposite of what is 
currently selected. This means if All is selected, selecting Inverse 
changes the selection to None. Or, if Read is selected, selecting 
Inverse changes the selection to Unread. 
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Mark selected 
as:  

In this drop down-down list, you can change the state of a Thread as 
read or unread. This means, for the Threads you have already read 
and are identified by the system as read, you can change as Unread 
and vice versa. Changing the state of a Thread is useful when you 
have a long Threaded Discussion and want to flag those responses you 
might return to for future reference. For example, when responses 
contain attachments or links. 

View 
Selected/View 
All 

Click this link to toggle between viewing Threads based on the 
options you selected or viewing all Threads regardless of 
whether they have been read or unread. 

Sometimes when you have a lengthy Threaded Discussion you 
might want to only reply to a select few of the many responses. 
In this case, you can select the check box to those topics to 
which you have a response, click View Selected, and then 
post a reply to the selected responses. 
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Exams and Quizzes 
Use the Exam content item to evaluate student performance. When you create an 
exam item, you can add pages, add and edit questions and pools of questions, use 
existing exam test banks, and add and edit exam and quiz information. To add an 
exam to your course, you must first add the exam content item to a Unit, and then 
insert content into the exam. You can also set exam preference settings like 
passwords, extending test time, access dates and times, grading options, etc. 

If your course must meet Section 508 requirements, refer to http://www.access-
board.gov/sec508/guide/1194.22.htm to ensure your course content 
(announcements, introductions, uploaded files, links, URLs) is compliant. You can 
check your HTML code by clicking the HTML button in the Visual Editor. 

See also: 

• How to Create an Exam 

• Add Exams 

• Add Questions  

• Delete Exams 

• Design Tips: Gradebook and Exams 

• Edit Exams 

• ExamGuard 

• Exam Preferences (Toolbox) 

• Exam Statistics 

• Preview Exams 

• Question Pools 

• Reset or Grant Additional Time 

• Test Banks 

How to Create an Exam 

Before you can create an exam, you need to add an exam content item to a Unit. 
You can also set exam preferences like exam passwords, access dates and times, 
grading options, etc. 

Use the following steps as a guide to creating an exam for your course. 

To create an exam: 

1. Set your exam preferences 

2. Add an exam content item 

3. Add questions to the exam 

  

http://www.access-board.gov/sec508/guide/1194.22.htm
http://www.access-board.gov/sec508/guide/1194.22.htm
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Add Exams 

You can add exams to your course the same way you would add any other content 
item. Once you have added an exam content item, you are ready to add questions 
and other content to the exam. If you know a particular Unit or section of the course 
will include an exam but you do not have content prepared, you can add the exam 
content item and hide it from course view by selecting the "Hide item from students" 
option when you add the exam. 

To add an exam: 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Unit to which you want to add an exam. 

3. Click Unit Content Items. 

4. Click Add Items.  

5. In the fields provided, enter information accordingly. 
 

 Describe the fields 

 

In this field Do this 

Name: Either: 

 Type a name for the new content item. When you enter a new item 
name, it displays in the Select existing item name drop-down list. 
 
Naming content items lets you customize your course. For example, 
you might create an exam content item in your course and name the 
content item "Practice Exam."  
 

 Select an existing content item from the drop-down list. This list 
displays names to previously created content items. 

Item type: Select Exam. 

Add to: Select either Course Home or the Unit to which you want to add 
the content item. 

Assign to: Select the audience for the content item. 

Hide item 
from 
students 

Select this check box if you do not want the content item to 
show in course view to students.  

Some instructors like to work ahead and add content items to 
the course, hide them, and then insert content at a later time. 

Create 
dropbox 
basket 

Select this check box to create a Dropbox basket for the content 
item. When you create a Dropbox basket for a content item, 
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students can submit assignments related to the content item 
directly to the Dropbox basket for the item.  

 

6. Click Add Items.   

 
 

  

  

Add Questions  

After you create an exam item, whether it's a quiz, a midterm, or a final exam, you 
can add questions to the exam. Types of questions you can add include: Multiple 
Choice, Multiple Answer, True-False, Essay, Short Essay, Fill in the Blank, and 
Matching. Additionally, you can use the Question Pools feature to randomly extract 
questions from a pool of questions for use in the exam, or you can store exam 
questions in the  Test Bank and reuse them in future courses. Regardless of the 
types of questions and features you use, you can edit exams in your course at any 
time. 

To add questions to an exam: 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click on the Exam content item.  

3. In the Title & Introductory Text section, click Edit to add a title and introduction to 
your exam. 

4.  In the Page section, select the page number to which you want to add questions. If you 
are starting a new exam, only Page 1 displays. To add a new page, click Add New Page. 

5. In the Add drop-down list, select the type of question you want to add.  

6. In the as row box, type a number to specify the order in which the question should display 
on the page. For example, type 2 and the question is added as the second question on the 
exam page. 

7. Click Add. Depending on the selected question type, the Visual Editor opens with specific 
fields in which you can enter information to build your actual question. 
 

Explain what to enter for each question type 

 Multiple Choice 
Type a question and the number of points the question is worth (optional). Then, in the text 
boxes provided, type the possible answers and select the button next to the correct answer. 
 
Multiple Choice Example 
The system grades mixed multiple choice by checking whether each response option is 
correct or incorrect. For example, let's say you set up the following question with 5 response 
options of which 2 are correct: 
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 What two colors when mixed make the color Green? 
1. Red  
2. Blue 
3. Black 
4. Yellow 
5. White 
 
In setting up the question, let's say you selected options 2 and 4 as the correct answers. 
The system checks every response option as either correct or incorrect.  
 
Basically, if a student selects 1 and 4, the system uses the following validation: 
1. Red - Incorrect (because it is not the correct response but the student selected it) 
2. Blue - Incorrect (because it is one of the correct responses and was not selected) 
3. Black - Correct (because the user did not select this response and it's not the correct 
answer) 
4. Yellow - Correct (because it's one of the correct responses and the user selected it) 
5. White - Correct (because the user did not select this response and it's not the correct 
answer) 
 

 Multiple Answer 
Functions the same as Multiple Choice, but you must select two or more correct answers. 

 True-False 
Functions the same as Multiple Choice, but the answer options are True and False. 

 Essay 
Cannot be auto-graded. Type a question and, if you want, type the number of points 
possible, as well as an explanation for the answer. Students will see this explanation when 
you make it available in the Gradebook. 

 Short Answer 
Cannot be auto-graded. Functions the same as Essay, only less space for the student to 
reply. 

 Fill in the Blank 
Enter a question and up to five Acceptable Responses in the text boxes provided. The auto-
grading feature is case-sensitive and because of this, it is very specific. This means, all 
spaces and letters (capital and lower case) are taken into consideration, so make sure you 
enter all possible correct answers.  

 Matching 
Type a question, and then enter matched pairs in the boxes provided. 

8. Click Add. 

  

Delete Exams 

Like all content items, when you delete an exam the contents within the exam, such 
as questions, are also deleted. It's best practice to delete an exam before it is 
available to students.  

To delete exams: 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click on the exam you want to delete. 

3. Click Toolbox. 

4. Click Delete. A confirmation message displays. 
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5. Click Delete.  

Design Tips: Gradebook and Exams 

Following is a list of helpful tips and reminders to help you use the Gradebook more 
efficiently. Many preferences you set when creating an exam affect how the exam 
displays in the Gradebook. 

Tips for Gradebook 

 Use Gradebook as another communication tool to comment on graded assignments and 
provide feedback to students on their progress in the course.  

 User Activity - Haven't heard from a student yet? Use the User Activity feature to see if 
the student came to class. If they haven't been spending time online, send an email to 
review directions and answer questions and concerns. User Activity is not designed to be 
used as a participation grade. Many students print course material to read offline, or leave a 
page open for a while without actually participating in the course. When this occurs, the 
activity in class will be skewed.  

 Extra Credit and Exclude from Course Grade features can be used with or without 
Weighting turned on; however, you must have Points/Calculations turned on.  

 The Dropbox and the Gradebook are connected meaning, if you enter a grade through the 
Dropbox interface, the grade also shows in the Gradebook and vice versa. Remember, you 
must return the assignment to the student before the student can see the assignment in 
his/her Inbox. 

 The Gradebook calculates and displays up-to-date points and calculations by default. With 
this option enabled, students can see their Grade to Date, Current Course Average, and 
Points Possible. You can turn this feature off in Gradebook Preferences. Remember that 
in doing so, however, students will not have access to calculated figures (like Current Grade 
to Date, for example). Remember, also, that you must have assigned points to gradable 
items in order to display Gradebook calculations. 

 You can assign a Final Letter Grade from any view in the Gradebook in which you see the 
Points column. Click the student's current course points, and then click Save & Next to go 
to the next student. 

 Grade data is not removed if you disable Gradebook from the Enable/Disable tools list in 
Course Admin. When you disable a tool, the system is hiding it from course and author 
view. 

 Weighted grades 

 The Weighting feature in the Gradebook, set in Gradebook Preferences, enables you to 
weight or grade course items relative to other course content. For example, you have an 
exam worth 50 points, but you want it to count for 25% of a student's grade. Instead of 
adjusting all your course points to make this percentage, you can weight the exam item. 
The Weighting feature is optional. 

 If you want to provide graded feedback on an assignment but not include the grade in 
the final course grade, exclude the item from the course grade. This feature is excellent 
for practice assignments which you want to grade but not count. To exclude items from 
the course grade, click the Gradebook tab, click Setup Gradebook, click Assign 
Points/Weights, then click Exclude from Course Grade. Select the check box to 
those items you do not want to include in the final course grade. Excluded items are 
marked by  throughout your Gradebook. 

 The Distribute Weight % feature, set in Assign Points/Weights, enables you to apply a 
single weighted percentage evenly across multiple content items. For example, if you 
want Threaded Discussions in your course to be worth a total of 20% of the final course 
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grade and you create three Threads, the Distribute Weight % feature assigns a weighted 
percentage of 6.66%, 6.66%, and 6.68% to each Thread.   

 If you have the Weighting feature turned on but do not assign a weight percentage to a 
gradable item, that item will not count towards the final course grade. Essentially, the 
item carries a weight of 0%. 

 If you're using Weighting in your Gradebook, your students will see a Course Weighted 
Average rather than a Grade To Date. The Course Weighted Average indicates that 
course content items have different weights assigned to them. Students see their current 
weighted grade as well as remaining course work and its relative weight. For example, a 
student who did poorly on one assignment might see that the assignment was only worth 
10% of the final course grade. 

 View grades 

 The Quick Grade View is perhaps the most common and efficient way to assign grades in 
the Gradebook. This view lets you assign grades to all students for a single content item 
(like a Webliography entry, for example). You simply locate the content item (or course 
tool) in the Gradebook and then assign a grade for each student. 

 The Export Current View feature located on each Gradebook screen exports only the 
current displayed view of the Gradebook. If you want to export your entire Gradebook, go 
to the Show All view and then click Export Current View. Students cannot see a grade 
you've assigned them unless the share grade with student option is selected. This 
option appears in all Gradebook Details windows and within the Dropbox. 

 To accurately show students their Current Grade to Date, enter zeros in any incomplete 
items to that point in the course. Gradebook only calculates graded items, so if a student 
did not turn in an assignment, the total possible points for that assignment is not figured 
into the total points possible for the course, skewing the student's grade to date. 

Tips for Exams 

 The options selected when setting up an exam affect the Gradebook display for both you 
and your students. For example, if you want students to view exam scores in Gradebook 
without you having to manually enter points or scores, select the Automatically display 
the objective score for completed exams to students in the Gradebook option when 
setting up the exam.  

 To automatically have students view scores for an exam, remember to set a Gradebook 
Review Date when you create the exam. If a review date is not set, students cannot view 
the comments or scores entered in Gradebook. 

 Print students' completed exams for offline grading. Locate the exam in the Gradebook, 
click the asterisk * to open the Gradebook Details window for that exam, and then click 
Print View. In the File menu, click Print. 

 Save a printer-friendly version of completed exams to your computer or network for offline 
grading. Locate the exam in the Gradebook, click the asterisk * to open the Gradebook 
Details window for that exam, and then click Print View. In the File menu, click Save 
As.  

 Reset a student's exam through the Gradebook Details window. Resetting an exam clears 
all saved information from the individual exam database and allows the user to begin the 
exam again, as if the student had never taken it. 

 Grant a student additional time on an exam through the Gradebook Details window. 
For example, if a student was in the process of taking an exam and the student's Internet 
connection was lost, the system would "think" that this student had already taken the exam 
and would, therefore, not let the student retake the exam. This option allows the student to 
access the exam again for the amount of time you specify. Information previously saved is 
still there, and the student starts the exam wherever he or she left off. 
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Edit Exams 

Once you create an exam item and insert questions, you can return to the exam to 
make additional changes at any time. Use the Preview Exam feature to ensure your 
changes are correct before making the exam available to students. 

Design Tips: 

• Add additional pages within your online exam to group similar questions together. Pages 
give students a sense of where they are in an exam 

Add pages 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Exam content item. 

3. Click Add New Page.  

4.  In the fields provided, enter the following: 

 Page Title: - Type a title for the new page. 

 Page Instructions: - Type any instructions that might be specific to that exam page. 
Format your page instructions using the Visual Editor toolbar. 

5. Click Add Page. 

Reorder questions 

1. In the navigation tree, click the Author tab.  

2. In the navigation tree, click the Exam content item.  

3. Find the question you want to move to another row on the page. 

4. In the row box, type a new row number for the question. The row option is not visible 
unless you have more than one question on the page. 

5. Beside the row box, click  to reorder the question. 

Move questions to a different page 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Exam content item.  

3. Find the question you want to move to another location within the exam. 

4. In the page box, type a new page number for the question. The page box is not visible 
unless you have more than one page in the exam. 

5. Beside the page box, click  to move the question to a different page. 
 
To move a question into a question pool, make sure the question's row falls within the 
question pool. For example, if your question pool occupies rows 8 and 9, type 9 in the 
question's row field.   

ExamGuard 

ExamGuard is an optional online assessment tool that your institution might have 
purchased. ExamGuard uses a customized browser that provides an extra secure 
environment for online test-taking. When students take an exam using ExamGuard, 
they cannot:  
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 Print, copy, and paste 

  Go to another URL or Website  

 Minimize the browser window  

 Use menu options, control keys, or task switching  

 Use right-click options  

 Start new applications  

 Return to a previous page  

Students must download the ExamGuard software before they can access the exam. 
We highly recommend that you have students download ExamGuard before the day 
of the exam. Students can download ExamGuard from the Start page of the Exam. 

Design Tips: 

 Because the ExamGuard browser locks the user's browser window, avoid using links to 
other Web pages or outside sources in your exam. Students will be unable to access these 
pages. 

 If you've set a time limit on the exam, a student's time doesn't start until the student starts 
the exam. ExamGuard download time does not apply to the exam time.  

Install ExamGuard 

 Tell students in advance to download and install ExamGuard. We suggest creating a course 
announcement on the Course Home page as a download reminder.  

 The link to download ExamGuard and all other necessary instructions are located on the 
Start page for the exam. There are several steps in the installation process so students 
should plan accordingly.  

 After students install the ExamGuard software, they must close their current browser 
window, open a new browser, and re-login to their course for the ExamGuard software to be 
recognized by the system.  

 If a student downloaded the software but is having trouble launching the browser, s/he may 
need to clear the temporary internet files area of her/his browser. To do this, students click 
the Tools button in the browser, then select Internet Options. On the General tab, click 
Delete Files under Internet Options.  

Download ExamGuard 

ExamGuard is either powered by QuestionMark or Respondus. Please confirm with 
your administrator about which application your system is configured to use before 
downloading.  

To download ExamGuard software powered by:  

•  QuestionMark, click here. 

• Respondus, go to the Start page of the Exam. 

Preview Exam Guard 

Preview your ExamGuard exam before making it available to students. 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click on the Exam content item. 

http://www.questionmark.com/secure/_ecollege.aspx
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3. Click Preview Exam, then select to preview using ExamGuard. 

Using audio or video 

 The ExamGuard browser essentially locks the user's browser window. As a result, students 
will not have access to any programs or applications they have running when they launch 
the exam. Because of this, you should be very careful using audio links in your exam. 
Should something go wrong with the link for whatever reason, students will be unable to 
access their audio player. 

 If you really want to use audio or video in your exam, you must embed the media player in 
the exam question. This is the only way students will have access to the media player's 
controls: the start, stop, pause, and volume buttons. If you don't embed the player, the 
player opens behind the ExamGuard browser and students will be unable to see or access 
the controls.  

Browser compatibility 

 ExamGuard powered by QuestionMark is not compatible with Macintosh computers. You can 
create an exam that uses ExamGuard on a Mac, but students must take ExamGuard exams 
on a PC. 

 ExamGuard works best with Internet Explorer.  

 America Online (AOL), Prodigy, and CompuServe are Internet Service Providers (ISP) who 
provide as part of their software an internal Web browser that allows users to browse the 
Web. These Web browsers are either customized or older versions of Internet Explorer (IE) 
and are not currently supported by ExamGuard. 

Turn on ExamGuard 

If your institution has purchased ExamGuard, you can turn on the ExamGuard 
feature. 

1.  In the navigation tree, click the Author tab. 

2. In the navigation tree, click on the Exam content item.  

3. Click Toolbox. 

4. Select the Use ExamGuard check box. 

Toolbox 

Each content item you add to your course has a Toolbox associated with it. The 
Toolbox is where you can set preferences and properties for the current content 
item. Although most options in the Toolbox are common to all content items, there 
are several options that are unique to a particular content item. For example, 
Toolbox options for Exams are specific to Exams only, and Toolbox options for 
Threaded Discussion are specific to Threaded Discussion, etc.  

If your course uses Sharable Content Objects (SCOs), you can access the Toolbox 
associated with the SCO, but you will be unable to edit or otherwise modify the 
shared content object. As a result, in Author mode for a SCO content object, only the 
Toolbox button is available. 

Open Toolbox 

1. In the navigation tree, click the Author tab.  

2. In the navigation tree, click on the Unit or content item. 
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3. Click Toolbox.  
 
The toolbox properties change accordingly for the selected content item. The Assign To 
Groups option in Toolbox only shows if you've created groups in your course. Similarly, 
the Create a Dropbox Basket option is not available in the Toolbox for Exams or for 
Threaded Discussions. 

Toolbox for Units 

For this 
option 

Do this 

 Edit 
Schedule 

See Edit Schedule._Ref-907952437 

Edit a 
Unit title 

1. Open Toolbox. 

2. Click Edit Unit Title. 

3. Type a new title. The Unit title displays in the course when the 
student clicks that particular Unit and also in the Coursework section 
of the Course Home page. 
 
To display the title in the navigation tree, select the Use title in 
navigation menu check box; otherwise, the navigation tree displays 
according to the default General Course Info settings in your 
Course Preferences.  
 

4. Click Save Changes. 

 Change 
Item Order 

Once you've added content items within a Unit, you might decide 
that you want them in a different order. You can rearrange 
content items within a Unit at any time. 

1. Open Toolbox. 

2. Click Reorder Items. 

3. Change the numbers in the Order column to reflect the new order. 

4. Click Save Changes. 

Change 
Unit Order 

Once you've added Units to your course, you might decide that 
you want them in a different order. You can rearrange Units 
within a course at any time. 

1. Open Toolbox. 

2. Click Reorder Units. 

3. Change the numbers in the Order column to reflect the new order. 

4. Click Save Changes. 

Delete 
Unit 

When you delete a Unit, you also delete all content items within 
that Unit. 

1. Open Toolbox. 
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2. Click Delete Unit. 

Toolbox for content items (in general) 

For this 
option 

Do this 

 Edit 
Schedule 

See Edit Schedule. 

Create 
Dropbox 
Basket 

1. Open Toolbox. 

2. Click Create Dropbox Basket.  
 
Text to Delete Dropbox Basket and Go to Dropbox Basket 
displays. Once you create a dropbox basket from within the Toolbox, 
you can return to the Toolbox to delete it. 
 

3. Click Save Changes. 

 Move  Once you've added content items, you might decide that you 
want them in a different order, or you might want to move an 
item to another Unit. You can rearrange the order of content 
items within a Unit or move them to another Unit at any time. 

1. Open Toolbox. 

2. Click Move. 

3. At this point, you can: 

 In the Move drop-down list, select the Unit to which you want to 
move the content item. 

 Change the numbers in the Order column to reflect the new order. 

4. Click Save Changes. 

 Delete 1. Open Toolbox. 

2. Click Delete. A confirmation message displays. 

3. Click OK. 

The content item and the content it contains is deleted from your 
course.  

Assign to Select an audience for the item. This might be the entire class, 
groups, etc. 

Hide from 
students 

Hide the content item from course view so that students cannot see it. 
When you set up your course structure, you can hide and show content 
items as the course progresses. 

Toolbox for Exams 

For this 
option 

Do this 

 Edit See Edit Schedule.  
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Schedule 

Move Once you've added content items, you might decide that you want 
them in a different order, or you might want to move an item to 
another Unit. You can rearrange the order of content items within 
a Unit or move them to another Unit at any time. 

1. Open Toolbox. 

2. Click Move. 

3. At this point, you can: 

 In the Move drop-down list, select the Unit to which you want to move 
the content item. 

 Change the numbers in the Order column to reflect the new order. 

4. Click Save Changes. 

 Delete 
1. Open Toolbox. 

2. Click Delete. A confirmation message displays. 

3. Click OK. 

The content item and the content it contains is deleted from your 
course. 

Assign to Select an audience for the item. You might assign the exam to a 
specific group of students, or to all students. This option is 
available only if you have created groups in your course.   

Hide Hide the exam from course view so that students cannot see it. 
When you set up your course structure, you can hide and show 
content items as the course progresses. 

Exam type Select either: 

 Students may only take the exam once, to restrict students from 
accessing the exam more than once. 

 Students may re-take the exam, to allow students to access the 
exam multiple times. This option is useful for practice quizzes.  

Time 
allowed 

Set a time limit for the Exam. Time limits determine how long 
students have to complete the exam. To exit students from the 
exam after the time limit expires, select the Kick students out of 
exam when time expires check box. If this check box is not 
selected, the set time limit is not in effect and the student will not 
be kicked out of the exam. 

The time limit option only applies if you selected Students may 
only take the exam once.  

Grading 
options 

Click Use Auto-Grading to score questions if you want the 
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system to automatically grade all objective questions in the exam. 
If you select this option, you can also choose to automatically 
display the auto-graded score to students in the Gradebook, or to 
display an auto-graded summary to students at the time they 
submit their exam. This summary immediately tells students how 
many questions they got right (by question type). 

Select how the results of the graded exam display to students in 
the Gradebook.  

Security 
password 

Set a password for the exam. Students cannot access the exam without 
the correct password. You are responsible for notifying students of the 
password. 

Toolbox for Threaded Discussion 

For this option Do this 

 Edit Schedule  See Edit Schedule.  

Move Move the Threaded Discussion to another section or Unit 
in the course. You can also select this option to reorder 
the Thread within the Unit. 

1. Open Toolbox. 

2. Click Move. 

3. Type a new title. The Unit title displays in the course when 
the student clicks that particular Unit and also in the 
Coursework section of the Course Home page. 
 
To display the title in the navigation tree, select the Use 
title in navigation menu check box; otherwise, the 
navigation tree displays according to the default General 
Course Info settings in your Course Preferences.  
 

4. Click Save Changes. 

 Delete Delete the Threaded Discussion content item and all 
topics or Threads within it. 

1. Open Toolbox. 

2. Click  Delete. A confirmation message displays. 

3. Select the check box to accept the confirmation message, 
and then click Delete Content & Responses. 

Assign to Assign a target audience for the Threaded Discussion. This 
might be the entire class, groups, etc. 

Set all topics to 
"read only" after the 
scheduled end date 

Select this option to lock all Thread postings once the content 
item's End Date is passed. Students can view the Thread, but 
they will not see Respond or Edit buttons.  
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Allow students to 
edit their responses 
after posting 

 Select this option to allow students to edit their own Thread 
responses after they've posted them to a Threaded Discussion. 
If a Thread response is edited, a Last Modified date displays 
under the response, as well as the original post date. 

Hide item from 
students 

Hide the Threaded Discussion from course view so that students 
cannot see it. When you set up your course structure, you can 
hide and show content items as the course progresses. 

Toolbox for Learning Outcomes Manager  

Learning Outcomes Manager (LOM) is enabled from the Administrative pages. If LOM 
is not available to turn on or off from Enable/Disable tools, the LOM feature is not 
activated for your course.  

For this option Do this 

 Edit Title Change or rename the Learning Outcomes Manager content item 
title to how you want it to display under Course Home. For 
example, you might rename the title to "Performance 
Indicators," "Course Competencies," "Learning Objectives, " etc.  

Do not display 
Learning Outcomes to 
students in the 
Course View  

Either: 

 Select the check box to not show (default) Learning Outcomes 
Manager to students in Course view. 

 De-select the check box to display Learning Outcomes 
Manager to students in Course view as Read-only. The 
LOM page shows students their performance against set 
outcomes for the course. 

  

 
 

  

Exam Statistics  

Your online course includes a powerful diagnostic tool called Exam Statistics. Exam 
Statistics provides both exam-level and question-level statistical analysis for exams. 
You can download and save a copy of the statistics for archiving purposes.  

Notes about Exam Statistics: 

  Click Definitions & Best Practices on the Exam Statistics page for definitions, examples, 
and explanations of how each statistic was calculated.  

 You can run Exam Statistics before all exams have been submitted; however, only 
submitted exams are included in the analysis. Exams with a status of In Progress are not 
included in the results.  

 Because of the nature of short answer and essay questions, an item analysis is not available 
for these question types. However, you can click View Student Responses to view all 
student responses for the question. This allows you to read and evaluate each response 
against all other responses. You have the option to show or hide the student name 
associated with each response.  
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 Exams allowing multiple entry use the data from the most current exam submission in the 
Exam Statistics report.  

 If you edit an exam question after one or more students have responded to the question, all 
exam statistics will be lost for the edited or deleted questions.  

View Exam Statistics 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Exam content item. 

3. Click  Exam Statistics.    

Download and save your exam statistics analysis report to archive it. The report is 
not stored in the system once the report page is closed; however, you can always 
run the report again. 

Exam-level analysis 

When you run Exam Statistics, you see exam-level analysis by default. Calculations 
at this level are useful because they show you how the class as a whole performed 
on the exam and thus evaluate how challenging the exam was overall. When used 
over several courses, you might see trends in student performance which suggest 
refocusing your exam strategy. 

 Exam-level calculations include:    

 The number of respondents and number of questions on the exam  

 High and low scores, as well as the range  

 The mean, median, and mode  

 The average difficulty of questions on the exam (Mean P-Value)  

 Standard Deviation  

 Frequency Distribution 

Question-level analysis 

By default, analysis at the question-level displays in the order each question appears 
in the exam. However, you can sort exam questions by their level difficulty by 
clicking Sort By: Difficulty. 

To drill down to question-level analysis, click the Question-Level Statistics tab. 
Calculations at this level are useful because you can see how the class, as a whole, 
responded to each question in the exam. This level of analysis allows you to 
scrutinize the quality of each question, based on the accuracy of student responses. 
It also provides a way for you to identify questions that might not have been 
properly covered in the course presentation or that need to be rewritten or thrown 
out.    

Question-level analysis can help you identify areas where students might be weak 
and might suggest improving course materials in those areas. Question-level 
calculations include:  

 The number of respondents and the frequency of each response  

 The P-value, or difficulty level, of each question  

 The discrimination value for each question (the degree to which each question is separating 
the better students on the exam from the weaker students)  
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Download archived Exam Statistics 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Exam content item. 

3. Click Exam Statistics. 

4. Click Download.  

5. Click Save. Save the report as an .HTML document on your network or hard drive. 

Preview Exams 

As you build your exam, you can see what it will look like to students, as well as take 
the exam to see what students will experience at exam time. You can also preview 
what a graded exam looks like. 

If your institution uses ExamGuard and you have enabled it for this exam, you can 
preview the exam in the secure browser-- just as students will see the exam. We 
highly recommend you preview the exam using ExamGuard so you can ensure that 
test questions and features work correctly. Remember, you'll need to download and 
install the ExamGuard software, just like a student. 

Preview exams 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the exam content item.  

3. Click Preview Exam. The exam displays just as students will see it. If you like, you can 
take the exam as well. 

Preview graded exams 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the exam content item. 

3. Click Preview Graded Exam. The graded exam displays just as students will see it. 
 

Question Pools 

As you create your online exam, you might decide to use question pools. A question 
pool is a set number of questions randomly drawn from a larger base of questions. 
For example, you might add 20 questions to your pool, and then have the system 
randomly select 5 questions from the pool for each student. Question pools are an 
effective way to ensure that students see different questions on an exam. 

If you're using a question pool and there is a question that you want all students to 
see, select the Mandatory check box when you create the question. This check box 
only displays when you create questions within a question pool. 

Create a question pool 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Exam content item. 

3. In the Add drop-down list, select Question Pool. If you know where you'd like the new 
Question Pool to display on the exam page in relation to existing questions, type a row 
number in the as row box; otherwise, the new Question Pool displays on the page. 
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4. Beside the as row box, click Add.  

5. In the Number of Questions field, type the total number of questions from the pool that 
you want to include in the exam. For example, if you have 20 total questions in the pool, 
and you want each student to answer 10 questions, type 10. Each student sees 10 random 
questions drawn from your pool of 20 questions. 

6. (Optional) Type a title for your question pool. A pool title might help you organize your 
pooled questions.  

7. Click Add. Your new question pool displays on the main Exam page. 

Add new questions to a question pool 

Once you create a question pool, you can add new or existing questions to it.  

1. Create a question pool.  

2. In the Add drop-down list, select a question type: True/False, Multiple-Question, etc. 

3. In the as row box, type a row number that falls within your current question pool. For 
example, if your question pool currently occupies rows 5 and 6, type 6 in the as row box. 
This ensures that your new question is included in the question pool. To enter a new 
question outside of your question pool, type a row in the as row box that falls outside your 
question pool. For example, if your question pool currently occupies rows 5 and 6, type 7 in 
the as row box. 

4. Beside the as row box, click Add. The page for the selected question type opens.  

5. Enter information for the selected question type, and click Add.  A confirmation message 
displays.  

6. Click OK. Your changes display on the main Exam page. 

Add existing questions to a question pool 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Exam content item. 

3. Go to the page in the exam on which the question pool you want to edit is located. 

4. Click Edit Pool. The Edit Question Pool page opens. 

5. Change the question so that its row number falls within the rows occupied by the question 
pool, and then click Update. Your changes display on the main Exam page. 

Move an entire question pool 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Exam content item. 

3. Go to the page in the exam on which the question pool you want to move is located. 

4. Do one of the following: 

 Move the entire question pool to a new location on the current page 
Type a new row number in the Entire Pool To Row box for the question pool and click  
beside the box. This moves the entire question pool and all the questions within it to a 
new location on the current page. The pool does not absorb any new questions.  
 
The new row number you enter must exist on the current page. Question pools cannot 
span multiple exam pages. 
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 Move the entire question pool to a new page 
In the Entire Pool To Page drop-down list, select a new page number for the question 
pool and click  beside the box. This moves the entire question pool and all the 
questions within it to the bottom of the page you designated. The pool does not absorb 
any new questions. 
 

Move the start or end row for a question pool 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click the Exam content item.  

3. Go to the page in the exam on which the question pool you want to edit is located. 

4. In either the Start of Pool To Row box or the End of Pool To Row box, type a new row 
number. 

5. Click  beside the new row number. Depending on your changes, the question pool starts 
or ends on the row you specified, absorbing all existing questions that fall between the new 
start/end row and the old start/end row.  
 
When you enter a new row number, the row must exist on the current page. Question 
pools cannot span multiple pages. Also, you cannot enter a new start or end row that lies 
within another question pool. 

Reset or Grant Additional Time 

Occasionally, you might need to either reset an exam for a student or grant a 
student additional exam time. For example, if a student loses his or her internet 
connection while taking an exam, the system thinks that this student has already 
taken the exam and would, therefore, not let the student retake the exam. 
Depending on the individual situation, you can do one of the following: 

 Reset the exam - Clears all saved information from the individual exam database and 
allows the user to begin the exam again, as if he or she had never taken it.  

 Grant additional time - Allows the student to access the exam again for the amount of 
time you specify. Previously saved information in the exam is still there and the student can 
start the exam wherever he or she left off.  

Reset an exam 

1. On the Tools menu, click Gradebook. 

2. Select a Gradebook View from the drop-down menu and click Go. All items within the 
selected Gradebook View display.  

3. Click an individual’s score for a given exam. 

4. Click Clear Answers to reset the exam. 

5. Click Save & Close. 

Grant additional time 

1. On the Tools menu, click Gradebook. 

2. Select a Gradebook View from the drop-down menu and click Go. All items within the 
selected Gradebook View display.  

3. Click the specific exam for which you want to grant additional time. 

4. In the Grant additional minutes field, enter additional minutes.  
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5.  Click Grant. 

6. Click Save & Close. 

  

  

Test Banks 

Use the Test Bank feature to reuse test, quiz, and exam questions you've already 
created somewhere in your course in later assessments. For example, if you created 
a series of pre-test exercises and wanted to reuse some of those questions for a 
mid-term exam, you don't have to retype those questions into the system. Instead, 
you can use the Test Bank feature to recycle those questions.  

For example, if you decide to delete an exam but don't want to lose the questions 
that you created for the exam, go to the Test Bank page and manually move all the 
questions into the Test Bank. Later, you can reuse some or all of these questions for 
use in another exam.  

Locate Test Bank questions 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click on the Exam item to which you want to add existing 
assessment questions. This can be an existing exam, or it can be a new exam.  

3. Click Test Banks.  

4. In the List questions from box, select the exam, or quiz, etc., from which you'd like to 
reuse questions. You can select a specific exam, or you can select All Questions to see 
every exam question currently in your course for the selected question type. If you like, 
you can see questions that are not currently in use. 

5. In the of type field, select the question type you'd like to see.  

6. Click Search. All questions meeting your search specifications are listed. You can now 
either copy or move any of these questions to another exam.  

Add or move Test Bank questions to another exam 

1. In the navigation tree, click the Author tab. 

2. In the navigation tree, click on the Exam item to which you want to add or move 
assessment questions.  

3. Click Test Banks. All exams, assessments, quizzes, tests, etc. that you've created in the 
course display in the List questions from display box. 

4. Select the check box beside the questions you want to move or copy to the new location. 

5.  In the drop-down list provided, select one of the following: 

 Copy - Copies the question to the new exam. The question is added to the last page of 
the exam. You can reorder exam questions from within the exam. 

 Move - Moves the question to the new exam. The question is removed from the previous 
exam. If students have already taken an exam, questions cannot be removed from that 
exam. 

6. Use the other drop-down list to select a destination for the selected questions. Choose from 
all your course's exams, assessments, etc., or choose questions not in use. 
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If you decide to delete an exam but don't want to lose all the questions created for it, 
go to the Test Bank page and manually move all the questions in the exam to the 
Questions Not in Use category. Then, you can filter by Questions Not in Use to 
pull some or all of these questions for another exam, and there they'd be! 

7. Click Go.   
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Gradebook 
You and your students have access to a shared online Gradebook. Use the 
Gradebook to determine which aspects of your course should be graded and add 
these items to your online Gradebook as gradable items. Next, assign a "total points 
possible" value to each gradable item. As students complete assignments, you can 
evaluate their work and then enter their grades into the Gradebook. If you entered a 
total point value for each gradable item when you set up your Gradebook, the 
Gradebook can use the students' actual points and the total points possible to 
calculate current student grades at the content item, Unit, and course 
level. Students' names display in Gradebook after they have enrolled in your course.  

Additionally, you can use Gradebook to post comments for each grade, grant 
students additional test time, create links to course content for review, and view 
students' activity in the course. You can also create custom gradable items as they 
relate to the course, such as participation, group projects, extra credit, assignments, 
etc.  

See also: 

• How to Set Up Gradebook  

• Add Items to Gradebook 

• Assign and Change Grades 

• Assign Extra Credit 

• Assign Points and Weights 

• Design Tips: Gradebook and Exams 

• Exclude Grades 

• Export Grades 

• Preview Gradebook Settings 

• Quick Grade View 

• Reset or Grant Additional Time 

• Select Gradable Items 

• Set Gradebook Preferences 

• Share Grades with Student 

• View Grades 

• View User Activity 
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How to Set Up Gradebook 

Gradebook can be set up in 3 easy steps. These steps correspond to the tabs across 
the top of the Setup Gradebook page. Each tab builds upon the previous tab. 

To set up Gradebook, you must add content items to your course; otherwise, no 
content items appear in the Setup Gradebook page. Once you've added content 
items, you decide which items show in the Gradebook and which instances of those 
items are gradable. This is important because not all content items are assigned 
grades.  

For example... 

 Let's say you created a Readings content item in your course. The Readings content 
item is not something students would be graded on per se. However, a Threaded 
Discussion revolving around the Readings section probably would be graded, and 
therefore included in the Gradebook. Or, you might have created two research paper 
assignments in your course where the first assignment is practice and the second is 
the actual assignment. In this case, the first paper would not be graded, but the 
second paper would be. You can identify in the Gradebook which instance of each 
item is gradable. 

Once you identify and select gradable items, assign specific point values to each 
gradable item. Assigning total points possible values allows the Gradebook to 
calculate current student grades. 

To set up Gradebook: 

1. Add items - This is where you decide which content items and course tools to show in your 
Gradebook. 

2. Select gradable items - This is where you determine which items will be assigned grades. 

3. Assign Points or Weights - This is where you assign points possible or relative weighted 
percentages to gradable items. 

Add Items to Gradebook 

Adding items to Gradebook is the first step in your Gradebook setup process.  

When you add items to Gradebook, you are selecting which course items and course 
tools to display. For example, you might decide that the Lecture content item does 
not need to display in the Gradebook, but that Threaded Discussions should. 

 If your course includes Sharable Content Objects (SCO's), each SCO is gradable 
by default and each SCO is assigned 100 points in the Gradebook. This is because 
the SCORM Player returns a student's score as a percentage of 100%; it is therefore 
necessary to convert the percentage into a point value. 

Design Tips: 

 If you haven't added any content items to your course yet, only the default course tools 
display on the Add New Items page.  

 Exams and content items that have a Dropbox associated with them are selected by default 
because the system assumes they are gradable items. You can clear the check box for 
content items selected by default. 



 

125 

Add new items 

1. On the Tools menu, click Gradebook. 

2. Click Setup Gradebook, and then click the Add New Items tab. 

3. Select the check box next to each item you want to display in your Gradebook. Selected 
items are visible to you and to your students when viewing the Gradebook. 

4. Click Save Changes.   

Add custom items 

Adding custom items to the Gradebook is an easy way for instructors to record 
participation points, attendance, etc. for the course. Unlike content items, custom 
items added to Gradebook do not tie into the Course Tools. This means, when you 
add a custom item to Gradebook, it is independent from the Course Tools and does 
not work in conjunction with DropBox, Journal, Webliography, etc. 

1. On the Tools menu, click Gradebook. 

2. Click Setup Gradebook, and then click the Add New Items tab. 

3.  In the Add Custom Item field, type a name for the custom item. 

4. Click Add. The new item displays in the list of content items. 

5. Select the check box next to the custom item name to add it to your Gradebook. 

6. Click Save Changes.   

Assign and Change Grades 

After you  set up Gradebook, you can enter grades and comments into the 
Gradebook. The Gradebook system then calculates and displays up-to-date letter 
and numeric grades for each student, which you can then export to a regular 
spreadsheet application.  

In addition to assigning grades, you can also  reset an exam to allow a student to 
retake an exam, or you can  grant additional time.  

Assign grades to all students for a single content item 

1. On the Tools menu, click Gradebook. 

2. In the Select Gradebook View drop-down list, select the content item you want to grade. 
For example, if you created a Webliography assignment in Unit 4 of your course, select Unit 
4 from the drop-down list. 

3.  Click Go.  

4. Locate and click on the selected content item in the Gradebook page that displays.  

5. Enter a numeric grade, letter grade, or both for each student. 

6.  Click Save Changes. 

Change students' grades 

1. On the Tools menu, click Gradebook. 

2. Click on the student's name to display grades for that student. 

3.  Click on the student's score.  

4. Make any changes to the grade or add comments as needed. 
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5. Click Save Changes. 

Assign Extra Credit 

To assign extra credit points, the points and calculations setting in your Gradebook 
Preferences must be selected. 

For extra credit items, Gradebook includes in its calculation the extra credit points a 
student achieves for each assignment. However, the total points possible for extra 
credit assignments is not included in the calculation for the total points possible for 
the course.  

To make an extra credit item: 

1. In the Tools menu, click Gradebook. 

2. Click Setup Gradebook, and then click the Assign Points/Weights tab. 

3. Click Extra Credit. 

4. Select the check box beside the items you want to assign extra credit.  

5. Click Save Extra Credit Selections. 

Assign Points and Weights 

Assigning point values or weighted values to course content is the third step in your 
Gradebook setup process.  

Once you've decided which items to show in the Gradebook and in which Units each 
item is gradable, you can assign point values or possible points to each item.  

From the Assign Points/Weights page, you can assign weighted values to content, 
create extra credit items, and create practice assignments by excluding an item from 
the course grade.  

If you want the Gradebook to calculate up-to-date grades for your students, you 
must assign point values to your Gradebook items. If you 

 assign points for each gradable item, the Gradebook uses this value and the students' 
actual achieved points to calculate grades for each student at the content item level, the 
Unit level, and the overall course level; 

  do not assign points possible to a gradable item, nothing displays in the points possible 
field when you and your students view the Gradebook.  

Design Tips: 

 In your Gradebook Preferences, there is a setting for Use points and calculations. 
Select this setting to assign points possible, assign weighted percentages, and create extra 
credit or exclude extra credit from course grade items. 

  If you've created an exam in your course, the exam will already have a total point value 
assigned to it. To see the points you assigned to an exam when you created the exam, click 
the Insert Points link for that particular exam. You can change the points possible for the 
exam by entering a new point value in the text box. 

 Assigning points is optional; however, assigning total points possible values allows the 
Gradebook to calculate current student grades. You can assign points without using 
weighted percentages; however, you cannot use weighting without assigning points. 
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 Use the Weighting feature to easily weight or grade course items relative to other course 
content. For example, let's say you have an exam worth 50 points, but you want it to count 
for 25% of a student's grade, instead of adjusting all your course points to make this 
percentage, you can weight the exam in the Gradebook at 25%. Weighting allows you to 
easily count some course content items more than others without having to rely on point 
totals. 

 Use the Distribute Weight % feature to distribute a single weighted percentage evenly 
across multiple content items. For example, if you want Threaded Discussions in your 
course to be worth a total of 20% of the final course grade and you create three Threads, 
the Distribute Weight % feature assigns a weighted percentage of 6.66%, 6.66%, and 
6.68% to each Thread. Click Distribute Weight % to access this feature. Remember, you 
cannot distribute a weighted percentage to content items excluded from the course grade. 

Assign points 

1. On the Tools menu, click Gradebook. 

2. Click Setup Gradebook, and then click the Assign Points/Weights tab. 

3. Enter the points possible for each gradable item. Gradebook calculates student percentages 
based on the Total Points assigned to each gradable content item.  
 
If you click Insert Points, you can see the assigned points to the exam content items you 
created. If you have not created an exam yet in your course, the Insert Points link is not 
visible. 
 

4. Click Save Changes. 

Apply weighted values 

1. On the Tools menu, click Gradebook. 

2. Click Setup Gradebook, and then click the Assign Points/Weights.  

3. Enter a weighted percentage for each gradable item.  
 

For example... 

 To make an assignment worth half of a student's grade, enter 50 in the % field for 
that assignment. Note that you'll need to enter possible points for the assignment, 
too, so the Gradebook will know how the student did on the assignment before 
applying his/her weighted percentage. 

4. Click Save Changes. Although it's not required, the sum of your weighted percentages 
should equal 100%. 
 
Always assign weighted percentages to the items you want counted toward the final course 
grade. If the Weighting feature is turned on and you do not assign a weight percentage to 
a gradable item, that item is not counted toward the final course grade (essentially, the 
item carries a weight of 0%). 

Design Tips: Gradebook and Exams 

Following is a list of helpful tips and reminders to help you use the Gradebook more 
efficiently. Many preferences you set when creating an exam affect how the exam 
displays in the Gradebook. 

Tips for Gradebook 
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 Use Gradebook as another communication tool to comment on graded assignments and 
provide feedback to students on their progress in the course.  

 User Activity - Haven't heard from a student yet? Use the User Activity feature to see if 
the student came to class. If they haven't been spending time online, send an email to 
review directions and answer questions and concerns. User Activity is not designed to be 
used as a participation grade. Many students print course material to read offline, or leave a 
page open for a while without actually participating in the course. When this occurs, the 
activity in class will be skewed.  

 Extra Credit and Exclude from Course Grade features can be used with or without 
Weighting turned on; however, you must have Points/Calculations turned on.  

 The Dropbox and the Gradebook are connected meaning, if you enter a grade through the 
Dropbox interface, the grade also shows in the Gradebook and vice versa. Remember, you 
must return the assignment to the student before the student can see the assignment in 
his/her Inbox. 

 The Gradebook calculates and displays up-to-date points and calculations by default. With 
this option enabled, students can see their Grade to Date, Current Course Average, and 
Points Possible. You can turn this feature off in Gradebook Preferences. Remember that 
in doing so, however, students will not have access to calculated figures (like Current Grade 
to Date, for example). Remember, also, that you must have assigned points to gradable 
items in order to display Gradebook calculations. 

 You can assign a Final Letter Grade from any view in the Gradebook in which you see the 
Points column. Click the student's current course points, and then click Save & Next to go 
to the next student. 

 Grade data is not removed if you disable Gradebook from the Enable/Disable tools list in 
Course Admin. When you disable a tool, the system is hiding it from course and author 
view. 

 Weighted grades 

 The Weighting feature in the Gradebook, set in Gradebook Preferences, enables you to 
weight or grade course items relative to other course content. For example, you have an 
exam worth 50 points, but you want it to count for 25% of a student's grade. Instead of 
adjusting all your course points to make this percentage, you can weight the exam item. 
The Weighting feature is optional. 

 If you want to provide graded feedback on an assignment but not include the grade in 
the final course grade, exclude the item from the course grade. This feature is excellent 
for practice assignments which you want to grade but not count. To exclude items from 
the course grade, click the Gradebook tab, click Setup Gradebook, click Assign 
Points/Weights, then click Exclude from Course Grade. Select the check box to 
those items you do not want to include in the final course grade. Excluded items are 
marked by  throughout your Gradebook. 

 The Distribute Weight % feature, set in Assign Points/Weights, enables you to apply a 
single weighted percentage evenly across multiple content items. For example, if you 
want Threaded Discussions in your course to be worth a total of 20% of the final course 
grade and you create three Threads, the Distribute Weight % feature assigns a weighted 
percentage of 6.66%, 6.66%, and 6.68% to each Thread.   

 If you have the Weighting feature turned on but do not assign a weight percentage to a 
gradable item, that item will not count towards the final course grade. Essentially, the 
item carries a weight of 0%. 

 If you're using Weighting in your Gradebook, your students will see a Course Weighted 
Average rather than a Grade To Date. The Course Weighted Average indicates that 
course content items have different weights assigned to them. Students see their current 
weighted grade as well as remaining course work and its relative weight. For example, a 
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student who did poorly on one assignment might see that the assignment was only worth 
10% of the final course grade. 

 View grades 

 The Quick Grade View is perhaps the most common and efficient way to assign grades in 
the Gradebook. This view lets you assign grades to all students for a single content item 
(like a Webliography entry, for example). You simply locate the content item (or course 
tool) in the Gradebook and then assign a grade for each student. 

 The Export Current View feature located on each Gradebook screen exports only the 
current displayed view of the Gradebook. If you want to export your entire Gradebook, go 
to the Show All view and then click Export Current View. Students cannot see a grade 
you've assigned them unless the share grade with student option is selected. This 
option appears in all Gradebook Details windows and within the Dropbox. 

 To accurately show students their Current Grade to Date, enter zeros in any incomplete 
items to that point in the course. Gradebook only calculates graded items, so if a student 
did not turn in an assignment, the total possible points for that assignment is not figured 
into the total points possible for the course, skewing the student's grade to date. 

Tips for Exams 

 The options selected when setting up an exam affect the Gradebook display for both you 
and your students. For example, if you want students to view exam scores in Gradebook 
without you having to manually enter points or scores, select the Automatically display 
the objective score for completed exams to students in the Gradebook option when 
setting up the exam.  

 To automatically have students view scores for an exam, remember to set a Gradebook 
Review Date when you create the exam. If a review date is not set, students cannot view 
the comments or scores entered in Gradebook. 

 Print students' completed exams for offline grading. Locate the exam in the Gradebook, 
click the asterisk * to open the Gradebook Details window for that exam, and then click 
Print View. In the File menu, click Print. 

 Save a printer-friendly version of completed exams to your computer or network for offline 
grading. Locate the exam in the Gradebook, click the asterisk * to open the Gradebook 
Details window for that exam, and then click Print View. In the File menu, click Save 
As.  

 Reset a student's exam through the Gradebook Details window. Resetting an exam clears 
all saved information from the individual exam database and allows the user to begin the 
exam again, as if the student had never taken it. 

 Grant a student additional time on an exam through the Gradebook Details window. 
For example, if a student was in the process of taking an exam and the student's Internet 
connection was lost, the system would "think" that this student had already taken the exam 
and would, therefore, not let the student retake the exam. This option allows the student to 
access the exam again for the amount of time you specify. Information previously saved is 
still there, and the student starts the exam wherever he or she left off. 

Exclude Grades 

Exclude items from the course grade when you want to provide a grade for the 
assignment but not include the grade in the final course grade. This feature is 
excellent for practice assignments you want to grade but not count. 

To exclude an item from the course grade: 

1. On the Tools menu, click the Gradebook. 
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2. Click Setup Gradebook, and then click the Assign Points/Weights tab. 

3. Click Exclude from Course Grade. 
 
In the window that opens, select those items with point values you do not want included in 
the final course grade. Your excluded items will display with the  icon throughout your 
Gradebook. You must have the Points/Calculations setting selected in your Gradebook 
Preferences to see this feature. 
 

4. Click Exclude Selections from Course Grade. 
 

  

Export Grades 

You can export the current view of your Gradebook to a comma-separated value 
(.csv) file, which you can then open in any spreadsheet application. Doing so enables 
you to take advantage of standard spreadsheet functions such as calculating mean, 
medium, average, and other statistical calculations. Exporting the current view of the 
Gradebook also provides you with final grades in a format that you can turn in to 
your administration and keep as a backup for your records. 

The Export View feature exports the current Gradebook view. If you want to export 
your entire Gradebook (for archive purposes, for example), run the export from the 
Show All view.  

 If you choose to export letter and number grades or just letter grades, ensure 
you've assigned letter grades in your Gradebook. If you have not assigned letter 
grades, an empty column displays in the exported Gradebook file. 

To export the current view of your Gradebook: 

1. On the Tools menu, click the Gradebook. 

2. In the Select a Gradebook View drop-down list, select the view you'd like to export. 

3.  Click Go. The Gradebook page changes to the selected view. 

4. Click Export View. 

5. Select the data format in which you'd like to export the current Gradebook view: 
 
 

 Letter and Number Grades - Exports the current view with Letter grades and Number 
grades in separate columns. 

 Number Grades Only - Exports the current view with Number grades only. 

 Letter Grades Only -  Exports the current view with Letter grades only. 

6. Click Export. A File Download window opens.  

7. Select Save, and then click OK. A Save As window opens in which you can select a name 
and location for the exported Gradebook file.  

Unless you enter a name for your exported file in the Save window, the system 
names the file using the date, followed by the view and data format. For example, 
a file exported on March 26th, 2007 would be named 
"032606ShowALL_Letterand#." 
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8. Click Save. The current view of the Gradebook file is saved with a .csv file extension in the 
specified location. You can use any spreadsheet to open the Gradebook file. 

Preview Gradebook Settings 

You can click the Current Setup tab anytime as you set up your Gradebook to 
preview what your Gradebook will actually look like and display. The Current Setup 
tab shows you all the content items you've added to your Gradebook. If you've 
identified a content item to be gradable in a particular Unit or week, the points 
possible for that item appear in the appropriate week. Similarly, if you've chosen to 
apply weighting to content items (i.e., to grade assignments as a percentage of the 
whole course grade), the weight percentage for each item displays above the point 
total. A summary of any course points and weighted percentages appears at the top 
of your current setup. 

If you are setting up your Gradebook for the first time, your Gradebook will be 
empty. However, exams and items associated with a Dropbox are automatically 
added to your Gradebook. Click the Add New Items tab to add items to your 
Gradebook. 

Gradebook Keys  
There are several symbols in your Gradebook you might see. For example:   

 A horizontal line (--) in your Current Gradebook Setup means that you marked the item as 
gradable in that Unit but you have not yet assigned points to the item (only with points 
turned on).  

 A horizontal line next to the "%" sign means you identified the item as weighted but that 
you have not yet assigned the weighted percentage (only if weighting is turned on). To 
assign points or weights, click the Assign Points/Weights tab under Setup Gradebook.  

 Grades in brackets [ ] identify graded items that have not been shared with the student.  

The Gradebook also identifies items with a Dropbox associated with them, extra 
credit items, or items that have been excluded from the course grade. You can view 
the Gradebook Setup Key or the Gradebook Key any time from the bottom of the 
Current Setup or View Gradebook screens within the Gradebook should you need 
help interpreting these symbols.  

Quick Grade View 

The Quick Grade View is the most efficient way to assign grades in the Gradebook. 
This view enables you to assign grades to all students for a single content item. 
Locate the content item in the Gradebook, and then assign a grade for each student. 

Additionally, from the Quick Grade View for exams you can reset an exam and grant 
additional exam time for a student. 

Assign grades using the Quick Grade View 

1. On the Tools menu, click Gradebook. 

2. Locate the content item in the Gradebook for which you want to assign grades. You can do 
this from any Gradebook view, although it might be easiest to locate the item in the Unit or 
Week View. 

3. Click the content item. For example, to grade a Webliography entry, click Webliography. 
The Quick Grade window opens, displaying each students' name. 
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4. Enter a Numeric or Letter grade for each student. You can also enter a brief comment.  

If you've accessed the Quick Grade view from the Item Summary, you will be able 
to enter a letter grade only from this view, as the student's numeric grade (or 
weighted average if Weighting is turned on) in this screen reflects a compilation of 
multiple content item scores. 

If you're grading an exam or an item that has a Dropbox associated with it, you 
will see some additional fields in the Quick Grade View. 

5. Click Save Changes. 

Grade Dropbox items using the Quick Grade View 

The Quick Grade View for Dropbox items includes a couple options: 

 Dropbox Status - Shows you where the actual assignment is, whether it's in your Inbox or 
your Outbox.  

 Return to Student - Select this check box to have the option of returning all assignments 
to all students at the same time, or grading all assignments before returning them. 

Assess outcomes using the Quick Grade View 

1. On the Tools menu, click Gradebook. 

2. Locate the content item in the Gradebook for which you want to assess outcomes. You can 
do this from any Gradebook view, although it might be easiest to locate the item in the Unit 
or Week View. 

3. Click the content item. For example, to grade a Webliography entry, click Webliography. 
The Quick Grade window opens, displaying each students' name. 

4. Click Assess Outcomes.  

5. In the fields provided, select a score and type a comment for each criteria listed as part of 
the requirements to meet the learning outcomes of the assignment.  
 
(Optional): In the Score drop-down menu, select N/A for any learning criteria not 
appropriate for the selected student. When N/A is selected, the weight of the criteria is not 
calculated into the final Strength (Weight%) score. Remember, Strength (Weight%) scores 
are separate from Gradebook weights.  

6. Click Save Changes. 

 
 

Reset or Grant Additional Time 

Occasionally, you might need to either reset an exam for a student or grant a 
student additional exam time. For example, if a student loses his or her internet 
connection while taking an exam, the system thinks that this student has already 
taken the exam and would, therefore, not let the student retake the exam. 
Depending on the individual situation, you can do one of the following: 

 Reset the exam - Clears all saved information from the individual exam database and 
allows the user to begin the exam again, as if he or she had never taken it.  

 Grant additional time - Allows the student to access the exam again for the amount of 
time you specify. Previously saved information in the exam is still there and the student can 
start the exam wherever he or she left off.  
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Reset an exam 

1. On the Tools menu, click Gradebook. 

2. Select a Gradebook View from the drop-down menu and click Go. All items within the 
selected Gradebook View display.  

3. Click an individual’s score for a given exam. 

4. Click Clear Answers to reset the exam. 

5. Click Save & Close. 

Grant additional time 

1. On the Tools menu, click Gradebook. 

2. Select a Gradebook View from the drop-down menu and click Go. All items within the 
selected Gradebook View display.  

3. Click the specific exam for which you want to grant additional time. 

4. In the Grant additional minutes field, enter additional minutes.  

5.  Click Grant. 

6. Click Save & Close. 

  

  

Select Gradable Items 

Selecting which items in your course to mark as gradable is the second step in your 
Gradebook setup process.  

On the Select Gradable Items tab, select the Gradebook items for which you will 
assign grades.  

For example...  

Perhaps you added Threaded Discussions to your Gradebook from the Add New 
Items tab and your course contains Threads in Units 1, 3, and 5. From the Select 
Gradable Items tab, you'll determine which Threads will be evaluated and graded. 
Perhaps the Threaded Discussion in Unit 1 is practice and therefore ungraded, but 
the Threads in Units 3 and 5 will receive grades. 

You can also exclude a content item from the final course grade. This option enables 
you to display an item in the Gradebook and assign a point value to it, but not 
include the point value in the final course calculations. This is useful for when you 
want to grade or provide feedback on a practice assignment but not include the 
score in the student's final grade calculations.  

To mark an item as gradable: 

1. On the Tools menu, click Gradebook. 

2. Click Setup Gradebook, and then click the Select Gradable Items tab. 

3. Select the items or course tools that you want to mark as gradable. 
If you don't see a check box for a particular content item in any given Unit, it means that 
you didn't add that item to that Unit when you set up your course. Course tools are 
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available in every Unit. 
 

4. Click Save Changes. 

  

Set Gradebook Preferences 

In the Preferences section of your Gradebook, you can set Gradebook to display 
points and calculations to your students (86/100 or 86%, for example) or display 
letter grades (B+). If you choose to display points and calculations, you also have 
the option of weighting graded items relative to other graded items. For example, 
making three Threaded Discussions worth 15% of the total course grade, or 5% 
each. Gradebook Preference settings affect what information displays to both you 
and your students. 

If you enable points and calculations and assign a point value to each gradable item 
in your course, the Gradebook can calculate and display up-to-date letter and 
numeric grades for each student at the content item, Unit, and course level. With 
this option enabled, students are given additional information in their Gradebook, 
such as Current Course Points, Current Course Average, and Current Grade to Date. 
If you apply weighting to your course assignments, the Gradebook displays each 
student's Course Weighted Average to date.  

By default, Gradebook calculates points, but not weights. You can turn automatic 
point calculations off from the Preferences tab under Gradebook Setup. By doing 
this, students will not have access to some Gradebook features (like Current Grade 
to Date, for example). You can turn on the weighting feature from the Preferences 
tab.  

The system saves grade data so you can turn points/weights on and off, or enable 
and disable Gradebook, and not lose information.  

To set Gradebook preferences: 

1. On the Tools menu, click Gradebook. 

2. Click Setup Gradebook, and then click the Preferences tab. 

3. In the check boxes provided, change the Gradebook preference settings accordingly. 

 Use points and calculations - Select this to assign points for each item. The 
Gradebook system automatically calculates numeric scores. 

 Use weighted calculations - Select this to assign a weighted percentage to each item. 
The weight is factored into Gradebook calculations. 

4. Click Save Changes. 

 
 

Share Grades with Student 

Most areas in the Gradebook include a Share Grade with Student option. This 
option is useful because it allows you to grade all your students' assignments and 
then return them all at once rather than grading one assignment and returning it, 
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grading another assignment and returning it, etc. It also allows you to grade an 
assignment over a period of time and then return all assignments at once. 

The Share Grade with Student option is enabled by default, so if you don't want to 
share the grade immediately, you'll need to clear the check box for this option. 
Remember, you can share/hide grades and assignments from the Dropbox as well.  

When the Share Grade with Student option is not selected for a graded item, the 
grade displays within brackets [ ] in the Gradebook. 

If you forget to share a grade, the student will not be able to see the grade in his/her 
Gradebook- even if you've graded the assignment. Similarly, if you set a Gradebook 
Review Date for an exam when you created the exam, students will not be able to 
view the exam grade in their Gradebook until the Review Date has passed. The 
Share Grade with Student and the Gradebook Review Date options are the two 
most common reasons that students cannot see grades in the Gradebook. 

  

View Grades 

When you open Gradebook, it defaults to the Grades To Date view, showing each 
students' name along with their current grade. By default, Gradebook Preferences 
are set to display points and automatic calculations. You can change the settings in 
your Gradebook Preferences to show letter grades, or add weighted calculations. 
Whatever your preference, the Grades To Date view can display: 

• a letter grade only (points and calculations off);  

• current course points and current course average (points and calculations on);  

• or course weighted average (points and weighting on). 

View students' grades 

The View Gradebook page provides you with various ways to view grades for 
individual students or all students in the course. Click on individual student names to 
see grades listed by Unit. 

View individual student grades for all content items 

1. On the Tools menu, click Gradebook. 

2.  Click on a student's name. Scores for the selected student display. 

3. Open a specific gradable item for this student by clicking the student's score in the 
Gradebook (if the item has been graded) or by clicking the asterisk * sign if the item has 
not been graded. 

View a student's work while you are assigning a grade   

1. On the Tools menu, click Gradebook. 

2. Click on an individual student name to display all grades for that student. You can also 
locate the content item you want to grade using the Select Gradebook View drop-down 
list.  

3. Click the asterisk * sign under the content item you want to grade. 

4.  Click Expand. This option is only available for some content items and exams. 
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View a summary grade report  

1. On the Tools menu, click Gradebook. 

2. In the Select Gradebook View drop-down list, select Item Summary.  

3.  Click Go. A summary score for all content items, course tools, and custom course items for 
each student displays.  
 
For example, if you had five Reading assignments in your course, each worth 20 points, the 
Item Summary shows you each student's score out of 100 (five assignments X 20 points 
each) rather than showing five separate Readings scores. You'll also see each student's 
final course points and course average. 

View all grades 

The Show All view is a combination of the View by Unit and the Detailed Grade 
Report. Select this option if you want to export the Gradebook to a spreadsheet 
application. Avoid using this view for day-to-day grading.  

1. On the Tools menu, click Gradebook. 

2. In the Select Gradebook View drop-down list, select Show All. 

3. Click Go. This view shows you every grade first by week or Unit, then by content item and 
course tool.  

View grades by Unit or Week 

1. On the Tools menu, click Gradebook. 

2. In the Select Gradebook View drop-down list, select an individual Unit or section in your 
course. 

3. Click Go.  

4. Click the content item name to open the Quick Grade view for that item. 

View final course grades 

The final course grade in Gradeboock might include a letter grade, course points and 
course average, or a weighted course average, depending on your Gradebook 
Preferences. 

1. On the Tools menu, click Gradebook. 

2. In the Select Gradebook View drop-down list, select Grades To Date. 

3. Click Go. You cannot edit the student's total achieved points in this screen, but you can 
edit the student's final letter grade and add comments. 

Student's view of Gradebook 

Ever wonder how your students see the Gradebook? Switch to Course mode to view 
the Gradebook as your students see it. You can also use this view to grade one 
particular student. Students can view the Gradebook by Unit or by item. 

View by Unit 

1. In the navigation tree, click the Course tab. 

2. On the Tools menu, click Gradebook.  

3. Click on an individual student's name. By default, you'll see grades listed by Unit just as 
the student sees it.  
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 Grade - Displays the student's numeric and/or letter score for the item. 

 Earned to Date - Relates the item's score to the rest of the course grade (i.e., taking 
into consideration extra credit and excluded items and, if weighting is turned on, the 
weighted percentage of the item). 

 Possible for Course - Displays what is possible for the course. This column is helpful 
because it displays the points/percentage remaining for items that the student hasn't 
completed yet. 

4. Open a specific gradable item for this student by clicking the student's score (if the item 
has already been graded) or by clicking the asterisk * sign if the item has not been graded. 

View by item 

1. In the navigation tree, click the Course tab. 

2. On the Tools menu, click Gradebook. 

3. Click on a student name. By default, you'll see grades listed by Unit. 

4. In the View gradebook by field, click Item. A summary score for all content items, 
course tools, and custom course items for the selected student displays. This viewing 
option is also available to the student. 
 
For example, if there were five Reading assignments in the course, each worth 20 points, 
the Item Summary view would show the student's score out of 100 (five assignments x 20 
points each) rather than showing five separate Readings scores (i.e., it displays a 
composite score for all Readings). You'll also see the student's current item points and 
course average (or, with Weighting turned on, the student's item points and the item's 
weighted percentage). 

View User Activity 

User Activity tracks the amount of time (in minutes) that individual students spend in 
the course and where in the course they spend their time. With the User Activity 
feature, you can see how much time a student spent in an individual Unit or content 
item, as well as the dates on which the student accessed the course. You can export 
this data to a spreadsheet. 

Ways you can view User Activity 

Remember, User Activity time may not necessarily reflect the time students were 
actually working in the course. User Activity provides information regarding how long 
a student spent in each area of the course. A short user activity time may be due to 
a student quickly entering a course area, printing the material, and then working 
offline. If a student does not log out of their course or logs out infrequently, the User 
Activity time displayed may be higher than the student's actual time spent in a 
particular area of the course.  

View user activity the following ways: 

 View by Unit or Course Tool - Shows you how much time a student spent in a particular 
Unit or tool. 

 View by Date - Shows you how much time a student spent in the course for a specific date 
range. 

 View by Student - Shows you a bar chart graph of how much time one particular student 
spent in each Unit or in a specific content item(s). This option is available from the View by 
Unit view and the View by Date view.   
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View user activity by Unit or course tool 

1. On the Tools menu, click Gradebook. 

2. Click User Activity.  

3. Click any of the following:  

 Unit number - View all the content items in that Unit, as well as the amount of time 
each student spent in each item. 

 Course Tools - View all the Course Tools in the course, along with the amount of time 
each student spent in each tool. 

 student's name - View the User Activity summary for that one user. 

4. Click Export View to export the current view to a comma-separated value (.csv) file. 
Save the .csv file to your hard drive and open using any spreadsheet application. 

View user activity by date 

1. On the Tools menu, click Gradebook. 

2. Click User Activity. 

3. In the Select User Activity view drop-down list, select View by Date, and then click Go. 
A matrix displays showing user activity during the current week in minutes. 

4.  To view user activity during a specific period of time, use the drop-down boxes to select 
From and To dates and then click Go. User activity for the dates selected displays in the 
matrix. You can also click on a specific student's name and see the User Activity summary 
for that one user. 

5. Click Export View to export the current view to a comma-separated value (.csv) file. 
Save the .csv file to your hard drive and open using any spreadsheet application.  

View user activity by student 

1. On the Tools menu, click Gradebook.  

2. Click User Activity. 

3. Click on a student name. The User Activity summary for that student displays 

4. Click  to view the student's individual user activity time for each content item within the 
course. You can also click Course Tools to view student activity for specific course tools. 

5. Click Export View to export the current view to a comma-separated value (.csv) file. 
Save the .csv file to your hard drive and open using any spreadsheet application. 
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Learning Outcomes 
In addition to the Course Tools, Learning Outcome Manager (LOM) is a key feature 
that makes Teaching Solutions unique. Getting started with Learning Outcomes is 
easy! As an instructor, you can use LOM to add Learning Statements from the 
LOM library (from now on, referred to as the repository) to your course. Once added 
to the course, you can then link those Learning Statements to Content Items and 
assess student performance against outcomes identified in the course rubric.  

LOM is available from the  Enable or Disable tools page only if your System 
Administrator has turned it on for your course.  

How it works: 

Many schools follow their own learning criteria for program and course objectives to 
meet standards set by accrediting agencies, colleges, program administrators, etc. In 
LOM, these learning criteria and course objectives are referred to as “Learning 
Statements.” The Learning Statements for your school are stored in a repository. By 
adding Learning Statements to your course, and then linking those Learning 
Statements to Content Items, you can track and measure the level of student 
proficiency across course projects, activities, etc.  

To Open LOM: 

1. In the Left Navigation menu, click Course Home. 

2. Under Course Home, click Learning Outcomes. By default, the system shows the 
previously accessed LOM repository. For first time users, click Add Learning Statements 
to select a repository and get started. 

See also: 

 Add Learning Statements to Course 

 Link Learning Statements to Content Items 

 View Learning Outcomes 

 Edit Learning Statements 

 Remove Learning Statements 

Add Learning Statements to Course 

By adding Learning Statements from LOM to your course, and then linking Learning 
Statements to course Content Items, you can trace and monitor student 
performance on defined outcomes for the course. Learning Statements in LOM are 
organized and grouped according to how they relate to each other. For example, 
non-measurable outcomes may be considered institutional goals; whereas, 
measurable outcomes might qualify as course skills or tasks a student can 
demonstrate. However your school structures Learning Statements in the 
LOM repository, use LOM's search tools to locate and add Learning Statements that 
pertain to your course.  

Design Tips: 
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 As a best practice, add Learning Statements from the lowest Level in the repository 
structure to your course. Because Learning Statements are often times linked to each other 
(associated) in the repository structure, linking from the lowest Level of the repository 
prevents conflict once you start linking Learning Statements to Content Items.  

To Add a Learning Statement to the Course: 

1. Open LOM. 

2. On the Outcome Management tab, click Add Learning Statements. 

3. In the search fields provided, enter information accordingly.  
 

Describe the search fields 

 

Field Description 

Learning 
Statement 

Type the ID or text you know the Learning Statement contains. 
Learning Statement is the generic term used in LOM to mean 
learning objectives, learning outcomes, goals, competencies, 
values or whatever term used that is unique to your school.  

Source Use the drop-down list provided to select the source of the 
Learning Statement. Source (Metadata) is the information 
entered about the Learning Statement. This information can 
include course IDs, accrediting agencies, state or government 
sanctioned standards, etc.  

Level Use the drop-down list provided to select a Level. A Level 
represents the organizational Level in your institution's 
Repository Structure where Learning Statements are collected. 
Organizational Levels commonly used by some schools 
include: Institution, Program, Course, and Task. 

Group Use the drop-down list provided to select the Group in which the 
Learning Statement resides. You must select a Level before you 
can select a Group otherwise, the drop-down list is empty. A 
Group is a collection of related Learning Statements. Levels can 
contain multiple Groups. 

 

4. Click Go.  

5. In the search results that display, select the check box for the Learning Statements you 
want to add to the course.  

6. (Optional) If you'd like to add Learning Statements from other repositories, click Switch 
Repositories. Some instructors use this when outcomes are shared with other courses 
from a different Program or College. Once you add Learning Statements from other 
repositories to your course, the repository becomes available as a clickable tab so that you 
don't have to search for the repository again. 
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7. Click Add to Course. To continue adding Learning Statements, click Save and Add 
Another. The Learning Statements display in alphabetical order by course ID and are 
organized by Level (i.e. Institution, Program, Course, Task). 

  

Link Learning Statements to Content Items   

The Outcome Management page in Learning Outcomes Manager provides a summary 
view of all the Learning Statements pulled into your course. From this view, you can 
view the alignment of course outcomes and Learning Statements to course Content 
Items. This view is also valuable because it provides a summary view for you to see 
in which Unit or section of the course an activity is covered. On the Outcome 
Management page, you can link Learning Statements to Content Items, edit Learning 
Statements, and remove links to Content Items. Additionally, you can enter Strength 
(Weight %) values to Learning Statements defined in the course rubric. Please note, 
LOM's edit features might not be turned on for your course. See your system 
administrator about LOM configuration settings. 

Linking Learning Statements to your course Content Items enables you to trace and 
monitor student performance on defined outcomes for the course. Learning 
Statements in LOM are organized and grouped according to how they relate to each 
other. For example, non-measurable outcomes may be considered institutional 
goals; whereas, measurable outcomes might qualify as course skills or tasks a 
student can demonstrate. However your school structures Learning Statements in 
the LOM repository, use LOM's search tools to locate and add Learning Statements 
that pertain to your course. 

Design Tips: 

 As a best practice, the system prevents you from linking Content Items to Associated 
Learning Statements that are already linked to Content Items in the course. When a 
Learning Statement is "associated" in LOM, it means the Learning Statement is linked to 
another Learning statement within the repository. Remember, repositories are organized 
into Levels forming a hierarchial structure, starting with a top Level and ending with a 
bottom Level. The logic of this structure dictates the association between Learning 
Statements.  

 Changes made to the Content Items in the course are reflected in existing Learning 
Statement and Content Item link relationships; meaning, if you change a Content Item that 
is linked to a Learning Statement, the system updates your changes for the activity type for 
a presentation or assessment on the Edit Learning Statement page in LOM.  

 Once a Learning Statement is linked to Content Items, the Learning Statement cannot be 
deleted from the LOM repository. This means, system administrators cannot delete Learning 
Statements from the LOM repository that are linked to Content Items in a course currently 
in session. 
 

View Outcome Management 

1. In the Left Navigation menu, click Course Home. 

2. Under Course Home, click Learning Outcomes. The Outcome Management page displays 
showing learning outcomes to the previously viewed repository. If you use multiple 
repositories, tabs display on the page for you to use to switch between repository views. 
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Link Learning Statements to Content Items 

1. Open LOM. 

2. On the Outcome Management tab, click Add Learning Statements. 

3. In the search fields provided, enter information accordingly.  
 

Describe the search fields 

 

Field Description 

Learning 
Statement 

Type the ID or text you know the Learning Statement contains. 
Learning Statement is the generic term used in LOM to mean 
learning objectives, learning outcomes, goals, competencies, 
values or whatever term used that is unique to your school.  

Source Use the drop-down list provided to select the source of the 
Learning Statement. Source (Metadata) is the information 
entered about the Learning Statement. This information can 
include course IDs, accrediting agencies, state or government 
sanctioned standards, etc.  

Level Use the drop-down list provided to select a Level. A Level 
represents the organizational Level in your institution's 
Repository Structure where Learning Statements are collected. 
Organizational Levels commonly used by some schools 
include: Institution, Program, Course, and Task. 

Group Use the drop-down list provided to select the Group in which the 
Learning Statement resides. You must select a Level before you 
can select a group otherwise, the drop-down list is empty. A 
Group is a collection of related Learning Statements. Levels can 
contain multiple Groups. 

 

4. Click Go.  

5. In the search results that display, select the check box for the Learning Statements you 
want to link to.  

6. (Optional) If you'd like to link to Learning Statements from other repositories, click Switch 
Repositories. Some instructors use this when outcomes are shared with other courses 
from a different Program or College. Once you add Learning Statements from other 
repositories to your course, the repository becomes available as a clickable tab so that you 
don't have to search for the repository again. 

7. Click Add to Course. To continue adding Learning Statements, click Save and Add 
Another. 
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View Learning Outcomes 

Once you have linked Learning Statements to course Content Items, use the 
Outcome Summary page to monitor the current assessment status on content 
presented in the course and the aggregate score in class performance. Assessment 
details by outcome or student provide valuable insight in measuring the effectiveness 
of the assigned learning criteria for defined outcomes.  

To view Outcome Summary: 

1. In the Left Navigation menu, click Course Home. 

2. Under Course Home, click Learning Outcomes. 

3. Click Outcome Summary. By default, the Outcome Summary page opens to the Details 
by Student tab.  

Details by student 

The Details by Student page shows you the aggregated score to only assessed 
content items. This means, a score does not display for course Content Items not 
mapped to Learning Statements from LOM or not assessed in the course.   

How to use the Details by Student tab 

What was the median score for the class on a quiz? How is an individual student 
performing in relation to the rest of the class? By default, the Outcome Summary 
page opens to the Details by Student tab. The Details by Student tab shows you 
assessment details for all students in the course and provides links to view in further 
detail assessment information for individual students or learning outcomes. In the 
image below, click on the highlighted areas to learn more.  

 
How to read the aggregation score 

The aggregation score shows the student score to date and consists of two numerical 
values: 

 points earned out of points possible  
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  percentage value for points earned  

Export Assessment Details 

Export the class scores from your course using the Export Assessment Summary 
feature. From the Detail by Student page, simply click Export Assessment 
Summary. The system exports the class scores to an easy-to-read spreadsheet 
view.  

Color Key 

As a visual aid, LOM uses a color code so from a glance you can quickly see the 
proficiency levels for the class and by student. The following table describes each of 
the colors and what it means when an asterisk or dash displays instead of a number. 

Color Description 

 

 

 

 

Indicates the level of proficiency for the class or student, where 

Red - 0-69% 

Orange - 70-79% 

Yellow - 80-89% 

Green - 90-100% 

 Like in Gradebook, the asterisk is a friendly reminder to you that 
a score or assessment has not been entered for the student.  

 Like in Gradebook, the dotted-dash means a student has not 
submitted work for the assigned outcome. 

 Indicates the score or assessment for the student is not 
complete. 

Details by Outcome 

The Details by Outcome page shows you how students are performing against the 
learning outcomes defined for the course. This includes the number of times content 
is presented and assessed, a description of the learning outcome, and the proficiency 
levels of the class. 

How to use the Details by Outcome tab 

Click on the highlighted area in the image below to learn more about that section. 
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Edit Learning Statements 

The Edit function in LOM is enabled by your System Administrator. If the  button is 
not available from the Outcome Management page, it means the Edit function is 
turned off. See your System Administrator about LOM configuration settings.  

When you edit Learning Statements, you are not changing the Learning Statement 
itself, but instead you are changing the link relationship between Learning 
Statements and Content Items. If you have a Learning Statement linked to multiple 
Content Items within a course, you can remove the link at any time. To remove all 
links from a single Learning Statement to multiple Content Items in the course, see 
Remove Links to Content Items. 

To Edit Learning Statements: 

1. Open LOM. 

2. On the Outcome Management tab, click  for the Content Item and Learning Statement 
relationship you want to change. 

3. Using the fields provided, make your changes.  
 

Describe the edit fields 

 

Field Description 

Unit Displays the Unit in which the Content item and activity or assessment 
types for that Content Item resides.  

Content 
Item 

Displays the selected Content Item type used for the course activity.  

Presented  Either: 
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   Select the check box to indicate the assignment for the Learning 
Statement is a non-measurable or presented type of activity. 

  De-select the check box to indicate the activity is not presented or 
non-measurable. 

Assessed  Either: 

 Select the check box to indicate the assignment for the Learning 
Statement is an assessed activity. For example, a paper or exam 
might be the activity you use to measure a student's understanding of 
Shakespeare.  

 De-select the check box to indicate the activity is not assessed.  

 

4. Click Continue. The Learning Statements marked as "Assessed" display. 

5. Enter a Strength (Weight %) for the Content Items you want assessed for the course. 
 

Explain more about Strength (Weight %) 

The weight value entered here is separate from grades assigned in Gradebook. The 
Strength (Weight%) in LOM is strictly a way for you to indicate the curriculum 
makeup the course, or how much assessed content is covered throughout the 
course.  

6. Click Continue. 

7. Enter a Strength (Weight%) value for the learning criteria of each assessed learning 
outcome. The system accepts a weight percentage total over 100% (just like in Gradebook) 
for assessed Content Items. 

 
 

Explain editing criteria for assessed content 

For example, if the Strength (Weight %) value for a Mid-Term paper in a 
Composition 101 course is 75%, the learning criteria might be broken down as: 
 

 
(75%) COMP 101 Midterm Paper   

Task Completion =  x1 
(25) 

Comprehensibility =  x1 
(25) 

Fluency =  x1 
(25) 

Totals: 75% 

Where, the entered Strength (Weight%) value for the learning criteria equals 
75%. 
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Using the Strength (Weight %) values entered for learning outcomes and criteria, 
LOM calculates and reports back to you in which areas students performed strongest 
overall. Having this info available allows you to actively see relationships between 
assessed content items, performance, and learning objectives.  

8. (Optional) Click Default Repository Settings to view the original course rubric for 
reference. This is useful for when you want to make changes to the default values entered 
for learning criteria, but also have the original values available to compare.  

9. Click Save Changes to save your changes and return to the Outcome Management page. 

Remove Learning Statements 

Removing links to Content Items is an all or nothing relationship; meaning, once a 
link from a Learning Statement to the corresponding Content Item is removed, all 
links from that Learning Statement to corresponding Content Items are removed. If 
you only want to remove one link from a Learning Statement to one or two Content 
Items, use the Edit function where you can modify the link relationship between 
specific Learning Statements and Content Items for the course. 

To remove links to Content Items: 

1. Open LOM. 

2. On the Outcome Management tab, click  for the Content Item linked to the Learning 
Statement you want to remove. A confirmation message displays. 

3. Click Remove. 

Export Assessment Summary  

You can export the current view of your assessments summary in LOM to an MS Excel 
spreadsheet file. Doing so enables you to take advantage of standard spreadsheet functions. 
Exporting the current view of the assessment summary also provides you with final weights 
and scores in a format that you can turn in to your administration and keep as a backup for 
your records. 

To export the current view of your assessment summary: 

1. Open Learning Outcomes.  

2. Click Outcome Summary tab.  

3. Click Export Assessment Summary. A File Download window opens.  

4. Select Save, and then click OK. A Save As window opens in which you can select a 
name and location for the exported file.  

Unless you enter a name for your exported file in the Save window, the system names the 
file using the date, followed by the view and data format. For example, a file exported on 
March 26th, 2007 would be named "032606ShowALL_Letterand#." 

5. Click Save. The current view of the Assessment Summary file is saved in the specified  
location. 
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Resources 
Because this whole online course creation process might be relatively new to you, 
we've included some resources in this section that might help you as you develop 
your course.  

 Accessibility Requirements gives you an overview, as well as specific online resources, for 
ensuring that your course meets Section 508 requirements. 

 Educator's Voice links you to eCollege's online magazine and monthly publication, The 
Educator's Voice. See what our instructors have to say about course development and the 
latest industry practices! 

 HTML Quick Reference lists and explains commonly used HTML tags to help you develop 
your course. 

 Online Education FAQs displays a list of Frequently Asked Questions. Check here to see if 
your questions have already been answered! 

Online Education FAQs 

Because the idea of creating an online course might be new to you, we've included a 
list of Frequently Asked Questions. Check the list below to see if your questions have 
already been asked and answered. 

What are the four greatest advantages of online courses? 

 Students have the ability to learn at any time, from any place-- time and place constraints 
have been eliminated.  

 Online learning is student-centered. A particular student cannot monopolize all of the 
instructor’s time, nor can a student seek to hide in back of the class. Because most of the 
learning is done in an asynchronous setting, the learner has time to compose his/her 
thoughts prior to submitting them to the class.  

 Online education makes education available to a greater number of potential students such 
as students who work full-time, people who travel, parents and urban/rural dwellers who 
desire to eliminate the commute.  

 Online courses can incorporate the latest in available technology such as text, audio, video, 
slides, graphics, images, Threaded discussions, an online library, a Webliography, real-time 
chatroom, email, exercises, online testing, and more. Online education uses numerous 
learning tools, thereby appealing to different learning styles. 

What are the four most significant challenges, limitations, or shortcomings of online 
education? 

 Being in a new environment, students and faculty are unfamiliar with the medium. They 
have been educated using the traditional, face-to-face system and might find the new 
environment difficult at first because of the lack of interpersonal communication.  

 Online learning is not easy. Technology might be intimidating to some people. The Internet 
sometimes does strange things. An Internet connection can disconnect for unspecified and 
unknown reasons. A computer can be a very rewarding or a very frustrating experience. 
Some people are not technical by nature nor do they have the inclination or the time to 
educate themselves with or without outside assistance.  

 Sometimes asynchronous (delayed) communication is not more valuable than immediate 
correspondence. It can be troublesome to wait for a response from a professor when the 
student desires an immediate answer. Also, communication can be more useful to the 
professor when the students reply spontaneously.  
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 Online learning is not appropriate for everyone. Some people need the traditional classroom 
environment with face-to-face interaction and immediate feedback.  

What are the best current solutions to these four challenges, limitations, or 
shortcomings? 

 To overcome the new environment users need to spend time in the new environment. Yes, 
there is no face-to-face communication; but there are other numerous types of interaction, 
both synchronous and asynchronous, that are available to fill the void. Some examples are 
discussions, real-time chatrooms, email, message center, Threaded Discussions, and 
Webliography.  

 The online environment must be developed so that technology is not a factor. Students take 
courses to learn the course material, not to learn about technology. Therefore, the delivery 
system needs to have a similar look and feel for all courses, helping both students and 
instructors feel comfortable. Students will only have to learn online once and subsequent 
courses will function the same. There has been careful thought to make sites as intuitive as 
possible with learning tools and features easy to identify and use.  

 To overcome the challenge of the lack of face-to-face communication, two things must be 
done. First, while online education is available at 'any time, any place' to students, 
instructors must check their email at least three times a week and return students' emails 
within a specified amount of time. Second, when communication outside of the online 
classroom is required, outside media can be used (ie. telephone). Also, when technology 
improves, real-time audio chats over 28.8 modems will be available.  

 Online education will not replace the classroom. The classroom will always survive. Online 
education is meant to expand the educational opportunities to all students and to students 
who might not otherwise have the chance to take a course or degree in a traditional setting. 

What is the turn around time on helpdesk responses for students and faculty? 

Our helpdesk is available by phone, online chat, or email 24 hours a day, 7 days a 
week. Email inquiries will be responded to within 3-4 hours during business hours, 
and always within 24 hours. Average response is less than 4 hours. Chat discussions 
are restricted to certain hours. 

What is the estimated time that a faculty member is online teaching their students? 

There is no standard answer for this question. The amount of time depends on the 
instructor’s teaching style, technical skills, the subject matter, if the course has 
already been developed for a face-to-face environment, and other factors. 

Have you lost any grades/exams/course material? 

No system is infallible. As a matter of course, the EP should keep a current back up 
of all materials in the event of some unforeseeable catastrophe should occur. 
eCollege.com backs-up the system, as well as your course content and student 
enrollments, automatically every night onto a tape. There is a Sunday tape, Monday 
tape, Tuesday tape, etc., so that our back-ups go for seven days (but not longer 
than seven days in most instances). 

How often is the system down? 

Almost never. Our system is up over 99.7% of the time. When the system does go 
down, several people at eCollege.com are automatically notified regardless of time of 
day, ensuring we are immediately working on the problem. Our average down time 
is less than ten minutes per occurrence. 

What special rules apply to the copyright material delivered over the Web? Who gets 
the releases? 
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eCollege.com does not help in obtaining copyrights and permissions, and we cannot 
be held liable for copyright infringements. We advise our partners that the online 
classroom is very similar to the traditional classroom and they should follow the 
same permission policies. The online classroom is a closed environment (meaning 
there is a limited and controlled number of users and it is password protected). We 
believe that the Fair Use for Educational Purposes doctrine applies. The EP might 
want to consult with their legal department and/or library service department. 

Do students have to sit down at their computers at the same time every day? 

Not really. Inherent course flexibility gives students the ability to determine when it 
is best for them to go online. This helps minimize the time actually spent online. 
Occasionally, classes are held at specific times (synchronously), but usually students 
study on their own schedule (asynchronously). 

  

  

HTML Quick Reference  

Purpose 
Code Coded Document Example Actual 

Document 
Example 

Line Break <BR> A break will simply break your  
<BR> 
text and continue on the next 
line.  

A break will 
simply 
break your  
text and 
continue on 
the next 
line.  

Paragraph 
Break 

<P> A paragraph break will leave 
<P> 
an empty row in between the 
text. 

A paragraph 
break will 
leave  

an empty 
row in 
between 
text. 

Horizontal 
Ruling 

<HR> This will draw a  
<HR> 
line across a page. 

This will 
draw a  
line across a 
page. 

Underlining <U> <U>This text will be 
underlined.</U> 

This text 
will be 
underlined. 

Bolding <STRONG> <STRONG>This text will be 
bold.</STRONG> 

This text 
will be bold. 

Italicizing <EM> <EM>This text will be 
italicized.</EM> 

This text 
will be 
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italicized. 

Centering <CENTER> <CENTER>Hello</CENTER> Hello 

Divisions <Div align="left"> 
<Div 
align="center"> 
<Div 
align="right"> 

 <Div align="left">Hello</Div> 
<Div align="center">Hello</Div> 
<Div align="right">Hello</Div> 

  

Hello 
Hello 

Hello 

*Ordered 
Listing 

<OL> <OL> 

<LI>Clerks 

<LI> Olaf  

<LI>Berzerker  

</OL> 

  

1. Clerks  

2. Olaf  

3. Berzerker  

*Unordered 
Listing 

<UL> <UL>  

<LI>Clerks  

<LI>Olaf  

<LI>Berzerker  

</UL> 

• Clerks  

• Olaf  

• Berzerker  

*Font 
Sizing 

<FONT 
SIZE="+2"> 

<FONT 
SIZE="+2">Hello</FONT> 

Hello 

*Font 
Coloring 

<FONT 
COLOR="ORANGE"> 

<FONT 
COLOR="ORANGE"></FONT>Hello 

Hello 

Comment 
Tags 

<!--  --> <!-- This text won't show up -->   

*Ordered lists and unordered lists 
• The <LI> tag should be placed where a number belongs (ordered list) or a 

bullet belongs (unordered list).  

• You can identify what kind of numbering, or bullets to use by using an 
"attribute" within the list tag. There are two attributes that work with lists:  

1. TYPE: <ul type="..."> 
Values might include -a,A,i,I,1 (ordered lists), and - disc, square, circle 
(unordered lists)  

2. START (only for ordered lists): <ol start="..."> 
Values might include - 1,2,3,4... (always use numbers)  
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*Font sizing and coloring 

The size and color can be varied by changing the number/color within the 
quotation marks. Always look up the HEX triplet (six digit number) for a color you 
need. 

Section 508 

If you're creating a course that must meet accessibility requirements, please read 
the following information carefully. If you're not sure if your course must meet 
accessibility standards, please refer to your organization's policies for Web 
accessibility.  

U.S. Federal Section 508 identifies specific development standards that ensure 
electronic information transmitted over the World Wide Web is accessible to people 
with disabilities. Although not all schools and institutions require their online courses 
to meet Section 508 requirements, if an online course claims to be Section 508 
compliant, the content and functionality of the course must be available to all 
persons regardless of disability. 

If you are authoring a course that must be Section 508 compliant, you'll need to take 
care that all content in your course meets the standards set forth in Section 508.  

If you'd like more specific information or help with developing a universally 
accessible online course, eCollege can help. eCollege offers course development 
services to assist you in creating a universally accessible online course. Contact your 
Client Services representative for more information. 

Show me Section 508 standards 

Electronic and Information Technology Accessibility Standards (EITAS)  
(Section 1194.22) 

Graph Requirement Text Additional 
Information

(a) A text equivalent for every non-text element shall be 
provided (e.g., via "alt", "longdesc", or in element content). 

More info 

(b) Equivalent alternatives for any multimedia presentation 
shall be synchronized with the presentation. 

More info 

(c) Web pages shall be designed so that all information 
conveyed with color is also available without color, for 
example from context or markup. 

More info 

(d) Documents shall be organized so they are readable without 
requiring an associated style sheet. 

More info 

(e) Redundant text links shall be provided for each active region 
of a server-side image map. 

More info 

(f) Client-side image maps shall be provided instead of server-
side image maps except where the regions cannot be 
defined with an available geometric shape. 

More info 

(g) Row and column headers shall be identified for data tables. More info 

http://www.access-board.gov/sec508/guide/1194.22.htm#(a)
http://www.access-board.gov/sec508/guide/1194.22.htm#(b)
http://www.access-board.gov/sec508/guide/1194.22.htm#(c)
http://www.access-board.gov/sec508/guide/1194.22.htm#(d)
http://www.access-board.gov/sec508/guide/1194.22.htm#(e)
http://www.access-board.gov/sec508/guide/1194.22.htm#(f)
http://www.access-board.gov/sec508/guide/1194.22.htm#(g)
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Graph Requirement Text Additional 
Information

(h) Markup shall be used to associate data cells and header 
cells for data tables that have two or more logical levels of 
row or column headers. 

More info 

(i) Frames shall be titled with text that facilitates frame 
identification and navigation. 

More info 

(j) Pages shall be designed to avoid causing the page to flicker 
with a frequency greater than 2 Hz and lower than 55 Hz. 

More info 

(k) A text-only page, with equivalent information or 
functionality, shall be provided to make a Website comply 
with the provisions of this part, when compliance cannot be 
accomplished in any other way. The content of the text-only 
page shall be updated whenever the primary page changes. 

More info 

(l) When pages utilize scripting languages to display content, 
or to create interface elements, the information provided by 
the script shall be identified with functional text that can be 
read by assistive technology. 

More info 

(m) When a Web page requires that an applet, plug-in or other 
application be present on the client system to interpret page 
content, the page must provide a link to a plug-in or applet 
that complies with §1194.21(a) through (l). 

More info 

(n) When electronic forms are designed to be completed online, 
the form shall allow people using assistive technology to 
access the information, field elements, and functionality 
required for completion and submission of the form, 
including all directions and cues. 

More info 

(o) A method shall be provided that permits users to skip 
repetitive navigation links. 

More info 

Official Website to Electronic and Information Technology Accessibility Standards 

http://www.access-board.gov/sec508/guide/1194.22.htm 

Educator's Voice 

The Educator's Voice is a monthly column in the eCollege eNewsletter published by 
the eCollege Instructional Design team. The column includes useful information and 
hands-on advice for educators who use eLearning tools. Find previously published 
tips and articles in the Educator's Voice - Archive. 
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